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Disclaimer

MS Govern has taken due care in preparing this manual. However, nothing 
contained herein modifies or alters in any way the standard terms and 
conditions of the purchase, lease, or license agreement by which the product 
was acquired, nor increases in any way the liability of MS Govern to the 
customer.
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Govern New Administration (GNA)
System Requirements

This section lists the minimum hardware and software requirements for 
Govern’s eGovernment solutions and Microsoft .NET applications.

eComponent Requirements

Refer to the table below to determine which components and applications are 
required. Users with installed eComponents will only be able to view the 
components that they are licensed to use.

X - Mandatory          O - Optional

Overview

eCOMPONENTS

e
P

or
ta

l

e
P

er
m

it

e
C

om
p

la
in

t

e
R

en
e

w
a

l

e
G

re
iv

an
ce

e
R

eq
u

es
t 

fo
r 

S
er

vi
ce

s

eP
ro

fil
e

e
R

em
itt

an
ce

e
P

ay
m

e
n

t 2,
 3

A
P

P
L

IC
A

T
IO

N
S

 / 
M

O
D

U
L

E
S
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LM module X X X X X

AR module1 O O O O O O4 O X

MB module O4 O

NA module X X X

SRT module X

Govern Security
Manager 6.0

(GSM)

X X X X X X X X X

Govern New
Administration

6.0 (GNA)

X X X X X X X X X

Govern for
Windows 10.8

X X X X X X X X X
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ePayment Solution requires the following:

1. Accounts Receivable (A/R) Module, with links to the sub-systems for which you 
are setting up payment collection

2. Supported ePayment EFT Provider Interfaces are as follows: Pay Connexion, 
Moneris, Nelnet, Paymentus, Pay Pal, Point and Pay, US Moneris, and Your Pay.
• Credit Card / Debit Card / eCheck software1, installed and configured with 

valid merchant account 
• Automated Clearing House (ACH) agreement, in force with a bank if you are 

providing Electronic Funds Transfer (EFT) services. Refer to the GNA release 
6.0 guide for a list of EFT interfaces / providers supported by Govern.

• Govern for Windows™ Release 10.8 or greater sub-systems:

3. The Accounts Receivable (AR) Modules with links to the sub-systems to which 
you are setting payment / collection are required.

4. Required if users are creating eSubscriber accounts from the Web.

Third Party Applications

The following Microsoft and Third Party Software are required for the 
eGovernment solutions:

• Internet Information Server (IIS) with Secure Sockets Layer (SSL) 
certificates, installed

• Microsoft .NET Framework 4.5
• SAP Crystal Reports Runtime Engine 13.0.9.x for .NET Framework 4.5 

(32-bit)

Note: All sub-systems are required for ePayment collection

Note: Users of Govern eComponents should note that there are issues with 
using the Report Viewer for the SAP Crystal Reports Runtime Engine 
v13.0.9.x for .NET Framework 4.5 (32-bit). With eComponents use the 
v13.0.1.x of the SAP Crystal Reports Runtime Engine the for viewing 
reports in a Web browser.
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Server and Client Operating Systems not Supporting 
Microsoft’s .NET Framework 4.5
Users should note that the .NET Framework 4.5 is not supported by any of 
the following:

CLIENT OS:
Windows 7 / 8 (32-bit and 64-bit)

SERVER OS:
Windows Server 2008 R2 SP1 (32-bit and 64-bit), Windows Server 2012
Refer to the following link for full information:
http://msdn.microsoft.com/en-us/library/8z6watww.aspx
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System Requirements
Server and Network Requirements

Note: It is recommended, but not mandatory, to set up three physical 
servers. The first server would be for the Database, the second for the 
Application, and a third would function as, if required, for the Web. If, 
however, you decide to use one physical server for both the 
Application and Web, you will need to revise the minimum 
recommended configuration.

Note: Deployments on the application server are maintained with the Deploy 
EZ application, ensure that this server has Web access and an open 
FTP port.

SERVER HARDWARE

Hardware Type Minimum Specifications

DATABASE SERVER

Platform Windows & Unix1

Database Package Oracle2 or Microsoft® SQL Server3 2008 R2, 2012, 2012 R2, 2014

CPU
2 GHz / 1 MB cache, 800 MHz FSB (2.4 GHz Quad-core 1.066 GHz FSB - 
Recommended)

RAM

16 GB DDR24 (32 GB DDR2 or greater - Recommended)
Note that specified memory requirements are for the core Govern Applications 
alone, i.e. without 3rd party application integrations. Third party integrations 
can significantly impact system performance due to their individual require-
ments. A review of requirements of integrated applications should be per-
formed prior to their installation. Also refer to A Note for users of Virtual 
Machines (VM’s) below.

Disk Space
Dependent upon the size of data to be managed; RAID V with a minimum of 
500 GB of hard disk space is a recommended configuration. Note that Disk 
Space is dependent upon Database and Disk Mirroring requirements

Operating System Microsoft® Windows® Server 2008 R2, Server 2012, or greater

Network 100 Mbit NIC (1 Gbps - Recommended)

Peripherals DVD / CD ROM Drive
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WEB SERVER

Platform Microsoft® Windows® 2008 R2, with IIS 7.5, Server 2012 R2 with IIS 8.5

CPU
3 GHz / 1 MB cache, 800 MHz FSB (2.4 GHz Quad-core 1.066 GHz FSB  - 
Recommended)

RAM 8 GB DDR2 (16 GB - Recommended)

Disk Space
100 MB for each site being maintained. Additional space will be required for 
reports, and temporary space for submitting multimedia documents.

Operating System Microsoft® Windows® Server 2008 R2, Windows® Server 2012, 2012 R2

Network 100 Mbit Network Interface Card (NIC) (1 GBit Recommended)

WEB SERVER HARDWARE

Peripherals DVD / CD ROM Drive

Other Redundant power supply and fans

Server and Client Operating Systems not Supporting 
Microsoft’s .NET Framework 4.5
Users should note that the .NET Framework 4.5 is not supported by any 
of the following:

CLIENT OS:
Windows Windows 7 / Windows 8/8.1 (32-bit and 64-bit)

SERVER OS:
Windows Server 2008, all editions
Windows Server 2008 R2 SP1 (32-bit)
Refer to the following link for full information:
http://msdn.microsoft.com/en-us/library/8z6watww.aspx

SERVER HARDWARE

Hardware Type Minimum Specifications
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A Note for users of Virtual Machines (VM’s)

Users of Virtual Machines (VM’s) should note that when multiple servers are 
being hosted in a Virtual Machine on the same physical servers, the 
requirements for each individual server must be carefully managed as it can 
impact use of system resources. For example, users may decide to host the 
Database Server, Application Server, and an eGovern Web server in a VM 
that is running on the same physical server. In such a situation, as a result of 
the varying requirements of each server, planning is required to address how 
shared system resources are allocated to the individual server, and the VM.

Client and Network Requirements

CLIENT HARDWARE

Hardware Type Minimum Specifications

CLIENT WORKSTATIONS

Platform Microsoft® Windows® 

CPU Intel® Core™ i3 Processor

RAM 4 GB5 (8 GB RAM - Recommended)

Disk Space 40 GB of hard disk space 6

Network 100 Mbit Network Interface Card (NIC) 7 (1 GBit Recommended)

Operating System Microsoft® Windows® 7 Professional (32-bit and 64-bit), or Windows 8.x Pro-
fessional (32-bit and 64-bit)

Other 17” Display 8  WPF Direct 3D Graphics Card

MOBILE HARDWARE (Laptops / Tablets)

Platform Microsoft® Windows® 

CPU Intel® Core™ i3 Processor

RAM
2 GB Internal RAM - 4 GB Recommended
(4 GB recommended for Open Forms Laptop / Tablet)
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1) The version of UNIX will be dependent upon the manufacturers recommended version 
of Oracle.

2) Oracle 11g, and 11g R2 and greater are supported.

3) Microsoft® SQL Server 2008, SQL Server 2008 R2, SQL Server 2012, SQL Server 2012 R2  
are supported.
NOTE: Although these servers are supported, the Reference Database for the OpenForms 
Models is only available as a SQL Server 2008 R2 database.

4) CPU and RAM requirement may vary depending upon the amount of users and the number of 
parcels managed by the application.

5) Minimum - 4 GB (recommended - 8 GB).
6) Govern requires a minimum of 40 GB of temporary storage used while running the application.
7) Internet Explorer must support HTML 3.0 or higher.
8) Govern’s performance is dependent upon network bandwidth because files, reports, icons, 

images, and data are downloaded from servers.

Operating System
Microsoft® Windows® 7 Professional (32-bit and 64-bit), or Windows® 8.x Pro-

fessional (32-bit and 64-bit) 7

Network 100 Mbit Network Interface Card (NIC) 8

Peripherals Extra Battery, Docking Station in vehicle, plug in keyboard

Other
12.1” (1024 x 768) Display (Recommended 1280 x 1024)

Colors: True Color (32 bit) 9

Disk Space 160 GB of hard disk space

Integrated 
Communications

Optional Integrated Mobile Broadband 

WiFi® 802.11 a/b/g/n

10/100/1000 Ethernet

THIN CLIENT PC / SERVER

Operating System Microsoft® Windows® 2008 Terminal Server OR Citrix Metaframe 

CLIENT HARDWARE

Hardware Type Minimum Specifications
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9) The minimum required resolution for Govern Release 4.0 or greater is 1024 x 768 (1280 x 1024 
Recommended) - Minimum Colors: True Color (32 bit).

Server and Client Operating Systems not Supporting 
Microsoft’s .NET Framework 4.5
Users should note that the .NET Framework 4.5 is not supported by any of 
the following:

CLIENT OS:
Windows Vista / Windows 7 / Windows 8 (32-bit and 64-bit)

SERVER OS:
Windows Server 2008, all editions
Windows Server 2008 R2 SP1 (32-bit)
Refer to the following link for full information:
http://msdn.microsoft.com/en-us/library/8z6watww.aspx
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Supported Web Browsers 

Note: Internet browsers are continuously developed and upgraded, as a 
result compatibility issues may arise. The following list is by no means 
an exhaustive one, and cannot completely take into account the 
incompatibilities that can occur between browser versions and 
versions of operating systems.

Web Browsers

The MS Govern eComponents are compatible with the following versions of 
these popular Web browsers.
It can be assumed that Web browsers that do not appear on this list are not 
supported.

Browser Compatible Version

Microsoft Internet Explorer 9.0 and above

Mozilla Firefox 3.0 and above

Google Chrome 2.0 and above

Apple Safari 3.1 and above
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Introduction
Introduction

The Govern New Administration, or GNA is the administration application 
used to configure Govern. The following are some of the features included:

• Database Management Utilities including management of multiple 
database connections. See Managing Multiple Database Connections on 
page 352.

• An extensive list of Editors to support the administrative requirements of 
Govern, as well as the end-user customization and integration 
requirements. See Govern New Administration (GNA) Setup Editors on 
page 143.

• Web Creation and Management Utilities that support the eGovern - Public 
Self Service Portal. See Web Site Manager on page 105,  Accessing 
Govern Web Configuration Tools on page 104, Search Configuration on 
page 201, and others.

• Additional language support. See Changing the Interface on page 34.

Overview
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Administration of Govern for OpenForms

Although the administrative capabilities of GNA are extensive, there are 
configurations that need to be maintained in the Govern for Windows 
GovAdmin application. Refer to the individual Govern Modules for 
administrative setup and configuration.

Govern Release 6.0 is a significant update from the previous release 5.1. With 
this release, as part of the upgrade process, there are changes that users will 
need to acknowledge and confirm. In addition there are interface changes that 
streamline the user experience with other applications in the Govern for 
OpenForms Release 6.0 suite.
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5.1 to Release 6.0
Upgrading from Govern Suite Release 
5.1 to Release 6.0

Govern users that are upgrading from Release 5.1 to Release 6.0 will note the 
behavior of Release 6.0 applications.

Notable Changes

Design Tools

The Model Designer (MoD) application is no longer a part of the suite. Design 
and Security of Business Models is now performed with the OpenForms™ 
Designer (OFD). The Business Entity Designer (BED) is still used for 
designing Business Entities.

Database Changes

Govern application versions that are prior to Release 6.0 will be referred to as 
legacy applications. Govern Databases created for use with releases prior to 
6.0 will be referred to as legacy databases. For Release 6.0, changes have 
been made to the structure of models used in the Mod el Designer (MoD) 
Release 5.1 and the new OpenForms™ Designer (OFD) Release 6.0. As a 
result of these changes, the databases that are used by Release 6.0 and 
above applications are not compatible.

In order to assure the integrity of the 6.0 database, the Govern system will 
prevent the use of any legacy databases unless they have been created for, or 
upgraded to Release 6.0. 

How Govern Interacts with “Legacy” Databases

When launching an application, the Govern system performs a comparison 
between the version of the launched application and the database. This is 
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carried out by looking at the value in the NET_DB_VERSION column of 
(Table: USR_KEY_MASTER).

Rules regarding Govern Legacy Applications

Release 5.1 Applications

The following Release 5.1 applications WILL NOT work with a Release 6.0 
database.

• Business Entity Designer (BED)
• Query Tool (QT)
• Security Manager (SM)
• Model Designer (MoD)
• Govern
• Govern New Administration (GNA)

Release 5.1 Exception Application(s)

Users attempting to set a Release 6.0 database as a Default Connection Key 
in the Connection Key Management form in the Release 5.1 Govern New 
Administration (GNA), will be presented with a warning indicating that they 
cannot select a database version that is greater than Release 5.1. No change 
will be made to the default connection key.

Any user that tries to access any of the above applications will receive a 
warning message.

Note: Prior to fully launching the application, i.e. prior to displaying the 
“splash screen”, a message box is displayed warning of an 
inconsistency between the application and the database. Upon user 
acknowledgement of the message, the launch of the application is 
terminated so as to minimize any calls to the database, and to 
maintain its integrity.
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Refer to Creating a Supplementary Connection Key on page 340 in this user 
guide for details about changing the default Connection Key.

Release 6.0 Applications

Govern Release 6.0 applications will not run with a Release 5.1 or lower 
database. The following is a list of the Release 6.0 applications that will not 
work with a legacy database, i.e. a version prior to Release 6.0.

• Business Entity Designer (BED)
• Security Manager (SM)
• Query Tool (QT)
• Open Form Designer (OFD)
• Govern (Release 6.0)

Attempting to run any of the above Release 6.0 applications will result in a 
warning being displayed. 

Release 6.0 Exception Application(s)

Users attempting to set a Release 5.1 database as a Default Connection Key 
in the Connection Key Management form in the Release 6.0 Govern New 
Administration (GNA), they will be presented with a warning indicating that 
they cannot select a database version that is less than Release 6.0. If the user 
selects Yes, the system will run the Database Verification process and will 
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update the selected database to a Release 6.0 version. See Processing a 
Database Verification on page 297 for details about this process.

Upgrade Paths to Release 6.0

Users that will be using Release 6.0 have two (2) paths to upgrade to Govern 
Release 6.0 applications:

OPTION 1 - Direct Upgrade

This path will immediately upgrade your current installation database from 
Release 5.1 to Release 6.0. The database upgrade process is irreversible and 
as such, a complete database backup should be made prior to the 
upgrade. Should it be necessary to roll back to your Release 5.1 database, 
the backup can be restored. The Deploy EZ application will be used to update 

WARNING: When users select the Yes option, GNA will display the 
Database Verification form to perform a non-reversible 
upgrade to their database. After the process is complete, the 
NET_DB_VERSION column in (Table: USR_KEY_MASTER) is 
updated.

Note: If errors are encountered during the Database Verification process, the 
conversion to a Release 6.0 database will not be complete. Any errors 
will have to be addressed prior to the process being repeated.

WARNING: Prior to any upgrade, it is recommended that a complete 
backup of the database prior to copying or upgrading should be 
performed.
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the currently existing deployment. The deployment will consist of the Release 
6.0 replacement applications.

Upgrade Steps for OPTION 1

1. Open the Govern New Administration (GNA) Release 5.1.

2. Use the Connection Key Management form to ensure that the default 
connection key is set to your Release 5.1 database; close the GNA 
application when done. Refer to Setting a Connection Key (CK) as a 
Default on page 343 for steps.

3. Perform a complete backup of your current Release 5.1 database with 
your Database Management application.

4. Update your current deployment with Deploy EZ; update the applications 
to the latest Release 6.0 versions.

5. Run the Govern New Administration (GNA) Release 6.0.

6. At the prompt, click Yes to perform the database update.

7. When the process is complete, restart the application.

Upon completion of the process, the NET_DB_VERSION column in (Table: 
USR_KEY_MASTER) is updated. The database conversion is complete. 
Close GNA and restart the application.

OPTION 2 - Parallel Install

This Option 2 upgrade path is non destructive in that a new Release 6.0 
Deployment is created; a name that reflects a Release 6.0 database is 
recommended. 

In addition to a full database backup a new Connection Key (CK) must be 
created to connect to the Release 6.0 database. Installing the applications in 
the Release 6.0 deployment will not overwrite any existing Release 5.1 

Note: This Option 1 upgrade path will replace the Release 5.1 applications 
with their Release 6.0 versions.

Note: As with Option 1 above, a full backup of the Release 5.1 database is 
mandatory.
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applications. The newly installed application will run independently of the 
legacy applications on a separate database.

Upgrade Steps for OPTION 2

1. Perform a complete backup of your current Release 5.1 database with 
your Database Management application.

2. With you DB Management application, create a duplicate of the Release 
5.1 database; rename with a 6.0 designation, e.g. mydbase_60

3. Open the Govern New Administration (GNA) Release 5.1.

4. Use the Connection Key Management form to create a connection key to 
the newly designated Release 6.0 database. 

5. Set the new connection key as the Default connection; close the GNA 
application when done. Refer to Setting a Connection Key (CK) as a 
Default on page 343 for steps.

6. Launch Deploy EZ.

7. Create a new deployment with a Release 6.0 designation.

8. Create your deployment with the latest required Release 6.0 applications.

9. Run the Govern New Administration (GNA) Release 6.0.

10. At the prompt, click Yes to perform the database update.

11. When the process is complete, restart the application.

Upon completion of the process, the NET_DB_VERSION column in (Table: 
USR_KEY_MASTER) is updated. The database conversion is complete the 
applications can be restarted.

Note: The Option 2 upgrade path will leave the existing Release 5.1 
applications and database intact; as no upgrade is actually performed 
on existing Release 5.1 applications. The database upgrade that is 
performed is on a duplicate database that is created from a backup of 
the Release 5.1 version.

There is no synchronization of data between the old and new 
database; the 5.1 and 6.0 environments are independent of each 
other. If synchronization of data is required it will have to be performed 
by a qualified database administrator that is knowledgeable on the 
functioning of the Govern application and its database structure.
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What’s New

This section lists new features, or new ways of performing an old function in 
the Govern New Administration (GNA) release 6.0. These new features are 
indicated by the NEW! symbol.

Database Structure

Govern Release 6.0 has many changes. In order to accommodate new 
features and new applications, changes have been made to the structure of 
the Govern Release 6.0 database structure. See Upgrading from Govern 
Suite Release 5.1 to Release 6.0 on page 3 for database upgrade steps.

User Interface

The interface for the Govern New Administration (GNA) has been updated to 
have a similar look and feel navigation as other applications in the Govern 
Release 6.0 suite. Refer to GNA User Interface on page 12 for interface 
details.

Open Forms Designer

Noticeably absent from the Govern Release 6.0 suite of applications is the 
Govern Model Designer (MoD). This application for designing the Business 
Models that are required by OpenForms has been replaced with the Govern 
Open Forms Designer (OFD). See the OpenForms Designer Release 6.0 user 
guide for details.

Online User Help

The user help for the GNA now follows the same convention as Govern and 
the OpenForms™ modules. Refer to Configuring System Help on page 410 
for details.

Expressions Editor

Using the Expression Editor, it is now possible to design expressions, i.e. a 
combination of explicit values, constants, variables, operators, and functions 
that follow specific rules. Expressions are used throughout Govern to 
calculate, format, validate, set properties, etc. and are executed when a form 
is loaded or as soon as a change is detected. See Expressions Editor on page 
XXXXX for details.
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Grouping of Govern Ribbon Icons
NEW! A new behavior is now observed when there are multiple Ribbon icons 
in an icon group, as the UI window is reduced in size, the icons within the 
group will be combined into a single icon. There will be a drop down group 
menu containing all icons within the group.

This behavior will allow the application UI to be flexible when the screen is  
resized by the user.
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Grouping of Govern Ribbon Icons
NEW! A new behavior is now observed when there are multiple Ribbon icons 
in an icon group, as the UI window is reduced in size, the icons within the 
group will be combined into a single icon. There w with a drop down down 
group containing all icons within the group.

This behavior will allow the application UI to be flexible when screen resizing 
occurs.
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The Govern New Administration

GNA User Interface

The Govern New Administration (GNA) user interface was redesigned for 
Release 6.0 and upwards. The interface uses ribbons for quick access to the 
required areas of the application. Forms are now accessible through tabs on 
the ribbons. Presentation of forms can be changed from the standard Multi-
window forms, overlapped and staggered, to a tabbed layout.

GNA applications are arranged under the tabs that logically groups then by 
their function. With the exception of the File tab, GNA applications are found 
under one of the following:

• Options
• Parameters
• Applications Configurations
• Editors
• Utilities
• Windows
• Help

Note: Configuration interfaces that appear in the GNA may vary between 
users depending upon the security settings that have been applied to 
them. Menu items under the tabs in the ribbon are secured by the 
Govern Security Manager (GSM). Refer to the Govern Security 
Manager Release 6.0 user guide for details about securing the GNA 
menu items.
Page 12 © 2015 Harris Govern



The Govern New Administration
Organization of the GNA Ribbon tabs

The GNA Ribbon has been arranged to group utilities with similar functions in 
a common location. In addition some ribbon icon options are mutually 
exclusive, i.e. when a selection is made, that selection will be removed from 
the list of available options. See Language on page 34 and Mutually Exclusive 
Menu Options on page 34.

Note: The Ribbon of the Govern New Administration (GNA) Release 6.0 
can be secured with the Govern Security Manager (SM) Release 6.0. 
After starting the GNA, if you are presented with an interface 
containing limited tabs and ribbon icons, verify with your system 
administrator that you have access to your required menus.
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Space Saving features of the Ribbon

Minimizing / Restoring the Ribbon

As is customary with application interfaces with ribbons, when space is 
limited, the ribbon may be minimized.

To minimize the Ribbon...

1. In the GNA interface, Right click on the Ribbon or on the row where the 
tabs are presented.

2. In the floating menu, select the Minimize the Ribbon option.

Restoring the Ribbon...

1. Right click on the row where the tabs are presented.

2. Select the checked Minimize the Ribbon option.

Display Behavior of Ribbon and Ribbon Icons

Typically an application window with a ribbon will exhibit specific display char-
acteristics when the width of the window is reduced. Display characteristics 
are as follows:

• A tab with multiple icons too numerous to display in the ribbon at full size 
will be displayed at a reduced size (approx. 50%). When the application 
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screen width is reduced, the application icons will be displayed with a text 
label (A).

• If the application group contains 2 or more icons, the group will be 
presented with a group icon (B) that can be accessed to display the items 
in the group.

• When ribbon space is extremely limited and there are multiple icons in a 
group, icons will be combined into sub groups. The sub group icons will be 
combined in groups of three, and presented without labels. The name of 
the icon will be displayed when the mouse pointer is hovered over the 
reduced size icon (C).

File tab

The File tab is selected to access the Exit command. A click will close down 
the application. 

Options tab

The Options tab contains selection options to modify the user interface and to 
diagnose system errors and generate trace logs. 

Options

Under this tab are interface language choices. Selection options are Mutually 
Exclusive, i.e. when an option has been selected, that option will no longer be 
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displayed as a selection option. See Mutually Exclusive Menu Options on 
page 34

• Switch Language to...; see Language on page 34.
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GNA Trace Utilities

The functionality of the GNA trace utility has been expanded in Release 6.0. In 
previous releases, trace logs were generated by setting individual keys for 
sections that a log was required for; e.g. General, DAB, GIS, Mobile, and so 
on. In the current Release 6.0, all trace activities are managed through the 
Configuration Diagnosis console.

Default Trace Log Settings

By default, when enabled, a trace process will immediately begin to generate 
data that is written to a Comma Separated Value (.csv) log file in the Trace 
directory of the deployment folder. The trace file uses the following naming 
convention:

userName_serverName_ckName_appName.csv

where...

Note: When enabled trace functions can be instrumental in troubleshooting 
system issues, likewise in assisting Technical Support to resolve them. 
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• userName = users login name
• serverName = name of the server that the application is installed
• ckName =  the connection key name
• appName = the application that is being monitored

Ex.: jdoe_JNMTL2_GOVDB_60_JNMTL2_SQL_GovernNetAdmin.csv

Software option

Target: The Target options allow the selection of how the trace information 
will be presented. The options are as follows:

• File - The File option will generate the trace information as a log file. This 
.csv file can be opened with any application that supports the format, e.g. 
Microsoft Excel.

• Console - When Console is selected, a console (output window) titled 
NLog is launched. The trace information is logged in the NLog window.

• Console and File - Selecting the Console and File option will display the 
trace information using both of the above means, the NLog console 
window will be displayed and the .CSV log file will also be generated.

Note: The trace file is self maintaining in that it will be deleted when it is older 
than 30 days. Alternatively, users may opt to delete the file manually, it 
will be regenerated the next time it is enabled.
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When the Text option is selected, A text field is displayed. The intent is that 
any debugging information is pasted into the field.

Minimum Reporting Type: Selecting a minimum reporting type will 
determine what details are logged. For example:

• Info - Select the Info option to log general information about the 
application. This can include a list of the calls that are made by the 
application

• Warning - The Warning minimum level will log error messages that are of 
the type Warnings.

• Error - When a minimum level of Error is selected, the system will log all 
errors that are categorized as an Error. These are errors that will cause the 
application to halt its current process, but will not cause it to fail.  In this 
situation data loss may occur.

• Fatal - This option will log all errors that are categorized as Fatal. These 
are errors that will cause the application to fail, i.e. a crash without the 
chance of a recovery. In this situation data loss may occur.

Supported Modules

The list of supported modules are presented below the Min Level: option and 
pertain to the areas of the govern application, modules, and integrated 3rd 
party modules.

• All - Selecting All will log the errors generated by all modules. This will 
include traces of the errors generated by installed Govern suite 
applications; e.g. MSGovern, GovernNetAdmin, BEDesigner, 
GovernSoftware.Security.UI.Manager, MSGovern.OFD, and so on.

• DAB - Selecting the DAB option will log the activities that access the 
Govern Data Access Block (DAB)

• Trace commands where execution time is longer than X 
milliseconds - Enter a value in milliseconds that will be used a 
threshold. Any actions or calls that take longer than this value will 

Note: When the DAB option is selected, a new field called Trace commands 
where execution time is longer than X milliseconds will be 
displayed. See details below.
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be recorded in the log file. The default value for this field is 30 
milliseconds

Tracing Govern Applications
• All - Select the All option to obtain a trace log of all Integration applications
• Apex - The Apex option will trace issues that are related to integration with 

the Apex drawing tool.
• AppXTender - To troubleshoot or monitor issues related to integration 

involving the AppXTender document management system, select this 
option for a trace log.

• Business - When there are issues related to the Govern Business Tax 
module, select this option.

• DAB - Select the DAB option for trace logs related to the Govern Data 
Access Block (DAB).

• eGovern - This option will trace errors related to the eGovern - Public
• Self Service Portal. 
• HummingBird - Use this option to obtain a trace log for Hummingbird 

Document Management System integrations.
• mGovern - Selecting this option will provide trace information that is 

related to the mGovern mobile application
• Reports - When there are issues with reports, select this option to trace 

information related to reports.
• Valcura - Use this option to obtain log information related to the Valcura 

appraisal system integration.
• Web Browser Integration - Select this option to log errors generated by 

Web browser related integrations, i.e. integrations that make calls to the 
Web.
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Text (from MS Govern) option

The text option is reserved for entering debugging information that is 
generated by the system. When errors are generated by the system, the 
debug code can be copied and reviewed for insight into the issue. To further 
assist, when the “Load configuration from” Text option is selected, the debug 
code can be copied and pasted into the text field that is displayed.

If there is an incompatibility, an error window will be displayed.

Parameters tab

In the Govern New Administration (GNA), the System Parameters tab is the 
location of the main configuration interfaces to the Govern System Registry 
(General Settings Editor). In addition, interfaces to the General Connections 
and Report Parameters can also be located under this tab.

• General Connection Parameters, see General Connection Parameters on 
page 36.

• General Setting Editor, see OpenForms™ General Settings on page 40.
• User Maintenance, see User Maintenance on page 52.
• Department Maintenance, see Department Maintenance on page 55.
• Report Parameters Editor, see Reports in the Govern New Administration 

(GNA) on page 70.
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Application Configurations tab

The Application Configuration menu is the location of the configuration utilities 
for installed suite modules. 

This menu contains configuration forms for the following:

GIS Configuration group

Configuration parameters for users of the Govern GIS View module 

• GIS Parameters; see GIS Parameters Editor on page 91
• GIS Tool tip; see GIS Tooltip Editor on page 96
• GIS Synchronization; see GIS Synchronization Tool on page 98

Web Configuration group

Configuration parameters related to the eGovern - Public Self Service Portal 
module

• Manage Web Sites...; see Web Site Manager on page 105
• Manage Web Skin...; see Web Skin Manager on page 106
• Open Web Config Editor; see Web Configuration File Editor on page 108
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Govern Tax Modules

General

The General group is reserved for system wide tools. Currently the Roll 
Forward Exclusion tool can be found in this location. Refer to the Roll Forward 
Exclusion tool on page XXXXXX for details.

Govern Tax group

When the relevant Govern Tax module is present, The Govern Tax group 
under the Application Configurations tab will allow users to access the Tax 
form editors within the modules. Refer to the appropriate tax module for 
details.

Real Property

When the Real Property Tax module is present, users will be able to access 
the parameters that are relevant to the Real Property Tax module; i.e. General 
Parameters, Levy Codes, Exemption Groups, and others.

Personal Property

Users with the Personal Property Tax (PP) module installed can access Self 
Reported Tax configuration parameters and editors. Currently this module is in 
development...

Motor Vehicle

When the Motor Vehicle Tax (MV) module is present, this menu will allow 
users to access Motor Vehicle Tax configuration parameters and editors. 
Currently this module is in development...

Aircraft Excise

The Aircraft Excise Tax (AC) menu will allow users to access Aircraft Excise 
Tax configuration parameters and editors. Currently this module is in 
development...

Note: Govern Tax modules for Govern 6.0 are currently in development. As 
modules become available they will be introduced into the application.
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Boat Excise

Users with the Boat Excise Tax (BT) module installed can access Boat Excise 
Tax configuration parameters and editors. Currently this module is in 
development...

Business Tax (Self Reported Tax)

Users with the Business Tax (BT) module installed can access Self Reported 
Tax configuration parameters and editors. Currently this module is in 
development...

Accounts Receivable

When the Self Reported Tax (SRT) module is present, this menu will allow 
users to access Self Reported Tax configuration parameters and editors. 
Currently this module is in development.

CAMA group

Mass Appraisal

The Mass Appraisal Validation Tables for Building Structural Elements (BSE) 
are displayed on the Building Structural Elements form in Govern. All the BSE 
tables are set up in a similar fashion. The interface to create new BSE 
Templates is found in the BSE Templates form. Refer to the Mass Appraisal 
Release 6.0 user guide for details.

Utility Billing group

Utility Billing

The Utility Billing system was designed to handle multiple types of services 
including water, sewer, refuse, electrical, gas and more. The system maintains 
a single account number for ease of use and customer inquiries. A many-to-
many relationship exists so that multiple meters and reading devices can be 
linked to an account. Refer to the Utility Billing Release 6.0 user guide for 
details.
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Editors tab

Editors group

Editors and Configuration tools for, OpenForms™. See Govern New 
Administration (GNA) Setup Editors on page 143.

• OpenForms Profile Editor. See Profile Editor on page 110.
• Field Mask Editor
• Constant Value Editor
• SQL Query Editor
• Formula Editor
• Logical Expression Block Editor
• External Command Editor
• Number Format Editor
• System Validation Table Editor
• User Validation Table Editor
• Data Mapping Editor
• Resource File Editor
• Batch Process Definition Editor. See Batch Process Definition Editor on 

page 144. 

Dynamic Search Configuration group

These are the Dynamic Search editors used for search configurations that are 
accessible in Govern and the Web. 

• Dynamic Search Objects
• Dynamic Search Styles
• Dynamic Search Groups
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Utilities tab

Utilities group

Active Directory Integration Tool

The Active Directory MSGovern Integration Tool allows administrators to 
import users from Active Directory into Govern’s user database.

Connection Key Management

This form is used to create or modify the parameters for a Connection Key 
(CK). This feature is useful in an environment with multiple databases. 

General Connection Parameters

Use the parameters in the Connection Key General Parameters Management 
form only when instructed by Govern Technical Support.

Country Corrections in NA_NAMES table

This tool is used to clean up text fields used in earlier versions of Govern for 
Windows.

Database Utilities group

Database Verification

Select this menu to locate the tools that are used for Active Directory 
Integration, managing Connection Keys, and all database utilities including 
import and export tools. See GNA Utilities on page 292.

• Create MS Govern System Stored Procedures - In Verify 
• Create only Tables necessary to the Dynamic Search component
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Import / Export Tools group
• Initialize Mobile Database

The following two utilities are collectively referred to as the Enterprise 
Management tool (EMT

• Export Data to File
• Import Data from File

Windows tab

Windows group

Under the Windows menu are options to change how forms and windows that 
are opened in the GNA interface are displayed.

• Cascade
• Tile Horizontally
• Tile Vertically
• Layout - Users should note that selection options are Mutually Exclusive, 

i.e. when an option has been selected, that option will no longer be 
displayed as a selection option in the menu list.
- Standard
- Tabbed

Help tab

Help group

Select Help to view user help documentation for the Govern New 
Administration (GNA).

• Govern Net Admin Help - F1
• About Govern Net Admin Application
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Year tab

The Year tab is used to display the parameter for the Current year. The value 
appearing is the Active or Current Fiscal year. For details about this option, 
refer to the Global Information group section of the Govern General 
Information user guide.

Note: The appearance of this tab is conditional upon the displaying of 
configuration forms that are based upon the active year, e.g. SRT 
Categories, or modules that use exemption codes, and so on.
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Tools found in the Govern New 
Administration (GNA)

Database Connection and Verification Tools

Tools for defining Database connection parameters and configuring Web sites 
associated with the Database, are found under the Utilities (tab) and the 
Editors (tab). See Connecting to a SQL Database Server on page 341 and  
Web Configuration File Editor on page 108 for details. The tool used to update 
Govern’s reference database is located under Utilities > Database Utilities 
menu. See Processing a Database Verification on page 297 for details.

Dynamic Search Configuration Tools

Governs Search Configuration tools are used to design and configure search 
pages for eProfiles, eComponents, and Govern.

These tools are located under the Editors (tab) > Dynamic Search 
Configuration menu. They are titled, Dynamic Search Objects, Dynamic 
Search Styles, and Dynamic Search Groups. Once you have created your 
search styles and style groups, you can link them to an eProfile, ePayment, or 
ePermit through menu options or reports. This is done through the eProfile tab 
of the Menu Setup form in Govern Admin. See Search Configuration on 
page 201 for details.

Web Configuration Tools

These are tools for managing the look and feel of the eProfile and 
eComponent Web sites; the Web Skin Manager and the WebSite Manager are 
submenus under Application Configurations (tab) > Web Configuration.... 
See Accessing Govern Web Configuration Tools on page 104 for details.

Web Skin Manager

The WebSkin Manager is used to create and preview customized WebSkins 
and define the look and feel of the eProfile and eComponents. This tool 
defines general layout, title, and sections of the web page such as the head, 
header, footer, left and right margins, and body. These sections are defined as 
“skins”, assigned a name and ID, and can be applied to the eProfile or 
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eComponent with the Web Site Manager. See Govern Web Configuration 
Tools on page 104 for details. See Web Skin Manager on page 106 for details.

Web Site Manager

After setting up WebSkins, the Web Site Manager is used to assign WebSkins 
to the eProfile and each eComponent associated with the Web Site. Each 
application can be assigned a different skin for a different look/feel navigation. 
Alternatively, you may assign the same skin to all components. See Web Site 
Manager on page 105 for details.

Batch Process Setup Tools

This form allows you to define the batch processes that are used in 
Govern.NET. See Batch Process Definitions User Interface on page 273 for 
details.
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Installing the Govern New Administration

Govern New Administration (GNA) Installation

The Govern DeployEZ™ Deployment Manager is the application that is used to 
deploy all Govern .NET solution applications, and legacy Govern for Windows 
applications. As a result, administrators should refer to the Govern DeployEZ™ 
Installer guide for pre-installation activities, and installation instructions.

When a deployment that includes the Govern New Administration (GNA) has 
been created, the user will be provided with a network link or URL indicating 
the location of the installation package.

Overview



Govern New Administration (GNA)
Getting Started

In this section of the Govern New Administration (GNA) user guide is a 
description of the configuration tools that are found in the GNA, and how to set 
up supplemental database connections.

Accessing the Govern New Administration

After the installation of GNA from a DeployEZ™ Deployment, icons will be 
created in the MS Govern group under the Windows Start button.

To access GNA...

1. Click Start > Programs > MS Govern > DeploymentName - MS Govern 
System Configuration Administrator; where DeploymentName is the 
name of the Deployment that was used.

Overview

Note: Oracle users should first review procedures in Connecting to an 
Oracle Database Server on page 350 before proceeding.
Page 32 © 2015 Harris Govern



Managing Connections
Managing Connections

The Connection Key

When first introduced, the Govern New Administration (GNA) was the principal 
application used to create a Connection Key. This key allows you to 
communicate with what is referred to as your principal or primary database. 
The DeployEZ™ Publisher™ is used for deploying the Govern applications, 
when Deployments are created, they can be pre-configured with a connection 
key.

Should a connection key be required to connect with additional, i.e. 
secondary, or tertiary databases, GNA is used to generate one. See  Creating 
a Supplementary Connection Key on page 340 below for details.

Oracle Users and Connection Keys

Oracle users requiring a Connection Key will need to first exit from GNA and 
follow the setup procedures recommended for Oracle databases. See 
Connecting to an Oracle Database Server on page 350, before proceeding.

Microsoft SQL Users

Microsoft SQL users should refer to Creating a Supplementary Connection 
Key on page 340; follow the steps indicated.
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Changing the Interface

Mutually Exclusive Menu Options

In Govern New Administration (GNA) some menu selection options are 
mutually exclusive, i.e. when a selection is already made, it will no longer be 
available for selection in the list. This provides a cleaner presentation of the 
Language menu option.

Language

The Govern New Administration (GNA) interface language, i.e. Culture, can 
be changed as needed; currently the two languages supported are English 
and French.

To change the interface language:

Select Options (tab) > Options group > Culture (Select the language of 
choice)

Additional languages will be supported in future releases of Govern.

After defining, testing, and saving the connection parameters for each 
database, complete the Web Configuration for each Web site. These 
procedures are found in the next section of this guide. See Web Configuration 
File Editor on page 108 for details.

Note: The text that appears in the GNA interface can be modified with the 
MS Govern Resource Editor. Refer to Modifying Text in the 
Resource File Editor on page 195 for details.
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System Parameters
Under the Parameters tab are the forms required to configure suite 
applications. General Installation parameters such as specifying the 
Organization Name, or specifying whether a user is given the option to choose 
a database connection key upon startup are found here. 

The GNA system parameter forms can be found by selecting the Parameters 
tab > “Name of the System Parameter form” 

• General Connection Parameters... - Used to modify installation 
parameters, i.e. some settings that are set during preparation of 
deployment. See General Connection Parameters on page 36.

• General Settings Editor... - Used to define Property Control, Multimedia, 
GIS, and System Registry parameters, and the parameters used to access 
Crystal Reports. See OpenForms™ General Settings on page 40.

• User Maintenance - This form is used to maintain user data. In this form, 
new users can be created or deleted. See User Maintenance on page 52.

• Department Maintenance - The Department Maintenance form is used to 
define the profile for each department. See Department Maintenance on 
page 55.

• Report Parameters Editor... - This form is used to configure individual 
reports. See Reports in the Govern New Administration (GNA) on 
page 70.
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General Connection Parameters
In the General System Parameters form, you are presented with database 
details about the currently selected connection key, configuration parameters 
for controlling how users access the application, and synchronization and 
refresh parameters for mobile installations.

Database Default Server Type Information

In the Database Default Server Type group (A) you will see the database 
server type of the currently selected connection key.  

Specifying Connection Key Source Folder at 
Startup

As a time saver users starting up GNA can specify a connection key source 
folder; i.e. a location for the list of Connection Keys. This feature is useful in 
multiple database environments where users need to frequently switch 
between databases. By default GNA will maintain a lock on the location of the 
last selected Connection Key. The file that the GNA will obtain its list of 
connection keys from is (File: GovernDABConfig.xml)

Note: This area is informational and cannot be modified.
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Database Connection Key parameters

The list of Connection Keys are obtained from the GovernDABConfig.xml file. 
If an administrator would like to provide an alternate GovernDABConfig.xml 
file containing Connection Keys, this information can be specified.

Definition File Folder: Type in a new path to the connection keys definition 
folder, i.e. location of the GovernDABConfig.xml file, or click “...” to browse 
for a folder.

Organization Parameters

In the Govern New Administration (GNA), it is possible to modify the 
parameters that were entered at installation. In the Organization Parameters 
group, you can modify the Organization name.

Organization Name: Enter your organization name. This is the name that 
appears in the GovernNetConfig.xml document.

User Name Prefix: The User Name Prefix field is used to enter a text string 
that is added to the beginning of the User ID. This feature allows for 
backwards compatibility with Govern for Windows. The specified prefix is 
concatenated with the user name, encrypted, and stored. Since it is appended 
to the password after a user enters their assigned password, they are not 
aware of it. The use of this method means that users will never see their real 
database UserID.

User Name Prefix: If required, enter a prefix into this optional field.

To specify an Organization Name and a User Name prefix...

1. Select System Parameters > General Installation Parameters...
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2. In the Organization Parameters group, enter an Organization name, and a 
user name prefix.

3. Click Save to confirm your changes.

The user must explicitly enable editing for each parcel: When 
selected the user must click on the Edit icon in the Govern.NET Dataset 
Treeview before editing a record. By default this option is disabled.

Mobile Device Parameters

Mobile Device Connection Check Trigger (in ms): After installing a 
mobile deployment, one of its functions is to continually check the connection 
to the master database, and compare and update changes to the data.   

Note: This option is designed to minimize errors when selecting a record to 
edit in Govern. When a record is selected in the Dataset Treeview, a 
conscious effort must be made to click the Click to Edit icon a second 
time, and unlock the record for editing. 
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Connection Check Trigger (in ms): The Connection Check Trigger value 
determines the length of the interval, in milliseconds, between each check to 
verify the availability of the connection to the main database. The default is 
value 1000 milliseconds.

Synchronization Interval (in ms): The value in this field is the interval 
that will be used to force a synchronization of data between the mobile 
database and the main system database when Govern.NET’s automatic syn-
chronization option is selected. This option is set on the mobile devices 
Govern.NET install.

Note: For details about Mobile Device configuration, refer to the Govern 
Mobile Release 5.1 user guide.
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OpenForms™ General Settings

The OpenForms General Setting form is the administration application used 
for configuration of Govern’s applications and related integrations. Users that 
are familiar with the Govern for Windows applications can equate its 
functioning with the System Registry Maintenance form in the Govern System 
Administration (GovAdmin) application.

The OpenForms General Settings form is the administrative interface for 
configuring parameters required for General settings, GIS, Installed modules, 
Tax functionality, Reports, i.e. Crystal Reports™ and SQL Server Reporting 
Services (SSRS)™, and others.          

Overview

Note: Users of Crystal Reports will need to install the Crystal Reports 2015 
runtime on the server hosting the application, and on each client 
computer. Refer to the Crystal Report Runtime section of the Govern 
DeployEZ™ Installer Guide for details.
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The parameters that are accessible through the Registry Filter (A), can 
include the following:

Note: The options and modules that are displayed in the Registry Filter drop 
down menu are dependent upon the modules installed, or security 
settings enforced by the Govern Security Manager (GSM).

Registry Filter Description Reference

Accounts 
Receivable

These are the parameters that are related 
to the A/R and Tax

See OpenForms General Settings - 
Accounts Receivable option 
parameters on page 43.

Aircraft Used for Aircraft tax parameters. Go to the OpenForms General 
Settings - Aircraft option 
parameters on page 43.

Batch Process Parameters for the Govern Scheduler 
(GS).

See OpenForms General Settings - 
Batch Process option 
parameters on page 43.

Boat Configuration of Boat tax parameters. Go to the OpenForms General 
Settings - Boat option 
parameters on page 43.

External 
Documents

Used for managing interfaces for external 
documents that are supported by 
applications integrated with Govern.

Refer to the appropriate Govern 
Integration user guide. E.g. SIRE, 
AppXTender, etc.
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General These are parameters used for internal 
messages. For notifications, memos to 
employees, internal alerts; all within the 
organization.

See OpenForms General Settings - 
General option on page 44.

GIS Parameters used to configure the GIS 
server.

Refer to OpenForms General 
Settings - GIS option on page 46.

Inspection Specify default Inspection parameters. Go to the OpenForms General 
Settings - Inspection option on 
page 46.

Integration Connection parameters for Hummingbird 
Multimedia Integration, iNovah 
Integration, and other integrations.

Refer to OpenForms General 
Settings - Integration option on 
page 47.

Mass Appraisal Mass Appraisal and Comparable 
parameters.

See OpenForms General Settings - 
Mass Appraisal option on page 47.

Motor Vehicle Configuration of Motor Vehicle tax 
parameters.

Go to the OpenForms General 
Settings - Motor Vehicle option on 
page 47.

Name Used to set default account number 
names, formats, and barcode parameters.

Refer to OpenForms General 
Settings - Name option on page 47

Permit Land Management, Permitting 
parameters.

See the Govern Permits & 
Inspections Release 5.1 user guide 
for details.

Personal Property Personal Property parameters as related 
to tax.

Go to the OpenForms General 
Settings - Personal Property 
option on page 48.

Property Control Parameters used to configure Property 
Control

See the Govern Property Control 
Release 5.1 user guide for details.

Real Property Real Property parameters as related tax. See the Govern Real Property 
Release 5.1 user guide for details.

Report Configuration of access parameters as 
they relate to Govern
Configuration support for SQL Server 
Reporting Services (SSRS)

Go to the OpenForms General 
Settings - Report option on 
page 49. For SSRS refer to the 
Govern SSRS user guide for details

Self Reported Tax Parameters that are related to Self 
Reported Tax

See the Govern Self Reported Tax 
Release 5.1 user guide for details.

Registry Filter Description Reference
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OpenForms General Settings command buttons

Save: Complete the parameters and click Save to save the general 
connection settings.

Exit: Click Exit to close the form without saving the information or making 
modifications to existing settings.

OpenForms General Settings - Accounts 
Receivable option parameters

Under the Accounts Receivable Registry Filter option are the configuration 
parameters required for Governs’ Accounts Receivable module. See the 
Govern Accounts Receivable Release 6.0 guide for details.

OpenForms General Settings - Aircraft option 
parameters

Under the AIrcraft Registry Filter option are the configuration parameters 
required for Governs’ Aircraft tax module. Refer to the Govern Tax user guide 
for details.

OpenForms General Settings - Batch Process 
option parameters

Under the Batch Process Registry Filter option (A) are configuration 
parameters required for Governs’ Scheduler. Refer to the Govern Scheduler 
Release 6.0 user guide for details.

OpenForms General Settings - Boat option 
parameters

Under the Boat Registry Filter option are the configuration parameters 
required for Governs’ Boat tax module. Refer to the Govern Tax user guide for 
details.
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OpenForms General Settings - External 
Documents option parameters

Parameters for specifying external document types are displayed under this 
registry filter; e.g. AppXTender, SIRE, and so on. 

OpenForms General Settings - General option

The General option contains multiple configuration parameters for the various 
modules of Govern. As a result of the nature of the form, parameters required 
due to being customized are also displayed. Descriptions for these 
parameters are not described in this document. Parameters for each specific 
module can be seen under the Section Name and Key Name columns. 
General Option - Default Section Name parameters

Country Format: The country code formats the mailing information, 
according to the standards of the country from which the mail is sent. This 
code sets the default. The user can override the default, for the current record, 
on the Name and Address Maintenance function in Govern. (Table: 
VT_SY_MAILFMT)

Format Name Proper Case: Select one of the following options to set a 
default of whether, and how field names are to be formatted. 

• 1st Letter (N&A) - Saves the first letter of each field in upper case
• No - Select to save the data as entered
• Ucase - This saves the Name & Address, Property Location, and forms 

from the NA_NAMES and PC_ADDRESS tables, and any data that is 
masked in other tables, in upper case.

• Ucase (N&A) - This will save the Name & Address data (from the 
NA_NAMES and PC_ADDRESS tables) in upper case.

General option - General Section Name parameters

County: This is an optional field that is customized for specific organizations, 
this code will be provided by Govern. If required, enter your County Code in 
this optional field.

Customer Code: Enter a Govern three (3) letter customer code if instructed 
by Govern Customer Support; e.g. WAL - Waltham. 
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Database Date: Select one of three (3) formats for saving dates in the 
database.

Flag to automatically open high/low/normal priority messages: 

Refer to Global Messages and the User Registry section of the Govern 
General Information guide Release 5.1. 

Help Folder Structure Type: See Help Content Directory Structure on 
page 411 for details.

Login Prefix: In this optional field, enter a code to add to the beginning of 
the User ID. This information is invisible to the user. If the database login is 
automatic, using a prefix provides increased security since the users will never 
see their full, complete, database UserID.

Notification flag for high/low/normal priority messages: Refer to the 
Displaying Notification section of the Govern General Information guide 
Release 5.1 for additional details about the Govern Global Messages 
notification system.

Primary Activation Key: This parameter is intended for use by users 
whose licenses were issued with Govern for Windows Release 8.5 or earlier. 
At the time, the structure of the license was as follows:

• organization name=databaseName
• serial number=123456-12345678987-654321
• primary activation key=1234
• secondary activation key=

State: Enter a two (2) letter state name; e.g. ma for Massachusetts

General option - SMTP Section Name parameters

Users that are familiar with the settings of Govern will note that there are two 
(2) locations for entering SMTP information. The first is here in the General 
section, the other is the GNA Web Site Editor under the General tab. Refer to 
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the MS Govern eGovern - Public Self Service Portal Release 5.1 guide for 
details.

SMTP Default Sender Address: Enter the E-Mail address that will be 
used to send responses that do not require a reply from the destination. These 
can be system status messages, e.g. Notification of Outages, Maintenance 
Notifications, etc.

SMTP Host: Enter the name of the internal SMTP host, e.g. 
smtp.mycompany.com

SMTP Password: This is the password that is used to access the server. 
Text entered into this field will appear “cloaked”, i.e. typed letters will be 
displayed as asterisks “ ****** ” to hide the typed letters.

SMTP Port: Type the port number that is dedicated to SMTP messages.

SMTP User: This is the user name that w ill be used to access the SMTP 
account.

OpenForms General Settings - GIS option

The GIS option contains the parameters that are required to configure the GIS 
server. For the GIS configuration instructions, refer to the Govern GIS 
Integration user guide.

OpenForms General Settings - Inspection option 

Under the Inspection Registry Filter option are the configuration parameters 
required for Governs’ Permits & License module. See the Govern Permits & 
Licenses user guide for details.

Note: It is recommended that these system registry parameters be used for 
internal messages, i.e. messages sent to users that are located within 
the network DMZ.
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OpenForms General Settings - Integration 
option

Under the Integration Registry Filter option are the configuration parameters 
required for Governs’ integration applications and services. Refer to the user 
guide for each specific integration. Current integrations include the following:

• Hummingbird - For details about Hummingbird Integration, refer to the 
Govern Hummingbird Integration Release 5.1 guide.

• iNovah - Details for iNovah integration can be found in the Govern iNovah 
Integration user guide.

• Melissa Data - Refer to the Melissa IMB Integration Release 5.1 user 
guide for details.

OpenForms General Settings - Mass Appraisal 
option

Under the Mass Appraisal Registry Filter option are the configuration 
parameters required for the Govern CAMA modules. See the Govern CAMA 
Buildings, CAMA General Information, CAMA Income, CAMA Land, CAMA 
Misc. Structures, CAMA Sales & Comparable Sales, Release 6.0 user guide.

OpenForms General Settings - Motor Vehicle 
option

Under the Motor Vehicle Registry Filter option are the configuration 
parameters required for Governs’ Motor Vehicle Tax module. Refer to the 
Govern Tax user guide for details.

OpenForms General Settings - Name option

Name option - Intelligent Barcode Name parameters

The Intelligent Mail barcode (formerly known as the 4-State Customer 
Barcode) is used to sort and track letters. Intelligent Mail barcode technology, 
combines the capabilities of the POSTNET™ barcode and the PLANET 
Code® barcode into one unique barcode.
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Under the Name Registry Filter option are the configuration parameters 
required for configuring the Intelligent Mail Barcode. Barcode formats that are 
supported are IMB_31 and IMB_65.

Barcode ID: Enter the ID of the Barcode (2 digits; 2nd digit must be 0-4)

Generate Mail Barcode on Save: Select this option to automatically 
generate a barcode when a new name is created or an update is made in the 
Name & Address Maintenance function.

Mailer ID: Enter a Mailer Identifier (6 or 9 digits)

Service Type ID: Type the Service ID in this field (3 digits).

Serial Number: Specify a serial number, this is a 9 digit code when used 
with a 6 digit Mailer ID, or a 6 digit code when used with a 9 digit Mailer ID.

OpenForms General Settings - Personal 
Property option

Under the Personal Property Registry Filter option are the configuration 
parameters required for Govern’s Personal Property module. See the Govern 
Tax: Personal Property Tax Billing & Collection user guide for details.

OpenForms General Settings - Property Control 
option

Selecting the Property Control option in the Registry Filter will display the 
System Registry options that are available for the Govern Property Control 
module. These Registry Keys also include the Property Control Split / Merge / 
Remap process. Refer to the Govern Property Control Release 6.0 user guide 
for details about these parameters.
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OpenForms General Settings - Report option

Report option - Crystal Reports Section Name parame-
ters

Use Crystal Reports: Select this option to enable the system for Crystal 
Reports.

Standard Report Path: Specify the UNC path to the standard reports.

Custom Report Path: Enter a UNC path to any custom reports.

Reports and Database Access

Reports Connecting to the Database

Legacy Reports from Govern for Windows connected to a database using an 
Open Database Connectivity (ODBC) connection string. In Govern release 6.0 
ActiveX Database Object (ADO) connections are used. The conversion for an 
ODBC string to ADO occurs at runtime.

Standard reports that came with Govern for .NET will use the default 
connection key, or an override, when one is specified in the Report Editor 
form. See Intelligent Scanning of reports in Reports Editor on page 72.

Note: Users of Crystal Reports will need to configure the following 
parameters to access the reports. See Providing Database Access for 
Crystal Reports on page 50 for steps.

Note: It is possible to configure access on a report by report basis; this level 
of granularity is accomplished through the Report Editor, see Reports 
in the Govern New Administration (GNA) on page 70

Note: Users of Crystal Reports will need to install the Crystal Reports 2015 
runtime on the server hosting the application, and on each client 
computer. Refer to the Crystal Report Runtime section of the 
DeployEZ™ Installer Guide for details.
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OpenForms General Settings - Reports option for Crystal 
Reports™

Providing Database Access for Crystal Reports

To allow Crystal Reports to access your database...

1. In GNA, select the System Parameters tab > General Settings Editor...

2. In the OpenForms General Settings form, select Reports (A) from the 
Registry Filter parameter 

3. Click to select the Use Crystal Reports (1) option.

4. Under the Crystal Reports tab enter the Standard Report Path (2).

5. If applicable enter a Custom Report Path Name (3).

For additional information on using Crystal Reports in Govern Release 6.0, i.e. 
use of formulas, Best Practices, and so on, refer to Crystal Reports on 
page 401.
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OpenForms General Settings - Reports option for SSRS

Users of SQL Server Reporting Services (SSRS) should refer to the SSRS 
Release 6.0 user guide for installation and configuration details.

Notes for Govern for Windows Users

In Govern, a Profile is the equivalent of a Department in Govern for Windows. 
Inside a department there would be Functions and Reports. In Govern, this 
same analogy can be applied. Functions are referred to as OpenForms. In a 
Profile, we would have OpenForms and Reports. In Govern for Windows, 
inside a department we can have Functions for tasks like Permitting, 
Complaints, Offences or obtaining Property Information.
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User Maintenance

The User Maintenance form maintains user data. In this form, new users can 
be created, their access passwords can be set, or user profiles that are 
inactive can be removed.

Access rights can be set in the Govern Security Manager (GSM).

To access this form, from the Govern New Administration (GNA)...

1. Select the System Parameters tab in the GNA ribbon.

2. Click to select User Maintenance..

Overview
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User Maintenance command buttons

Browsing User Records: In the User Maintenance form, the list of existing 
user profiles can be seen on the left hand side (LHS).

Creating a User: Click New to clear the form and create a new user 
profile.

Canceling Changes / Creation of a User: To cancel the creation 
of a user, click the Cancel Changes icon. This icon is similar to the 
Create a New Item icon during the creation process. A confirmation 
message appears if there are any unsaved modifications.

Saving a User Record: Click Save the Current Item to save a new 
user profile or modifications to an existing one.

Deleting a User: Click Remove the Current Item to remove the 
current user record.

User Maintenance parameters

These are the parameters that are located in (Table: USR_USERFILE).
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ID: This informational field displays the unique user ID (U_ID) of the current 
record; this information cannot be modified.

Inactive From: Enter the expiration date for the account; i.e. the date after 
which the account is no longer active. Dates are entered in the following 
format: DD/MM/YYYY. The date may be entered manually, or the date control 
can be used. (Table: USR_USERFILE.INACTIVE_DATE)

User ID: The User ID is the user identification required for login. (Table: 
USR_USERFILE.USR_ID)

Password: Enter the password for the user; passwords will be cloaked, i.e. 
appear as an asterisk “*” when being entered. This value is encrypted in the 
database. (Table: USR_USERFILE.PWD)

Name: For this parameter, enter the full name of the user. This field supports 
up to 32 characters; spaces are included in the count. (Table: 
USR_USERFILE.NAME)

Initial: Enter the initials of the user; a maximum of three (3) letters are 
supported. (Table: USR_USERFILE.INITIAL_NAME)

Email: Enter the email address contact for the user. This e-mail address is 
used in the Messaging System function within the Permits & Inspections 
subsystem. (Table: USR_USERFILE.EMAIL)

Any modifications to a record, or creation of a record are presented with the 
option to Save. Click Yes to accept the changes. When there are Validation 
issues with the record, the Validation Errors form is presented. Click OK to 
continue. 
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Department Maintenance

The Department Maintenance form is used to define the profile for each 
department. This includes the fiscal year used by the department, access to 
the Govern data entry functions and access to Accounts / Receivable data. 
This form also contains the Multimedia Parameters and Multimedia Codes.

To access this form, from the Govern New Administration (GNA)...

1. Select the System Parameters tab in the GNA ribbon.

2. Click to select Department Maintenance..

Overview
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Department Maintenance command buttons

Browsing Records: In the Department Maintenance form, the list of 
existing department profiles can be seen on the left hand side (LHS).

Creating a Department: Click New to clear the form and create a 
new department profile.

Canceling Changes / Creation of a Department: To cancel the 
creation of a Department, click Cancel changes icon. This icon is 
similar to the Create a New Item icon during the creation process. A 
confirmation message appears if there are any unsaved modifications.

Saving a Department Record: Click Save the Current Item to 
save a new department profile or modifications to an existing one.

Deleting a Department: Click Remove the Current Item to remove 
the current department record.

Department Maintenance - General tab 
parameters

Department Code: This code is used to Identify the department. All links to 
this department will use this code. All alphanumeric characters are valid.

English Short Description: In the English Short Description field (or the 
Short Description field for your first language), enter a description using a 
maximum of 25 characters.

English Long Description: In the English Long Description field, enter a 
description up to a maximum of 50 characters.

Note: When a Short Description is entered and you click in the Long 
Description field, it is copied into the Long Description field.
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French Short Description: In the French Short Description field (or the 
Short Description field for your first language), enter a description using a 
maximum of 25 characters.

French Long Description: In the French Long Description field, enter a 
description up to a maximum of 50 characters.

Any modifications to a record, or creation of a record are presented with the 
option to Save. Click Yes to accept the changes. When there are Validation 
issues with the record, the Validation Errors form is presented. Click OK to 
continue. 

Fiscal Year: This field will display the fiscal year that the current department 
will work in; when creating a new department, this will be the fiscal year that 
the department will be working in.

Modifying the Fiscal Year

To modify the Fiscal Year value, click in the field, select the existing year and 
overwrite the value.

Privacy / Restrictions for Names

Name Group Code: You can create a Name Sharing Group in order to 
extend access rights to the name and address records, created by your 
department, to one or more of the other departments, within your organization.

Use the options in this group to set up access rights for Name and Address 
records; to do this you need to define the following:

Note: When a Short Description is entered and you click in the Long 
Description field, it is copied into the Long Description field.

Note: This field must be modified manually when the department changes to 
a new fiscal year.
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To create a Name Sharing Group, enter a code of one or two characters in this 
field. Then, enter the same code when you set up the other departments in 
this group.

Next, select one of the following options to define the access rights for the 
departments included in the Name Sharing Group and for those outside of it. 

The code of the Name Sharing Group and the type of security permissions are 
displayed on the Name and Address Maintenance function in Govern, unless 
the records are private to another department. If the name is restricted, it is 
grayed out and cannot be modified. Similarly, if the address is restricted, it is 
also grayed out and cannot be modified.

There are four (4) levels of security for name and address records.

• No Restrictions - There are no restrictions to the Name and Address 
portions of the records, they can be searched, modified, or deleted. Other 
users are equally unrestricted.

• Private Names - Name and Address records, are private to the 
department or Name Sharing Group, where they were created. Other 
users can’t search, modify, or delete these names. They can only view 
them if they are already link to other Govern functions

• Restricted Names - Names in the Name and Address records are 
restricted to the department or Name Sharing Group, where they were 
created. Other users can view the names can’t modify or delete them. 
They are still able to search for the records and modify the addresses.

• Restricted Names and Addresses - Both the name and address 
portions, of the Name and Address records, are restricted to the 
department or Name Sharing Group where they were created. Other users 
can perform a search for these records but cannot modify or delete them.
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Name & Address Security Grid

The two (2) grids below should serve as a guide to the users level of access 
when they are Within a Department in a group, or Outside of the Name Group. 
For example in the Name & Address form, a user that is in the Building 
Department, and is a member of the Create/Modify/Delete group, within their 
department, for Names that are designated as Private, will be able to Search 
for the name, Link to the name, Modify Addresses, and Delete Names. 
Although note that according to the system rule, this user is not able to Modify 
(A) the name. Outside of their name group they have no access (B). Refer to 
the grids below for details.
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The following grid should serve as a guide to system imposed user restrictions 
for Name Sharing groups. 
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Name & Address Maintenance Security

After creating a Name Sharing Group, you can further refine name and 
address maintenance by setting access permissions for each user. 

Security for the Name & Address Maintenance function is more complex than 
for the other functions due to the important and sensitive nature of the data.

There are four levels of user access that can be set for each Govern function 
that typically provide the following rights:

• Inquiry Only: The user is only able to view the data for the specified 
function.

• Create and Modify: The user can view, create and modify data for the 
specified function.

• Create, Modify, Delete: The user can view, create, modify and delete data 
for the specified function.

• Full Access Rights: The user can view, create, modify and delete data 
and could also modify and delete historical data for the specified function.

However, in order to grant the permission to create names to any user, 
including a Super User or a user with Full Access Rights to the Name & 
Address Maintenance function, the Allow Creation of Names option must be 
selected on the User Maintenance form in Govern Admin. 

The following tables display the different levels of access security for the 
Name & Address Maintenance function, according to the following tasks:

• Search: the right to search for a name and address record through the 
various search screens; for example the Name Search or the Name & 
Address Search. Refer to the Property Control guide for further details.

• Link: the right to link a name and address record to another function; for 
example, a Permit function, the Owner Information, Occupant / Business, 
Related Lien Names, ACH Information by Name or the Real Estate or 

Note: Super Users are automatically given Full Access Rights to all 
functions.
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Utility Billing Mailing Index, provided the user has access rights to these 
functions.

• Create: the right to create a new name and address record.
• Modify Name: the right to change name data: i.e., first name, last name, 

company name or formatted line_1.
• Modify Address: the right to change the address part of the record.
• Delete Name and Address: the right to delete name and address records.

The following conventions are used in these tables:

Restriction Level: Private Names

* The permission to create names is granted if the Allow Creation of Names 
option is selected on the User Maintenance form, in Govern Admin. Users can 
then create names within their primary department and within the Name 

Symbol Definition

 The user has permission to perform the task.

 The user does not have permission to perform the task.

Permission Levels Ability to Perform Name & Address Maintenance Tasks

Access Type
Name Sharing 

Group
Search Link Create

Modify
Delete

Name Address

Super User or 
Full Access 
Rights

Member   *   

Non-Member     

Create, Modify 
and Delete

Member     

Non-Member     

Create, Modify Member     

Non-Member     

Inquiry Only Member     

Non-Member     
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Sharing Group, selected for the department. Otherwise, users do not have 
permission to create names, regardless of their department, regardless of the 
Name Sharing Group in which the department is a member and regardless of 
User Access Type.

Restriction Level: Restricted Names & Addresses

Restriction Level: Restricted Names

Permission Levels Ability to Perform Name & Address Maintenance Tasks

Access Type
Name Sharing 

Group
Search Link Create

Modify
Delete

Name Address

Super User or 
Full Access 
Rights

Member   *   

Non-Member     

Create, Modify 
and Delete

Member     

Non-Member     

Create, Modify Member     

Non-Member     

Inquiry Only Member     

Non-Member     

Permission Levels Ability to Perform Name & Address Maintenance Tasks

Access Type
Name Sharing 

Group
Search Link Create

Modify
Delete

Name Address

Super User or 
Full Access 
Rights

Member   *   

Non-Member     
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Restriction Level: No Restrictions

Create, Modify 
and Delete

Member     

Non-Member     

Create, Modify Member     

Non-Member     

Inquiry Only Member     

Non-Member     

Permission Levels Ability to Perform Name & Address Maintenance Tasks

Access Type
Name Sharing 

Group
Search Link Create

Modify
Delete

Name Address

Super User or 
Full Access 
Rights

Member   *   

Non-Member     

Create, Modify 
and Delete

Member     

Non-Member     

Create, Modify Member     

Non-Member     

Inquiry Only Member     

Non-Member     

Permission Levels Ability to Perform Name & Address Maintenance Tasks

Access Type
Name Sharing 

Group
Search Link Create

Modify
Delete

Name Address
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Summary

1. Only users with Full Access Rights on the Name and Address 
Maintenance function can modify a name even within their Name Sharing 
Group.

2. Even with Full Access Rights, users can modify a name, outside of their 
Name Sharing Group, only if the No Restrictions option is selected on the 
Department Setup form.

3. Users with Full Access Rights, Create, Modify, Delete or Create, Modify 
rights can always modify an address within their name sharing group.

4. These users can modify an address created outside their Name Sharing 
Group only if the Restricted Name or No Restrictions option is selected 
on the Department Setup form.

5. Users with Full Access or Create, Modify, Delete rights can delete name 
and address records even though they may not be granted permission to 
create or modify them.

6. All users can view and search for a name and address records unless 
Private names is set for the department and the department is outside 
their Name Sharing Group.

7. Users can create names if the Allow Creation of Names option is 
selected on the User Maintenance form, regardless of whether or not the 
user’s department is a member of the Name Sharing Group and 
regardless of the user ‘s Access Type.

If this option is selected users can create names within their primary 
department and within the Name Sharing Group, selected for the 
department.

Access to Accounts / Receivable Information

A/R Sub Systems Allowed: The department has access to the Accounts 
Receivable (A/R) data of each selected subsystem. Users can view, update 
and process these data through the Accounts / Receivable functions, including 
A/R Inquiry, Payment Data Entry and Cash Collection Posting.
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Access to the Govern Functions

Forms / Functions group

In Govern, users will access functions by first logging into a department. Only 
the functions that are selected for the department, on this form, will be 
accessible to those users.

Department Maintenance - Multimedia 
Parameters tab

The Multimedia Parameters tab contains the parameters that are required to 
specify the paths for multimedia files for the various Profiles.

Often a single location for all department multimedia storage requirements 
may not be practical. For example, the Building Department may have need of 
a location that offers large storage capacity and processing power due to its 
extensive use of high resolution images and video files. In contrast, the needs 
of the Treasurers Department may be more modest. In addition maintenance 
cycles, i.e. backup of files, will vary for these different departments. With the 
Multimedia Department Setup option, it is possible to specify a separate path 
for multimedia files for each department.

Note: If no setup is specified for a department, then the multimedia settings 
from the System Registry Maintenance form will be used by default.
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Multimedia Document Path

When configured, Multimedia document attachments will be stored using the 
following directory structure:

\\server\department\yyyy\mm where...

• department - This is the configured department
• yyyy - The current year
• mm - This is the current numeric month (i.e. Jan. = 01, Feb. = 02, etc.)

An example file path using this structure for the building department on a 
server designated as ‘Apollo’ might be as follows:

\\apollo\bldg_dept\2010\04

Level 1 Archive Document Path: This path will contain all the multimedia 
documents. The system creates a new directory in this path each time you 
save a multimedia document. The directory name is the date you have saved 
a document, for example, 20150430: April 30th 2015. All the documents you 
save during the course of a day will be saved under the same directory.

Level 2 Archive Document Path: This path will contain all the archived 
multimedia documents from Level I after running the Archive Multimedia Batch 
Process.

Level 3 Archive Document Path: This path will contain all the archived 
multimedia documents from Level II after running the Archive Multimedia 
Batch Process.

Multimedia Levels by Year: Select this option to create an additional 
folder for archiving your multimedia images. A directory named by the current 
year will be added to the end of the multimedia image paths at each level.

Multimedia Levels by Month: Select this option to create an additional 
folder for archiving your multimedia images. A directory named by the current 
Month will be added to the end of the multimedia image paths at each level.
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Hide Document Path: When selected this option will hide the full path to 
the document on the users screen.

Restrict External File Types

When specifying the Multimedia Document Path for each department, you are 
able to apply limitations to external file types. You can specify which external 
file types are displayed based upon their extension, i.e. which file types are

previewed by the system, in addition you can limit the size of the file that is 
being saved for better storage management.

Limitation for Other External Type (No permanent path) group

Limit to File Type (jpg, pdf,...): With this text string you can specify which 
external file types are displayed based upon their extension, i.e. which types 
are previewed by the system.

Maximum Size (MB): With this option, each department within the system 
can limit the size of the Multimedia document that is being saved.

Note: The hide Document Path option can serve as a security feature that 
when enabled, will restrict users from locating the file and accessing it 
from applications other than within Govern.
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Multimedia Archive Path at System Registry Level

The Multimedia Archive Path can be set at the System Registry level through 
the OpenForms General Settings form. When a UNC path is specified at the 
System Registry level, it will be used as the default. If a different path is 
specified in the Department Maintenance form, it will override the System 
Registry settings.
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Reports in the Govern New 
Administration (GNA)

The Report Parameters Editor form is used to configure reports on an 
individual basis. These reports display query results found in the fields of 
tables within the data source.

Reports are given access through the default connection key. If required, they 
may also be configured using an alternate connection key. As long as the 
alternate connection key has been defined in the Connection Key 
Management form, it will be available in the Alternate Connection Key list. See 
Alternate Connection Key Properties group on page 75 for details about 
alternate connection keys. In Release 6.0 of GNA, there is enhanced support 
for SQL Server Reporting Services (SSRS)™. SSRS reports and Crystal 
Reports™ are configured in the OpenForms General Settings form, see 
OpenForms™ General Settings on page 40 for details.

To access the Report Parameters...

1. In the GNA ribbon, select the System Parameters tab.

2. Click the Report Parameters Editor icon (A)..

Overview
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Report Parameters Editor Command Buttons

Create a new item: Click Create a new item  to add a new report to the 
List of Reports column on the left hand side.

Delete: Select a report from the List of 

Report List; click Delete  to remove 
the report from the list. A confirmation 
window will appear, click yes to 
continue.

Save: After modifying parameters of a 

report, click Save  to save the changes.

Report Parameters Editor - Report Tab 
parameters

Report Name: Enter a name for the report; the length of the name is limited 
to a maximum of 15 characters. 

Audit Trail: When this option is selected, log entries are made that track the 
number of times that the report is run.

English Short Description: This is the English description that will be 
used for fast data entry and look-ups where space is limited on forms.

English Long Description: Enter the English description that will be 
displayed for look-ups on forms, and normally used for reporting.

French Short Description: This is the French description that will be used 
for fast data entry and look-ups where space is limited on forms.

French Long Description: Enter the French description that will be 
displayed for look-ups on forms, and normally used for reporting.

Note: When you click on New the button changes to Cancel  ; this will 
allow you to cancel the creation of the current record. The Cancel 
button is present until the new record is saved.
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Intelligent Scanning of reports in Reports Editor

There is an underlying intelligence in the 
functioning of the Reports editor. Both 
SQL Server Reporting Service (SSRS) 
and Crystal Reports reports are read, and 
the data sources are scanned. 
Connection options to the database are 
by default specified as the current 
connection. If required, secondary 
sources can be selected from a list of alternate Connection Keys. During the 
initial scanning phase, if a report is determined to be invalid, i.e. incompatible, 
a warning is displayed in the form of a window with a list of the offending 
reports.

Details of the Report Scanning Process

When the Report Editor is launched, each report that is selected from the List 
of Reports list is scanned. The report connection key is tested. When the 
system encounters either a Crystal Report or an SSRS report that is not 
associated with a Govern connection key, the system will ask to associate the 
report with...:

• The current Connection Key (Default) OR 
• The user can see the path to the data source, and may select a 

connection key from the list of available Alternate Connection Keys.

Note: When there is no backward compatibility with a report the default 
connection setting will be used.
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Recordset Key: This option provides the ability to run the report by dataset, 
e.g. current P_ID, current dataset, or database. In the drop down menu list, 
select the primary key that will be used by this report, otherwise the user will 
not be prompted to select a dataset for the report. 

During the “Database Verification” process...

After performing an update / general maintenance, or defining database 
connections, running the Database Verification process is recommended 
as it will update the database for access by Govern applications.When this 
process is run in GNA, during the Misc. Corrections phase a script 
performs the following:
• Conversion of Alternate Connection Key information (i.e. server, 

database names, etc.) into the Connection Key in the new table.

The following four (4) fields will be set to NULL:
• [DTSRC_SERVER]
• [DTSRC_DBNAME]
• [DTSRC_UID]
• [DTSRC_PASSW]

Note: In the SY_REGISTRY screen, four key names were removed, 
• [DTSRC_SERVER]
• [DTSRC_DBNAME]
• [DTSRC_UID]

Note: A Record Set Key should be specified.
© 2014 MS Govern Page 73



Govern New Administration (GNA)
The report dataset will be filtered with a list of values for the selected key.

Example: SELECT * FROM pc_parcel WHERE p_id = ‘123’ OR p_id = ‘456’ 
etc.

Report Criteria: Click Report Criteria (A) to display the editor. The Report 
Criteria Editor is used to configure prompts for reports that require user input. 
See Report Criteria Editor on page 77 for details on configuring prompts.

The report dataset will be filtered with a unique value for the selected keys.

For Example...

SELECT * FROM pc_parcel WHERE p_id = ‘123’

Criteria Key group

Add Criteria Key: Click Add Criteria Key to display the criteria key list; 
select one or more criteria to be added, click OK or Cancel.

Remove Criteria Key: Select a criteria key from the Criteria Key list and 
click Remove Criteria Key to remove it from the list.
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Alternate Connection Key Properties group

Although database connection parameters are set in the Govern DeployEZ™, 
they can be overridden on a report by report basis. If required, each report can 
be configured with an alternate connection key.

Data Source: This is the path to the server that the report will be accessing.

Alternate Connection Key: Select an alternate Connection Key from the 
list.

Report Group

This parameter contains the Report Grouping for the Report Explorer in 
Govern.

Upper/Lower Level: Click to configure these parameters to indicate the 
location of the report in the Treeview pane in Govern.

For Example...

When the following report, Mass App.- Inventory Report is configured to 
appear in the following Report Group; Upper Level: List & Reports, and 

Note: All settings made in this section override the current, default, 
connection key. Users should ensure that they alternate connection 
key required has been entered in the Connection Key Management  
form. See GNA and Connection Keys (CK) on page 340.

Note: SQL Server Reporting Services (SSRS) can have a different alternate 
connection key for each data source found in the Report
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Lower Level: CAMA. In Govern, the report will appear in the List & Report 
upper folder (A) and CAMA lower folder (B): 
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Report Criteria Editor

User designed Crystal Reports™ are generated from data obtained from the 
data source. In some instances user input requested by a prompt is required 
to filter the data, e.g. entering a date range, specifying a fiscal year, etc. In 
other instances the data must first be extracted and “preprocessed”. For these 
types of reports it is necessary to configure the preprocessing. This 
configuration is in the form of prompts for the user to enter required criteria.

To display the Report Criteria Editor...

1. In the GNA ribbon, select the System Parameters tab.

2. Click the Report Parameters Editor icon.

3. Select a report from the List of Reports column on the left hand side.

4. In the Report Editor, click Report Criteria (A).

Overview

Note: Attempting to run reports without configuring required prompts will 
result in an error.

Note: Users of Crystal Reports will need to install the Crystal Reports 2015 
runtime on the server hosting the application, and on each client 
computer. Refer to the Crystal Report Runtime section of the 
DeployEZ™ Installer Guide for details.
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In the Report Criteria Editor (B), you are able to configure any required user 
prompts. See Adding one or more Criteria to a Report on page 79 for details 
about adding prompts.

Report Criteria Editor - Properties tab Command 
Buttons

 Create a new item: Click Create a new item to add a new criteria to the 
Report Criteria column on the left hand side.

 Cancel the creation of a new entry: When you click on the New 
button to create a new entry record, the New button changes to the Cancel 
button. Click this button to cancel the creation of the current record.

 Save the current item: Click Save the current item to save a record to 
the database.

 Up: When there are two (2) or more criteria in the Report Criteria column, 
you are able to define the order that each criteria will be displayed in the user 
prompt. Click to select the criteria that is to be moved up in the list; click Up.

 Down: When there are two (2) or more criteria in the Report Criteria 
column, you are able to define the order that each criteria will be displayed in 
the user prompt. Click to select the criteria that is to be moved down in the list; 
click Down.

 Delete: Select a criteria from the Report Criteria column; click Delete to 
remove the criteria from the list. A confirmation window will appear, click Yes 
to continue.

Modify: Make modifications to any of the parameters that; click Modify to 
confirm the modifications.
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Exiting from the form

To close the form, click the Close button (X) in the upper right hand corner of 
the form if changes have been made to any of the properties, you will be 
presented with a prompt; select Yes to accept the changes.

Report Criteria Editor Parameters

Report Criteria: The Report Criteria column displays the list of criteria that 
are associated with the report. When a criteria is selected, its parameters are 
displayed in the Report Criteria Editor.

Report Criteria Properties group

Prompt: Enter a name that will appear in the title bar of the user prompt.

Table Selection: Select the table that data is being selected from using the 
drop-down menu.

Field Selection: In the drop-down menu, select the field within the table that 
is being selected.

User Validation Table: If the criteria has to be validated with a user 
validation table, select the table from the drop-down menu.

System Validation Table: If the selected criteria is to be validated with a 
system validation table, select one from the drop-down menu.

Ask for Range: Select Ask for Range to display a range prompt; e.g. 
entering a date range.

Adding one or more Criteria to a Report

When linking reports to a profile, it may be necessary to customize the report 
to make it more interactive. This can include requesting that the user enter a 
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date range to define the scope of the report. For example, we can include a 
report for an Audit Trail Inquiry, but we will need to specify the criterion that we 
want to user to enter.

To specify the criteria for a report...

1. In GNA, click the System Parameters tab. Click the icon for the Report 
Parameters Editor (A).

2. In the Report Editor, click to select a report from the List of Reports: (A); 
for this example we will be modifying the Owner Listing report.

3. By default the report has a criteria called Tax Map Number. For our report 
we would like to be able to search for a Last Name as well as a First 
Name.
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4. Click Report Criteria (B) to display the Report Criteria Editor.  

5. In the Report Criteria Editor, click New (A) to begin adding your criteria.
Under the Prompt parameter, enter First Name (1).

6. For Table Selection, select na_names (2).

7. Under Field Selection, we are looking for the FIRST_NAME (3); we will not 
be using any user or system validation tables. 

8. Do not select the Ask for Range option because it is required for these 
parameters.

9. Click Add (4) to add the criteria to the Report Criteria list.

10. Repeat the above steps to add a criteria called Last Name. 

Change the order of appearance of the criteria

Should you want to change the order that the criteria are presented to the user 
on the form in Govern...

1. Select the criteria under the Report Criteria list (1).
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2. Click Up or Down (2) to move them.

3. When complete, click Save.

4. Click the Close button (3) to return to the Report Editor.

5. In Report Editor, click Save and exit from the form.

In Govern, you can preview your updated profiles. Reports are viewed under 
the Reports Explorer. The two (2) added criteria appear on the form. Users 
can now perform a search for specific first names and/or last names in 
addition to the tax map number (A), (B). 
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Configuring Applications

The Govern suite can be enhanced with modules designed to extend 
functionality. There are modules for providing GIS functionality, Self Reported 
Tax, Web, i.e. Internet/Intranet functionality through the eGovern Public Self 
Service Portal. Configuration parameters for these modules can be found 
under the Application Configurations tab.

GIS Configuration group

GIS Configuration forms are located under the Application Configurations tab 
> GIS Configuration group (B) > “Name of the GIS form”

Overview

Note: Full GIS integration involves the use of the Property Control GIS Web 
services. Users should ensure that their Username and Password are 
entered in the USR_USERFILE table.
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GIS Parameters

Enter the parameters used to publish the Service Map and the locations of the 
various services used by the GIS View application. See GIS Parameters 
Editor on page 91

GIS Tooltip

Use this form to enter the “tooltips” that will appear in the GIS Application. See 
GIS Tooltip Editor on page 96.

GIS Synchronization Tool

Use this form to synchronize your GIS View data to the MS Govern database. 
Parcels from the GIS will be linked and imported to MS Govern's database. 
See GIS Synchronization Tool on page 98.

Govern Tax

Real Property

The following forms found under the Real Property icon in the Govern Tax 
group, are used to configure the Govern Real Property Tax module. 

• General Parameters
• Swis Codes
• Levy Codes
• Exemption Codes
• Levy Groups
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• Exemption Groups
• Averaging Assmt. Values
• Cap Levy Group

Refer to the Govern Real Property Release 6.0 user guide for details about 
configuring the respective forms.

Self Reported Tax

The Self Reported Tax form is used for designing the layouts of Self Reported 
Tax entry forms in the Self Reported Tax OpenForm. 

• SRT General Parameters
• SRT Categories
• SRT Periods

Accounts Receivable

The form(s) found under the Accounts Receivable icon in the Govern Tax 
group, is/are used to configure the Govern Accounts Receivable module. 

• A/R Class

Refer to the Govern Accounts Receivable Release 6.0 user guide for details 
about configuring the respective forms.

Govern Web Configuration Tools

The Web Configuration tools allows you to modify the look and feel of the 
eGovern Public Self Service Portal Web sites. They are used to design and 
maintain the Web page templates that are used by the Web Search 
components. The editors offer basic web page editing capabilities and access 
to required configuration parameters. 

A feature of the Govern New Administration (GNA) is its ability to manage 
multiple web sites within the same database, i.e. you are able to manage 
multiple sites and their respective files within the same database. For 
example, a municipality may require two (2) web sites, one for the city, the 
other for the county.
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Accessing Govern Web Configuration Tools

Web configuration editors can be found on the GNA ribbon under the 
Application Configuration tab; locate the Web Configuration group (E) > “Any 
of the Web Configuration Tools below”

• Manage Web site - Used to create and manage the Web site.
• Manage Web Skin - This editor creates and previews the “skin” i.e. 

appearance of the Web site.
• Open Web Config Editor - Manage eComponent functionality through the 

Web.config file.

Web Site Manager (Manage Web Site)

After you set up your WebSkins, you can use the Web Site Manager, to assign 
WebSkins to the eProfile and the eComponents associated with the Web site. 
Each application can be assigned a different skin to provide a different look 
and feel or you can assign the same skin to all components. See Web Site 
Manager on page 105 for details.

Web Skin Manager (Manage Web Skin)

The WebSkin Manager can create customized WebSkins to define the look 
and feel of the eProfile and eComponents. This has tools for defining general 
layout, title, and sections of a Web page like the head, left and right margins, 
and the body. These sections are defined as a skin, assigned a name and ID, 
and applied to the eProfile or eComponent with the Web Site Manager. With 
the WebSkin Manager, since all your styles and formatting are centrally 
located, it is easy to preview your site and make modifications. See Creating a 
Web site on page 109 for details.
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Web Config File Editor (Open Web Config Editor)

Web Configuration editor is used to define and manage configuration 
parameters of Govern’s eComponents. See Web Configuration File Editor on 
page 108 for details.
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GIS Configuration

The following parameters are used for the configuration of the Govern GIS 
View application.

GIS Configuration editors are located in GNA under the Application 
Configurations tab; locate the GIS Configuration group in the ribbon (A).

Enter the parameters used to publish the Service Map and the locations of the 
various services used by the GIS View application. 

Arc GIS Server 9.3.1 / 10.0 Installation Notes

The following steps are for installing the Arc GIS Server. This is a prerequisite 
installation for the functioning of the GIS View application. Refer to the Govern 
GIS View release 4.5 guide for the system requirements for the Arc GIS 
Server 9.3.1 / 10.0.

ArcGIS 9.3.1 Installation

After installing the prerequisites listed under System Requirements, you can 
begin installing the ArcGIS Server software on each machine in your system. 
As you navigate through the ArcGIS Server Setup wizard, you will see a panel 

Note: Full GIS integration involves the use of the Property Control GIS Web 
Services. Users should ensure that their Username and Password are 
entered in the USR_USERFILE table.

Note: The queries used in the GIS configuration are created and saved in 
the SQL Queries Editor. Refer to the Govern GIS View release 4.5 
guide for additional details.
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that allows you to choose which components, or features, of ArcGIS Server to 
install. For a single machine deployment, choose to install all the components.

The ArcGIS Server Installation Guide contains detailed information about the 
software installation process. It also contains a list of system requirements and 
prerequisites for ArcGIS Server. You can open the guide by clicking the Install 
Guide button from the first panel of the ArcGIS Server Setup wizard.

For details about the installation process, click the following link: 

http://webhelp.esri.com/arcgisserver/9.3.1/dotNet/

ArcGIS 10.0 Installation

ArcGIS Server 10 for the Microsoft .NET Framework has two setups:

• ArcGIS Server 10 - GIS Services installs the Server Object Manager 
(SOM), Server Object Container (SOC), Services Manager, and Web 
Services (SOAP/REST) components.

• ArcGIS Server 10 - Web Applications installs the Applications Manager 
and Software Developer Kit (SDK) components.

If you intend to only create, publish, and host services (map services, search 
services, etc.) on your GIS server, you will only need to install ArcGIS Server 
10 - GIS Services. If you intend to develop and host Web Mapping 
Applications (WMAs) on your GIS server, you will need to install both ArcGIS 
Server 10 - GIS Services and ArcGIS Server 10 - Web Applications.

For more details on the installation process click the following link: 

http://help.arcgis.com/en/arcgisserver/10.0/help/
arcgis_server_dotnet_help/index.html

Installing eUtilities

Before you create a map service, you need an ArcMap map document (.mxd) 
that resides in a shared location visible to all server object container (SOC) 
machines in your GIS server. The SOC account you created during post 
installation must also have permissions to read the map document and all the 
data that the map document references.

Follow these steps to create your first map service:
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1. Start ArcGIS Server Manager and log in. For additional help with this step, 
see Logging in to Manager.

2. Click the Services tab.

3. Click Publish a GIS Resource.

4. Use the Resource drop-down list to browse to the map document (.mxd) 
that you want to publish.

5. Type a name for the service in the Name text box. The name cannot be 
more than 120 characters long and may contain only alphanumeric 
characters and underscores. 

6. Accept the default folder level by clicking Next. 

7. Click Next again to accept the default capability Mapping. 

8. Review the information about the service you are about to create and click 
Finish to create the service. 

Verification Steps

To ensure that the service is working correctly, follow these steps:

1. Click the Services tab in Manager. 

2. Make sure the Services in the drop-down list contains your server name, 
i.e. the root level of the server, and not a folder name. 

3. Click the plus (+) button to expand the information about the service you 
just published. If you can see a preview image after a few seconds, your 
service is running correctly. 

Click the following link to get more details about the map service:
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http://help.arcgis.com/en/arcgisserver/10.0/help/
arcgis_server_dotnet_help/index.html#/
Tutorial_Publishing_a_map_service/00930000000p000000/

GIS Parameters Editor

GIS Configuration in Govern New Administration (GNA)

After publishing the service map, the following configuration steps are 
performed in Govern New Administration (GNA).

To configure the GIS Parameters in the Govern New Administration (GNA)...

1. Click to select the Application Configurations tab.

2. In the GNA ribbon locate the GIS Configuration group.

3. Select the GIS Parameters icon.
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4. Complete the following parameters. All are required.

Configuration Name: Enter the name of GIS configuration. This is the view 
that the user sees on logging in.

Base MAP URL: Enter the URL of the base map used by your organization. 
The base map provides background for the GIS information and increase the 
speed for zooming in and out on selected parcels or other map areas.

Base maps are purchased by the organization or can be selected from the 
ESRI Web site; for example:

http://server.arcgisonline.com/ArcGIS/rest/services/
ESRI_Imagery_World_2D/MapServer
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Client Map URL: Enter the URL of your Map Service that you published in 
the ArcGIS Server.

The client map is automatically updated when changes are made to the 
database.

To locate this URL:

1. Go to the ArcGIS services directory:

http://yourServerName/arcgis/rest

2. Click on the link that has your Map Service’s Name:

http://yourServerName/arcgis/rest/services/yourMapService/MapServer 

Grid Query Name: Select the query used for the Result Grid.

The database columns displayed in the Result Grid are defined by this query.

Map Tip Query Name: Select the query used for the map tips.

The columns defined in this query are the columns that are displayed in the 
Information palette. This is shown when you select a parcel.
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Label Query Name: Select the query for the labels. These are columns 
displayed in the Label Features palette.

Print Service URL: Enter the name of the service for the Abutter’s report.

Report Path: Enter the path to the Crystal Reports used for the Abutter’s 
report.

Geometry Service URL: Enter the URL for the buffer for the Abutter’s 
selection.

PC Property Service URL: Enter the URL for the service to be used 

Parcel Layer Number: Enter the position of the Parcel Layer on the map 
and under the Query List section of the Layer List in Govern GIS View. This is 
SDE.SDE.Parcel in the following screen shot.

Historic Layer Number: Enter the position of the History Layer on the map 
and under the Query List section of the Layer List in Govern GIS View. This is 
SDE.SDE.Archive in the following screen shot.
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Abutter in Dynamic Search: Select this option to add the Abutter’s List 
option to the Dynamic Search menu. Otherwise, the Abutter’s List appears as 
an icon in the Results Grid.

Department: Multimedia documents include a code for the department. 
Select the department for saving the multimedia documents from the Abutter’s 
List and reports. 

Document Type: Enter the accepted document type for multimedia 
documents if required.

Search Group: Select the query to be used for the Dynamic Search.

Abutter Group: Select the query to be used for the Abutter’s List.
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Link Group: Select the query to be used for the link between the Govern 
database and the geodatabase.

GIS Tooltip Editor

Defining the GIS Tooltip for Identifying Parcels

The next step is to define the GIS Tooltip for viewing information on the 
parcels. This is the information displayed when the user performs a search; 
then, selects a parcel and clicks the Identify icon.

To define the GIS Tool tip;

1. Click to select the Application Configurations tab.

2. In the GNA ribbon locate the GIS Configuration group.
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3. Select the GIS Tool tip icon.

4.  Enter the following parameters:
• Query Name: Enter a name to identify the query.
• Query ID: Select the query you want to use from the drop down list. 

Queries are created and saved in the 
• User: Select All or select the name of the user who can see the 

information. 
• Layer Name: Enter the name of the layer under which the query will 

be visible.

5. Click the Save icon .
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GIS Synchronization Tool

Import and Link Data from Geodatabase to Governs data-
base

After configuring the GIS Parameters and setting up the GIS Tooltip, you need 
to run the GIS Synchronization Tool to synchronize the Govern database with 
the geodatabase. This synchronization is preformed by the GIS Synchroniza-
tion Tool.

To configure the GIS Synchronization Tool:

1. Click to select the Application Configurations tab.

2. In the GNA ribbon locate the GIS Configuration group.

3. Select GIS Synchronization 
Tool icon.

4. Complete the following 
parameters.
• Choose a GIS 

Configuration Name: 
Enter the name of the 
geodatabase.

• Synch Object from 
Layer: Select the name 
of the layer for the 
synchronization.

• GIS ID Field: Enter the 
name of the field in the 
geodatabase that you are using for the link; for example, enter 
OBJECTID.

• GIS From Date / To Date: If the layer includes historical data, enter a 
range of dates.

• Link Field: Enter the name of the field on which the link between the 
two databases: the geodatabase and the Govern database will be 
made; for example, the tax map number.

• Table: Enter the name of the database table in the Govern database 
that contains the field you are using to link the databases.

• Field: Enter the name of the field in the Govern database on which you 
are making the link.
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5. Click Import and Link button to link to import the data 
from the geodatabase into the Govern.

6. Click the Get PIDs not linked button  to generate a report 
showing the parcels that exist in Govern but are not linked to the 
geodatabase.

7. Click the Export Log button  to export the information to an 
Excel document.

Web Site and Web Service

The final step is to deploy the GIS Web site and the Web service that will 
access the data in both databases.

Create an Application Pool

Application Pools isolate sites and applications to address reliability, 
availability, and security issues. Application Pools should be created for any 
one of the following reasons:

• Grouping sites and applications that run with the same configuration 
settings.

• Isolating sites and applications that run with unique configuration settings.
• To increase security by using a custom identity to run an application.
• Preventing resources in one application from accessing resources in 

another application. For example, ISPs might create individual application 
pools for each customer's sites and applications. Separating customer 
content in this manner can prevent one customer's resources from 
accessing resources on another customer's site, even though both 
customers' sites are on the same Web server.

• Improving performance by separating unstable applications from well-
behaved applications.

It is strongly recommended to create an Application Pool for this solution.

Web Service Configuration and Deployment

For the deployment of the Web service you should publish the Web Service in 
IIS, in addition there are two (2) keys in the Web.config file that need to be 
filled:
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1. GovernNetConfig: The path to the Govern.NET configuration file on the 
network.

2. SDE connection key: Fill the alternate connection key for the 
Geodatabase.

Web site Configuration and Deployment

For the deployment of the GIS Terminal you should publish the Web Site into 
the IIS, and also there are 13 keys in the Web.config that should be filled:

1. BusinessRules: The URL to the WCF service configured on the step 
3.4.1.

2. GovernNetConfig: The path to the Govern.NET configuration file in the 
network.

3. DefaultConfig: The default configuration for your web site.

4. Supported: The supported configurations available for the user.
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Accessing the Application

When security is enabled, enter the application URL to display the login page 
with the username and password fields. Enter your access credentials and 
click Login.
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Govern Tax
The Govern Tax group in the GNA ribbon is used to access the forms used to 
configure installed Govern Tax modules. Modules include, Real Property Tax, 
Self Reported Tax, and Accounts Receivable, to name a few. 

Real Property Editors

The editors for configuring the parameters required for the Real Property Tax 
Assessment Module are found under the Real Property icon. Editors include 
the following:

• General Parameters
• Levy Codes
• Exemption Codes
• Levy Groups
• Exemption Groups
• Swis Codes
• Averaging Assessment Values
• Cap Levy Group

For details about Real Property Tax Parameters and Editors, refer to the 
Govern Real Property Tax user guide for details.

Business Tax Editors

When configuring the Business Tax aka Self-Reported Tax module, the 
following forms are used:

• Copy to Year
• General Parameters
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• Categories
• Categories Form Setup
• Periods

For details about parameters and configuration, refer to the Business Tax user 
guide.

Accounts Receivable Editor

The editors for configuring the Accounts Receivable Module are found under 
the Real Property icon. The A/R General Parameters form is used to define 
Accounts Receivable (A/R) settings for all the subsystems linked to the A/R.

For details about setting up A/R Classes and their parameters, refer to the 
Account Receivable Release 6.0 user guide.
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Govern Web Configuration Tools

The Web Configuration tool allows you to modify the look and feel of the 
eProfile and eComponent Web sites.

A feature of the Govern New Administration (GNA) is its ability to manage 
multiple web sites within the same database, i.e. you are able to manage 
multiple sites with their respective files within the same database. For 
example, a municipality may require two (2) web sites, one for the city, and the 
other for the county. 

Accessing Govern Web Configuration Tools

To access the Web Configuration tools in GNA:

1. Click Web Configuration (tab) > “Any of the Web Configuration tools in 
the group”.

Web Site Manager (Manage Web Sites...)

After you set up your WebSkins, you can use the Web Site Manager, to assign 
WebSkins to the eProfile and the eComponents associated with the Web site. 
Each application can be assigned a different skin to provide a different look 
and feel or you can assign the same skin to all components. See Web Site 
Manager for details.

WebSkin Manager (Manage Web Skin...)

The WebSkin Manager can create customized WebSkins to define the look 
and feel of the eProfile and eComponents. This has tools for defining general 
layout, title, and sections of a Web page like the head, left and right margins, 
and the body. These sections are defined as a skin, assigned a name and ID, 
and applied to the eProfile or eComponent with the Web Site Manager. With 
the WebSkin Manager, since all your styles and formatting are centrally 
located, it is easy to preview your site and make modifications. See Creating a 
Web site on page 109 for details.

Web Config File Editor (Open Web Config Editor...)

The Web Config editor is used to define and manage configuration parameters 
of Govern’s eComponents.. See Web Configuration File Editor on page 108 
for details.

Overview



© 2014 MS Govern Page 105

Web Site Manager

Web Site Manager

With the Web Site Manager, you can create a look and feel for each of your 
Web sites by assigning WebSkins to the eProfile and the eComponents. Each 
application can be assigned a different skin to provide a different look and feel.

For details about using the Web Site Manager, refer to the MS Govern - 
eGovern Public Self Service Portal Release 5.1 user guide.

Overview
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Web Skin Manager

A “skin” is a term used to refer to the appearance of the user interface (UI). 
Consequently a “WebSkin” refers to the appearance of the UI in a web 
browser. A WebSkin will present a Web application with a different look and 
feel, but the behavior of the UI will not change.

With the WebSkin Manager, you are able to customize the look and feel of the 
eProfile and eComponents. The WebSkin Manager contains tools for defining 
the parts of the layout, e.g. title, head, header, footer, left and right margins 
and body, of a Web site. These parts are defined as a “skin”, assigned a name 
and ID, and then selected for the eProfile or an eComponent through the Web 
Site Manager.

Typically the Webskin Manager can be used to replicate the pages of your 
Web site that will contain restricted access eProfiles and eComponents. For 
example, the pages that are duplicated can contain eComponents that allow 

Overview
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citizens to access information for outstanding tax balances, make payments 
online, or apply for permits as contractors. 

For details about using the Web Skin Manager, refer to the MS Govern - 
eGovern Public Self Service Portal Release 5.1 user guide.
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Web Configuration File Editor

The Govern New Administration (GNA) Web Config File Editor is designed to 
manage Govern’s eComponents. With the Web Configuration File Editor, you 
are able to define configuration parameters, determine how errors and 
exceptions are managed by the system, and set auto login parameters.

For details about using the Web Configuration File Editor, refer to the MS 
Govern - eGovern Public Self Service Portal Release 5.1 user guide.

Overview
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Web site Configuration

Creating a Web site

For the steps required to create a basic eGovern - Public Self Service Portal, 
refer to the Creating a Web site section of the Harris Govern - eGovern Public 
Self Service Portal Release 5.1 user guide.

Configuring Website Menus

The Web Sites and Web Skins forms are used to create the “shell” that will be 
your Web site; after defining the look and feel, administrators can then 
configure the menus. Menu options can be associated with a Web page, a 
report or with a Search Style. See Accessing Dynamic Search Configuration 
Tools on page 201. The Web Site Menu form is used to create and configure 
your menus. Refer to the MS Govern - eGovern Public Self Service Portal 
Release 5.1 user guide for details     
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Profile Editor

In Govern, a Profile is the equivalent of a department in Govern for Windows. 
Inside a department there would be Functions and Reports. In Govern for 
OpenForms, this same analogy can be applied, Functions are referred to as 
OpenForms. Understanding this analogy, in a Profile, we would have 
OpenForms and Reports. In Govern for Windows, inside a department we can 
have Functions for tasks like Permitting, Complaints, Offences or obtaining 
Property Information.

Within Profiles are OpenForm Zones; these are the tabs that appear under the 
profiles. These tabs can have additional command buttons.

The Profile Editor is the interface used to configure profiles and access for 
OpenForms. Administrators that are familiar with MS Govern’s user access 
interface will notice similar parameters. 

To access the Profile Editor...

1. In GNA, select the Editors tab.

2. Click the Profile Editor icon.

Overview
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The Profile Editor interface is 
divided into three (3) sections, 
Properties (A), Links (B), and 
Queries (C). Each section can be 
accessed by selecting either one 
of the tabs below the Profile tab.
© 2014 MS Govern Page 111



Govern New Administration (GNA)
Profile Editor Command Buttons

New: On the Profile tab, click New  to remove all parameter entries in the 
currently selected profile. When saved, this will add your profile to the list of 
profiles. (Table: USR_PROFILE)

Save: Click Save  to save the current parameters to the List of Profiles or 
to update an existing profile.

Note: When you click on New, the button changes to Cancel  ; this will 
allow you to cancel the creation of the current record. The Cancel 
button is present until the new record is saved.
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Copying a Profile

When creating one or more profiles that are similar in forms, a good strategy is 
to create a “base” profile, then make copies of the profile. The minor 
modifications can then be made to each copy.

Copy: Click Copy  to create a copy of the currently selected record. When 
the record is copied, it is given a random name that is based upon the original 
Profile Code.

Delete: Select a profile from the List of Profiles, click Delete  to remove it 
from the list.

Closing the Editor

To close the editor, click the Close Window button in the upper right hand 
corner of the form.

Profile Editor - Properties tab parameters

The Properties tab is used to configure details of the tab that are displayed in 
Govern.NET. Parameters such as the label displayed on the tab, the 
department that it is linked to, warnings and the fiscal year that the user may 
be restricted to. The Links tab is used to link Models to OpenForms, and 
Reports that are linked to the Profile.

Profile Code: Enter the code that will be used for this profile. This is a 
unique number that cannot be shared with another existing profile.  

English Short Description: Enter the English description that will be used 
for fast data entry and look-ups where space is limited on forms.

English Long Description: Enter the English description that will be 
displayed for look-ups on forms, and normally used for reporting.

Note: There is an Expand/Collapse button located below this field; when 
entering parameters, ensure that you click on this button to display the 
additional fields.
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French Short Description: Enter the French description that will be used 
for fast data entry and look-ups where space is limited on forms.

French Long Description: Enter the French description that will be 
displayed for look-ups on forms, and normally used for reporting.

Privacy / Restrictions for Names group

This group contains the security restrictions that will be placed upon the 
selected group.

Name Group Code: Specify the name group that the selected restrictions 
will be imposed on. For example if members of the group have access to this 
profile, the privacy restrictions would be applied to them.

None: This is the default setting; no restrictions will be imposed on the 
records.

Name Privacy: Select this option to restrict access to name records.

Restricted Name: When selected, this group will not be permitted to access 
restricted names.

Restricted Address: Select this option to restrict access to address 
information

Dataset Type Code: Select the Dataset Type code from the drop down 
menu. This refers to the key that the profile will be using. This value will also 
serve to filter the options that will be displayed in the Default eGroup and 
Default eStyle parameters.

Group Code: This parameter is for future expansion and is currently not 
used.

Note: For example if a Dataset Type Code of Name ID is selected, only the 
eGroups or eStyles that return a Name ID will be displayed in the 
Default eGroup and Default eStyle parameters.
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eStyles and eGroups

Search Styles and Search Groups that are created in the Web Search Styles 
Management and the Web Search Group Management forms can be applied 
to the profiles through the Profile Editor. Either individual styles or groups can 
be configured.

Default eStyle: Select a default syle from the drop-down menu.

Default eGroup: Specify the default group that will be used for this profile. 
This group is a collection of styles

Organization Number: This parameter is for future expansion and is 
currently not used.

Department Code: Choose a department from the drop-down menu that 
this profile will work by, for example a permitting related profile might work with 
the Building Department.

Jurisdiction: When multiple jurisdictions are defined, specify the jurisdiction 
that this profile will have access to.

Current Fiscal Year: This parameter allows you to specify the fiscal year 
that this profile will have access to.

Owner Month: Specify the (as of) month to be used when creating new 
property owners.

Owner Year: Specify the year of profile access.

Name Group Code: Name Sharing Groups are created to extend access 
rights to the name and address records created by a department to one or 
more of the other departments within an organization.

Approved Subdivision: Choose this option to restrict access to only 
approved subdivisions.

Overwrite Calendar: When selected, the user will be able to overwrite a 
calendar.
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Action Queries and Records Affected

Selection queries are used to retrieve records from specified tables, but action 
queries are used to perform some action, such as updating records in one or 
more tables, adding records to a table, deleting records from a table or 
creating a new table or index. At times these actions may affect a large 
number of records, more than the user may realize. Action queries can be 
controlled with an escape in the form of a rollback. The parameters that can be 
configured are as follows:

Number of Records Before Warning: When an action query is initiated, 
the system will first perform a record count to determine the number of records 
that will be affected by the query. Enter the number of records that are affected 
before a warning is displayed to the user.

Minimum Number Before Rollback: If an action query is used, enter the 
number of records that are to be affected before a rollback occurs. Once this 
number is exceeded, the rollback will occur automatically. An example is when 
you add, update or delete records in the database, performing any of these 
actions, within the department, will result in a warning screen appearing.

Profile Editor - Links tab parameters

Linked Models group

Appearing in this list are the Business Models that the user can be given 
access to.

Command Buttons

Up / Down: When two (2) or more options are present in the list, click to 
highlight the selection; click Up to move the selection up in the list.

Add: Click Add to display a list of available models that are available for 
selection; click to select.

Note: Multiple or extended selections using the Ctrl or Shift keys are not 
allowed in this list.

Note: You are able to make multiple or extended selections using the Ctrl or 
Shift keys in this list.
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Delete: Select a model from the list, click Delete to remove the model; a 
confirmation window will appear, click Yes to confirm deletion, or Cancel to 
abort.

Linked Reports group

Appearing in this list are reports that are linked to the Business Model.

Command Buttons

Add Standard Report: Click Add Standard Report, to link to a standard 
report from the list.

Add Custom Report: Click Add Custom Report to display a list of Custom 
Reports that are available for selection; click to select.

Delete: Select a report from the list, click Delete to remove the model; a 
confirmation window will appear, click Yes to confirm deletion, or Cancel to 
abort.

MS Govern Order of Precedence

When linking a report, it is necessary to understand that an order of 
precedence exists for both the filename, and the path that the report is located 
under.

Report Names

When a report is viewed in a directory on the system, the name is preceded by 
a series of leading characters and an underscore character “_”, or in the case 
of a Standard Report, no leading characters.

Note: Multiple or extended selections using the Ctrl or Shift keys are not 
allowed in this list.

Note: You are able to make multiple or extended selections using the Ctrl or 
Shift keys in this list.
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For example, a report based on a standard report called Audit.rpt, that is a 
custom user report, would be viewed as SHN_Audit.rpt, where SHN in this 
example is the three letter user (USR) name.

A report can be classified for 
use under one of the 
following four (4) categories 
with the format of the 
leading characters in 
brackets:

• User (USR_)
• County (COUNTY_)
• State (ST_)
• Standard Report (No 

leading characters)

Report Paths

As in the MS Govern 
application, the entries in 
the User Retry have a 
higher precedence to those 
in the System Retry. For 
example, if a path to a report 
is specified in the User 
Retry Maintenance form, it 
will have precedence over any entries specified under a different path in the 
System Retry Maintenance form. Following the same order of precedence, 
reports that are located under a custom path will have a higher priority than 
those under the standard path. 

Note: When browsing for a report, any preceding characters are filtered out, 
leaving only the report name. For example the above user report 
named SHN_Audit.rpt, will display in the list as Audit.rpt

Note: Leading character names are designated by MS Govern and are 
provided upon initial installation and configuration.
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Editing / Customizing Reports

In the event that custom reports are required, take note of the type of report 
that is being edited. When a custom report is required ensure that the report 
name has the correct preceding characters, otherwise the wrong report may 
be edited.

Linked A/R Subdivision group

Appearing in this list are the Accounts Receivable (A/R) subdivisions that are 
linked to the Business Model.

Command Buttons

Add: Click Add to display a list of Accounts Receivable (A/R) subdivisions 
that are available for selection; click to select from the list.

Delete: Select a report from the list, click Delete to remove the model; a 
confirmation window will appear, click Yes to confirm deletion, or Cancel to 
abort.

Govern Visual Query

The Govern Visual Query is a visualization of query results. This visual 
representation can be in the form of Pie Charts, Graphs of Data, or Data grids. 
When a dataset is retrieved, the impact upon the end user is increased 
significantly when the data is presented in a format that is easy for the viewer 
to visualize. The visual query is presented as icons that are displayed on the 
Govern Release 6.0 ribbon. When the user clicks the icon that is used to 
represent the Visual Query, the query result is displayed. Optionally after the 

Note: Multiple or extended selections using the Ctrl or Shift keys are not 
allowed in this list.

Note: You are able to make multiple or extended selections using the Ctrl or 
Shift keys in this list.
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data is displayed, the resulting chart may also be configured to display a 
report when the user clicks on the image of the chart. 

Display of Data Query Controls

Query data, when compatible, can be presented in any of the following 
supported controls:

Control Name Ribbon Image Description

Label Displays a user-defined text label in 
the Govern ribbon. 

Large Label‘ Unlike the text label, a large text label 
icon is displayed in the Govern ribbon. 
Descriptive text appears below the 
larger text label. 

Picture This is a picture icon that will display a 
thumbnail representation of the 
selected image.

Pie Chart Based upon the statements that are in 
the query, a pie chart is displayed to 
represent the data results.

Column Chart Based upon the statements that are in 
the query, a column chart is displayed 
to represent the data results.

Line Chart Based upon the statements that are in 
the query, a line chart is displayed to 
represent the data results.
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• Label
• Large Label
• Picture
• Pie chart
• Column Chart
• Line Chart

Configuring the Visual Query

Prior to configuring the control in the OpenForms Designer, it will be 
necessary to design queries to retrieve the data that will then be presented. In 
addition users must approach this process with the understanding that units 
that are being retrieved must also be formatted for use in the control.

Queries Tab
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The parameters under the Queries tab are used to configure the profiles with 
queries.

Profile Editor - Queries tab command buttons

Add a New Query: Click this button to add a new Query to the current 
profile.

Remove Selected Query: To remove the currently selected query from the 
profile, click Remove Selected Query.

Profile Editor - Queries tab parameters

Control Type: Select one of the control types for your query from the drop 
down menu.

Query: This list will display the English Long Name of the available queries. 

When the Open icon is clicked , the SQL Query editor is launched to create 
a new query; when a query is already configured in the parameter, it will be 
displayed. Refer to SQL Query Editor on page 229 for information about 
creating queries with the Govern SQL Query Editor.

Tool Tip: Enter the text for a Tool Tip that is displayed when the user pointer 
is hovered over the ribbon icon. This parameter has 3 possible states that can 
be selected.

• Fix - Select this option to display the current text string as a fixed text 
description, i.e. tool tip. 

• Query - When selected, the parameter will change to a drop down list of 
queries. The result of the queries can then be used to determine whether 
the tool tip is displayed.

• Logical Expression - Select this option to display a list of logical 
Expressions that can be used to determine whether the tool tip is 
displayed.

Visibility: This is a flag that is set to indicate that the icon will be displayed in 
the Govern Ribbon.

Note: You are able to make multiple or extended selections using the Ctrl or 
Shift keys in this list.
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• Fix - Select this option to display the icon as a fixed image. 
• Query - When selected, the parameter will change to a drop down list of 

queries. The result of the queries can then be used to determine whether 
the icon is displayed. Refer to SQL Query Editor on page 229 for 
information about creating queries with the Govern SQL Query Editor.

• Logical Expression - Select this option to display a list of logical 
Expressions; the visibility of the controls icon will be based upon the result 
of the expression. Refer to Logical Expression Editor on page 171 for 
information about creating Logical Expressions with the Govern Logical 
Expression Editor.

On Click group

The options in the On Click group when selected will determine what action 
occurs when the selected query item is clicked in the ribbon. The options are 
as follows:

None: Selecting None is an indication that no action will be performed when 
the user clicks on the Visual Query; this is the default.

Open Form: When selected, you will have the option to indicate which is to 
be opened when the user clicks on the query.

Open Report: Click to select the option to choose a report that will be 
displayed.

Open View Query: Select the Open View Query option to open a selected 
View Query. 

Execute Command: To execute a command, click this option; available 
commands can be selected from the list.

Open GIS: When selected, this option will open a window with an embedded 
GIS output screen.

Open Query Tool: Selecting this option will open the Govern Query Tool 
(QT).
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Open Batch Process: To configure the query to load a batch process, 
select this option.

Configuring a Visual Query Link

A Govern installation will contain a variety of Visual Queries; these “base 
queries” should never be modified. When a customized query is required, 
users can do one of the following after making copies of Govern base queries:

• Users can study the query for an understanding of how they work and then 
create their own.

• Users can directly modify the copied query to obtain their desired results.

Depending on the type of Visual Query required, the configuration steps are 
be simple. The visual query type that can be used to display the results is 
dependent on the “Statement Keywords” that are used in the query. The 

Note: Multiple or extended selections using the Ctrl or Shift keys are not 
allowed in this list.

Note: In Governs list of base SQL queries, Visual Queries are identified with 
a dh preceding the name. as in...dhQryNm - QueryName  These 
queries are seen under the SQL Definition List: in the SQL Query 
Editor.
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following is a list of the type of visual query and the required SQL statement 
keyword.

When the above statement keywords are present in the query, then Visual 
Query Type will be valid. If the statement keywords are not present and an 
incompatible Visual Query Type is selected, the icon will not appear in the 
Govern ribbon.

Example Visual Queries

The following SQL statements should serve as example of Visual Query types 
in Govern. Queries are designed in the SQL Query Editor in the Govern New 
Administration (GNA); see SQL Query Editor on page 229 SQL Query 
Editor on page 229 for details about creating and editing SQL queries.

Example 1 - Grid

The following is an example of a Visual Query that will produce a Query Grid.

----START----

--- smPC11
--- Property Assessment (Current + Last 4 Year)
--- Query Grid
SELECT 
MA_MASTER.YEAR_ID 'Fiscal Year',
('$' || CAST(ISNULL(MA_MASTER.LAND_VALUE,0) AS VARCHAR)) 'Land Value',
('$' || CAST(ISNULL(MA_MASTER.LAND_AG_VALUE,0) AS VARCHAR)) 'Land Agricultural 
Value',
('$' || CAST(ISNULL(MA_MASTER.BLDG_VALUE,0) AS VARCHAR)) 'Building Value',
('$' || CAST(ISNULL(MA_MASTER.MISC_VALUE,0) AS VARCHAR)) 'Miscellaneous Value',
('$' || CAST(ISNULL(MA_MASTER.CAMA_VALUE,0) AS VARCHAR)) 'Cost Value',
('$' || CAST(ISNULL(MA_MASTER.INCOME_GRM_VALUE,0) AS VARCHAR)) 'Income GRM Value',
('$' || CAST(ISNULL(MA_MASTER.INCOME_DIR_VALUE,0) AS VARCHAR)) 'Income DIR Value',
('$' || CAST(ISNULL(MA_MASTER.COMP_SALES_VALUE,0) AS VARCHAR)) 'Comp. Sales Value',
('$' || CAST(ISNULL(MA_MASTER.MRA_VALUE,0) AS VARCHAR)) 'Market Value',

Visual Query Type  SQL Statement Keywords Required

Grid No specific statement keyword required.

Line Chart CHART_TITLE, SERIE_TITLE, CODE, VALUE

Column Chart CHART_TITLE, SERIE_TITLE, CODE, VALUE

Pie Chart CHART_TITLE, CODE, VALUE
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('$' || CAST(ISNULL(MA_MASTER.APPRAISED_VALUE,0) AS VARCHAR)) 'Appraised Value' 
FROM MA_MASTER 
WHERE MA_MASTER.FROZEN_ID=0 
AND MA_MASTER.YEAR_ID>=Year ID-4 
AND MA_MASTER.P_ID=Parcel ID 
ORDER BY MA_MASTER.YEAR_ID DESC

----STOP----

For a Grid type query, when data is retrieved from a column, that will not 
have a column heading. The query will need to specify the column headings 
with an alias as illustrated above after the SELECT statement. 

Example 2 - Column Chart or Line Chart

The following is an example of a Visual Query that will produce a Column 
Chart or Line Chart.

----START----

--- dhMA01
--- Appraised Value by Year
--- Column Chart or Line
SELECT ('Appraised Value by Year (in $ 100K )') CHART_TITLE,
('Appraised Value') SERIE_TITLE,
MA_MASTER.YEAR_ID CODE,
CAST((SUM(CAST(ISNULL(MA_MASTER.APPRAISED_VALUE,0)AS NUMERIC (20,2))/100000)) AS 
NUMERIC(20,2)) VALUE 
FROM MA_MASTER 
WHERE MA_MASTER.YEAR_ID>=(Year Id-4) 
AND MA_MASTER.FROZEN_ID=0 
GROUP BY MA_MASTER.YEAR_ID 
ORDER BY MA_MASTER.YEAR_ID DESC

----STOP----

For the Column Chart or Line Chart type, as indicated in the grid above, a 
CHART_TITLE, a SERIE_TITLE, CODE, and VALUE statement keywords need to be 

Note: The above query will only work for a Grid type query.

Note: The above query will only work for a Column Chart or Line Chart type 
query.
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present. In addition the numeric data results should also as a rule be formatted as 
well. This is seen in the AS NUMERIC statements.

Example 3 - Pie Chart

The following is an example of a Visual Query that will produce a Pie Chart.

--- dhMA02
--- Appraised Value By Property Type for the Current Year
--- Pie Chart
SELECT ('Appraised Value By Property Type for the Current Year (in $ 100K )') 
CHART_TITLE,
ISNULL((SELECT VT_USER.SHORT_DESC_EN FROM VT_USER WHERE 
VT_USER.TABLE_NAME='PROPTYPE' AND 
VT_USER.CODE=ISNULL(PC_LEGAL_INFO.PROPERTY_TYPE,'N/A')),'N/A') CODE,
CAST((SUM(CAST(ISNULL(MA_MASTER.APPRAISED_VALUE,0)AS NUMERIC (20,2))/100000)) AS 
NUMERIC(20,2)) VALUE
FROM MA_MASTER 
INNER JOIN PC_LEGAL_INFO 
ON MA_MASTER.P_ID=PC_LEGAL_INFO.P_ID 
AND MA_MASTER.YEAR_ID=PC_LEGAL_INFO.YEAR_ID 
AND MA_MASTER.FROZEN_ID=PC_LEGAL_INFO.FROZEN_ID 
WHERE MA_MASTER.FROZEN_ID=0
AND PC_LEGAL_INFO.YEAR_ID=Year Id 
GROUP BY PC_LEGAL_INFO.PROPERTY_TYPE ORDER BY PC_LEGAL_INFO.PROPERTY_TYPE

----STOP----

For the Pie Chart type, as indicated in the grid above, a CHART_TITLE, a 
CODE, and a VALUE statement keywords need to be present. Again, as with the 
Column Chart and Line Chart types, numeric data results should also be formatted as 
well. This is seen in the AS NUMERIC statements.

Steps to Configure the Visual Query

In order to illustrate the configuration of a visual query, we will first use an 
existing query.

Note: The above query will only work for a Column Chart or Line Chart type 
query.
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Step 1 - Design and Review the Query 

Due to the fact that we will be using an existing Govern base query, no SQL 
design is required. It is nonetheless recommended that the SQL statements of 
the base query be reviewed. A review process can provide assurance that the 
required statement keywords are present for the desired Visual Query. Refer 
to the SQL Query Editor section, Creating Queries on page 232 for details 
about creating queries.

For the example, the query will display a visual representation of the 
assessment for the past 5 years from the current fiscal year; a Line Chart 
visual query will be used.

To review the query...

1. In the Govern New Administration (GNA), select the Editors tab.

2. On the Ribbon select the SQL Query Editor.

3. Under the SQL Definition List pane on the Left Hand Side (LHS), locate 
the Assessment over the last 5 years query; as a visual query, its name 
will be preceded with a “dh”. The name used here is as follows, 

dhPC1 - Assessment over the last 5 years; this title will appear as 
Assessment over the last 5 years when the visual query is being configured.

SELECT ('Appraised Value over last 5 years')CHART_TITLE,'Current Parcel' 
SERIE_TITLE,MA_MASTER.YEAR_ID CODE,SUM(ISNULL(MA_MASTER.APPRAISED_VALUE,0)) VALUE

FROM MA_MASTER

WHERE MA_MASTER.YEAR_ID>=(Year Id-4) AND MA_MASTER.FROZEN_ID=0 AND 
MA_MASTER.P_ID=Parcel ID

GROUP BY MA_MASTER.YEAR_ID

ORDER BY MA_MASTER.YEAR_ID DESC
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Step 2 - Configure in the Profile Editor 

In the To review the query...

1. In the Govern New Administration (GNA), select the Editors tab.

2. On the Ribbon select the Profile Editor.

3. When the Profile Editor is open, select the Profile that will contain the 
Visual Query. 
For this example select Property Control from the List of Profiles pane on 
the LHS.

Note: As required the CHART_TITLE , SERIE_TITLE, CODE, and VALUE 
key words are required.
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Step 3 - Add the Visual Query to the Profile

As indicated earlier, Visual Queries are configured under the Queries tab of 
the Profile Editor.

To configure the Visual Query...

1. On the Queries tab, click Add a new query (A); a blank label will appear in 
the horizontal area directly below the Queries tab (B). 

The type of Visual Query control that we want to use is a Line Chart...

2. For Control Type, click to select Line Chart from the drop down menu.

Note: This horizontal area can be used as a representation of the Govern 
Ribbon when the profile is open and a search has been performed.
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3. For the Query parameter, select the Visual Query that was designed. For 
this example, a Govern base query is being used; select the English Long 
Description Name that appears in the drop down menu list.

Queries are designed in the SQL Query Editor in the Govern New 
Administration (GNA); see SQL Query Editor on page 229 SQL Query 
Editor on page 229 for details about creating and editing SQL queries.

4. In the optional Tool Tip field enter a description that will be displayed 
when the users pointer hovers over the control displayed in the Govern 
Ribbon; by default the Fix option is selected. Refer to Tool Tip on page 122 
for details on this option.

5. The Visibility option is by default set to True, an indication that the 
control’s icon will be visible; by default the Fix option is selected. Refer to 
Visibility on page 122 for details on this option.

6. In the On Click group, the option of None is selected by default. If a Form, 
Query, or Report is required to be opened when the Visual Query result 
screen is opened, then it will be necessary to select one of the options. 
Refer to the On Click group on page 123 for option details.

Note: If a query needs to be modified or created, click the Open icon  to 
launch the SQL Query Editor. By default if there is a currently 
selected query, it will be opened.
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After the changes have been made, note the red dot on the Profile tab, an 
indication that a modification has been made to the profile.

7. Click Save on the Profile tab, after a brief pause the changes will be saved 
to the profile.

Step 4 - Review the Profile in Govern

Once the profile has been modified with the addition of the Visual Query 
controls, the final step is verifying that the changes are visible and functional in 
Govern.

To view a configured Visual Query in Govern...

1. Open the Govern Release 6.0 application.

2. Under the File menu open the Profile that the Visual Query was configured 
with.
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3. Select the home tab. 

4. Use the Predefined Search to perform a search. 

5. Load the results into the Dataset Treeview.

When the search results have been loaded into the Dataset Treeview, the 
Visual Query controls will be displayed in the Ribbon.

Note: A ribbon with the Visual Query icons that have been configured will not 
be displayed until a Search has been performed.
© 2014 MS Govern Page 133



Govern New Administration (GNA)
Behavior of the Visual Query Control in the Ribbon

When the user pointer is hovered over the control, a thumbnail preview of the 
data result is displayed with the Tool Tip.

A click on the Control’s icon will display the data results in a tabbed window. 
The display window has two (2) tabs...

Chart: The Chart tab is the default display view. It contains the Visual Query 
Result. The Chart tab also contains a Print icon.

• Click Print  to print the chart.

Results: A click on the Results tab displays the tabulated date results that 
are used to generate the Chart representation. The Results tab contains a 
Print icon and a Export to Excel icon.

• Click Print  to print the table.
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• Click Export to Excel  to export the table data as an Microsoft Excel 
spreadsheet.

Creating a New Profile

For this example we will configure a Profile in Govern that will be used for 
providing municipal services to the community, i.e. a department that will 
create general permits and licenses. The steps are as follows:

1. Create and configure the Profile.

2. Specify and link the Business Models that will be in the profile.

3. Link to the reports that will be used by the profile.

4. Specify A/R links to any Business Models with an A/R component.

5. Apply securities with the Govern Security Manager (GSM).

6. Verify the Profile in MS Govern.NET.

STEP 1: Create the Profile

In the Govern New Administration (GNA), you will need to click the Profile 
editor.

To open the Profile editor...

Note: In order to be able to use the Microsoft Excel export option, Microsoft 
Office containing Excel or Microsoft Excel standalone must be 
installed on the system that Govern is installed on.
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1. Select Setup > OpenForms Configuration > Profile Editor... (A) 

2. In the Profile Editor, we are able to see, which profiles already exists under 
the List of Profiles (A).

3. Click New (1) to clear all parameters and start a new profile.

4. Under the Properties tab, enter a Profile Code; this must be a unique 
number, i.e. not used by any other profile. For our example, we will use 23.

5. Click the Parameter Details (2) button to display the additional fields.

6. Enter short and long descriptions in the English Short Description and 
English Long Description parameters. The English Short Description 
text is the one that will appear on the Profiles tab in Govern.NET, while the 

Note: By default the fields on a form are “collapsed”, i.e. they are not fully 
visible. This is to give the form a cleaner appearance. Additional fields 
can be displayed with a click on the Collapse/Expand button.
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other appears under the List of Profiles list in the Profile Editor. Enter 
Citizen Services, and Citizen Municipal Services, respectively.

7. Select a Dataset Type Code from the drop-down list.

8. Specify a Default eGroup (A) or a Default eStyle (B) from the drop-down 
menu. This can be a single style or a group that is a collection of styles. 
This default will be associated with the current profile.

Note: Although you may not be using the French Short Description and 
French Long Description parameters, it is necessary to complete 
them in order to save a profile.

Note: The dataset key chosen here will determine the options that will be 
available for selection under the default eGroup and Default eStyle 
parameters.

Note: The Default eGroup and Default eStyle parameters are mutually 
exclusive in that you can select one or the other, but never both. To 
switch between one or the other, ensure that the “blank” selection is 
selected on the default that is not required.
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9. Choose a Department Code that the profile will work by.

10. If jurisdictions have been specified, select one from the Jurisdiction 
menu.

11. Specify the Current Fiscal Year from the drop-down menu that the profile 
will set to. In the parameter that is immediately to the right, you can also 
specify a month in the fiscal year.

12. Select the “as of” month from the Owner Month drop-down menu, that will 
be used when creating new property owners.

13. Specify the year that newly created property owner accounts will be set to 
from the Owner Year menu.

14. Specify the Number of Records Before Warning, and the Minimum 
Number Before Rollback. See Action Queries and Records Affected on 
page 116 for details.

15. Select Approved Subdivision to limit access to only approved 
subdivisions; choose the Overwrite Calendar option to allow the user to 
be able to make entries that can overwrite calendars like those of an 
inspector or assessor.
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STEP 2: Link the Business Models

The next step is to link business models to your profile. This is the equivalent 
of including the functions that the department will have access to. For our 
example, our Citizen Municipal Services profile will have access to the 
General Permits, Light Permits, Permit to Name, and License to Individuals, 
business models. To apply links, we need to select the Links tab.

To link to Business Models (BM’s)...

1. Click to select the Links tab.

2. In the Linked Models group, click Add (A) to display a list of available 
Business Models (B). For our example we will select General Permits, 
Light Permit, License to Individuals, and Permit To Name.

3. Click OK (C).

Note: Multiple selections can be made by using Ctrl + Click.
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4. In the Profile Editor, click Save to save the change to the profile.

STEP 3: Link the Reports

It will be necessary for the new department to have access to reports that will 
allow them to function. This can be done under the Linked Reports group.

To link to Reports...

1. Under the Linked Reports group, click Add Report (A). Under the list, for 
our example we will be adding 

2. Under the list of available reports (B), click to select required reports. Ctrl 
+ Click will allow you to make multiple selections.

3. Select the Audit Trail Inquiry, Permits Application Listing, Expired Permits 
Listing, and the Permits Listing.

4. Click OK (C).

Note: When linking reports, there may be a noticeable delay in the 
application. At times this non-responsiveness can be mistaken for a 
program error. In fact this extended period of inactivity is due to 
internal processing, and will vary from system to system.
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5. When the list closes, click Save to save the change to the profile.

STEP 4: Apply Required Securities

As stated, prior to viewing your profile, you will need to set securities through 
the Govern Security Manager (GSM)  (A), (1) , to enable access. Refer to the 
Govern Security Manager guide for Instructions on how to secure a profile.

Previewing a Profile in MS Govern.NET

Once the securities have been set, the new profile can now be viewed in MS 
Govern.NET (A),  (1).
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In the application we can see our new Profile for our department. The 
Business Models that were included appear in the default location of the 
Forms Explorer on the left hand side. Associated Reports are seen in the 
Reports Explorer .

Note: If a properly configured profile does not appear in the MS Govern.NET, 
refer to the securities of the profile and verify that access has been 
granted. See the Govern Security Manager guide for instructions on 
securing a Profile.
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Editors 

The Setups / Editors menu contains the forms and editors required to create 
and edit components that are used within the application. These components 
can be OpenForm Profiles, Constant Values, Formulas, Logical Expressions, 
SQL Queries, and Validation Tables to name a few. 

Standard Editors

The majority of editors within the Govern New Administration (GNA) are 
referred to as “standard” because of the common features in their interfaces. 
GNA Standard editors can be found by selecting Setups / Editors > Editors > 
“Name of the Editor”

• Profile Editor... - Used for configuring user access for OpenForms.
• Constant Value Editor... - Used to define and maintain constant values.
• Formula Editor... - For creating customized formulas.
• Field Mask Editor... - Define Field Masks that can be applied to fields in 

functions.
• Logical Expression Editor... - Create customized logical expressions 

used in calculations and linked to fields.
• Resource File Editor... - All text that is displayed in forms, i.e. labels, 

errors, and exception text within GNA, are kept in a “resource file”. This file 
can be edited with the Resource File Editor.

• SQL Queries Editor... - For creating, validating, and maintaining SQL 
queries.

• System Validation Table Editor... - Used to create or edit system 
validation tables.

• User Validation Table Editor... - Create and edit custom user validation 
tables.

• Data Mapping Editor... - Used to map tables and columns in the Govern 
database to Data Element Names.

Overview
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Dynamic Search Configuration Editors

Search Configuration editors are used to configure the Web search and 
Dynamic Search components of OpenForms. These editors can be found 
under Dynamic Search Configuration (tab) > “Name of the Editor”

• Dynamic Search Objects - This editor is used to configure the objects 
that appear within the groups.

• Dynamic Search Styles - Select to configure the search types.
• Dynamic Search Groups - Used to manage the Web search groups.

Batch Process Definition Editor

The Batch Process Definition Editor is used to define how batch processes 
appear and run in Govern. This editor is located under Setups / Editors > 
“Batch Process Definition Editor” (E)

Automatic Synchronization for Batch Processes

Whenever you create, modify, or delete a batch process definition, all 
applications in the Govern Product Suite are automatically synchronized. 
Previously, you had to open the Govern Security Manager (GSM) and run the 
Synchronization process in order to update the batch process menus.

The new processes appear automatically in the Govern Ribbon. Deleted 
process are automatically deleted. If you change the menu under which a 
batch process appears in the Govern Ribbon, this is immediately updated. 
The process is updated or removed from the listing in the GSM 

For details refer to the Govern Scheduler user guide.

Saving Attachments to a Specific Path or FTP Site

A network or local path for reports and other files that are generated by the 
selected batch process, can be defined. An FTP address for these 
attachments can also be defined.

Note: Before you see the changes, you need to refresh the GSM if it is 
already open or close and reopen Govern.
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This is an optional procedure and is not applicable to all batch processes. It is 
useful when an attachment, such as a comma separated value (.csv) or text 
file, is generated at the end of a batch process. The file extension can be any 
format supported by OS and ftp site. csv and txt are typical.

For additional details refer to the Govern Scheduler user guide.
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Constant Value Editor

The GNA Constant Value Editor is used to define and maintain values that are 
constant within the Govern system. Constants can be used in formulas and 
logical expressions for values that change on a yearly basis. Constants are 
saved by year, as a result you only need to edit the constant definition in order 
to update your formulas and logical expressions.

To access the Constant Value Editor, in the Govern New Administration 
(GNA):

1. Select Editors (tab) > Constant Value Editor...

Constant Value Editor Command Buttons

Copy to Next Year: Click Copy to Next Year when you need to copy the 
constant value, code and value, and initialize a new year.

New: Click New  to clear the form so that you can enter new data.

Save: To save a new record or any modifications to an existing one, click 

Save .

Delete: Click Delete  to remove the current record from the database.

Overview

Note: By default the fields on a form are “collapsed”, i.e. they are not fully 
visible. This is to give the form a cleaner appearance. Additional fields 
can be displayed with a click on the Collapse/Expand button (A).

Note: When you click on New the button changes to Cancel  ; this will 
allow you to cancel the creation of the current record. The Cancel 
button is present until the new record is saved.
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Constant Value Editor Parameters

Filter group

In the Filter group (A), select the fiscal year that you would like to use as a 
filter for displaying available constants.

Year: Constant tables are created by fiscal year; by default this parameter 
displays the current fiscal year.

Constant Value Editor - Constant tab

Name: Enter the name for this constant.

Short Description: Enter a short description. This is used for fast data entry 
and look-ups if space is limited on forms.

Note: Only alphanumeric entries are permitted in code parameters. This 
means that names for codes can only be made up of letters and or 
numbers. Special characters such as the underscore “_”, the dash “-”, 
the ampersand “&” , etc. are not recognized.
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Long Description: Enter a long description. This is displayed during look-
ups and on forms and reports.

When there is a 2nd language, or multiple languages, ensure that these 
description fields are also completed.

Is System: This flag / option is reserved for constants that are designated as 
Govern.NET system constants. (SYSTEM_FLAG in USR_CONSTANT table)

About System Reserved Values

Only users with Super-User access will be able to select and deselect the Is 
System option. In addition Super Users can also create new values and flag 
them for Govern.NET system use. 

Value: Enter a value for the constant. for example a Sales tax of 15% would 
be entered as 0.15.

To create a constant value for a specific fiscal year...

When no Fiscal Year has been defined...

1. For this example we will create a Sales Tax for the fiscal year 2015. Enter 
2015 in the Year: parameter.

2. Click the Expand button  to display the hidden parameters that need to 
be completed.

Note: When the Verify Database Objects Existence utility is run on the 
database, a new column called SYSTEM_FLAG of type smallint is 
added to the USR_CONSTANT table. When selected 
SYSTEM_FLAG=True. This option can only be modified by users with 
Superuser administrative rights.

Note: System constants are reserved for use by the Govern.NET system and 
as such should not be modified or deleted without a full understanding 
of the implications. Deletions of system values can damage the 
Govern.NET system, rendering it inoperable. Modifications that are 
made to System values should always be noted. When a system wide 
update is performed, these modifications may be overwritten. 
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3. Enter a Name for the constant value; use saleTax2015.

4. Next enter a Long Name for the constant; Sales Tax 2015

5. Click inside the English Short Description field; the Long Name will be 
automatically copied into both the English Short Description and English 
Long Description field. Select and change the text if modifications are 
required.

6. Enter names into the Short Description and Long Description fields of the 
second language parameters.

7. Any incomplete fields will result in the display of an error screen.

8. Click OK and complete any required fields. 

9. Save the newly created constant with a click on Save. 

When a Fiscal Year has been defined...

1. When there is a fiscal year already defined, click New; all parameters will 
be voided. 

2. Enter a name in the Name field; complete all Short and Long Description 
fields. 

3. Enter the value for the rate in the Value parameter; click Save.

Once created, the constant value will appear on the left hand side under the 
Constant List  (B) When saved this constant will be accessible for use in 
formulas and logical expressions. See Formula Editor on page 150 and  
Logical Expression Editor on page 171 for details.

Note: When naming the constant in the name parameter, avoid the use of 
underscore characters “_” and spaces.

Note: If you are dealing with multiple years, ensure that the correct year has 
been selected in the filter group.
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Formula Editor

The Formula Editor (A) creates customized formulas that can be used in, 
Mass Appraisal, or Permit fee calculations. These calculations can be added 
to a logical expression created through the Logical Expression Block Editor, 
and added to a customized database field or linked to any field. See Logical 
Expression Editor on page 171 for details.

To access the Formula Editor, in the Govern New Administration (GNA):

1. Select Editors (tab) > Formula Editor...

Overview

Note: By default the fields on a form are “collapsed”, i.e. they are not fully 
visible. This is to give the form a cleaner appearance. Additional fields 
can be displayed with a click on the Collapse/Expand button (B).
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Formula Editor Command Buttons

New: Click New  to clear the form so that you can enter new data. 

Save: To save a new record or any modifications to an existing one, click 

Save .

Delete: Click Delete  to remove the current record from the database.

Closing the Editor

To close the editor, click the close window button in the upper right hand 
corner of the form.

Formula Editor - Formula Tab Parameters

Name of Formula: Enter a name for the new formula.

English Short Description: Enter a short description for the formula.

English Long Description: Enter a long description for the formula.

Second Language Fields

When there is a 2nd language, or multiple languages, ensure that these 
description fields are also completed.

Is System: This flag / option is reserved for constants that are designated as 
Govern.NET  system records.

Note: When you click on New the button changes to Cancel  ; this will 
allow you to cancel the creation of the current record. The Cancel 
button is present until the new record is saved.

Note: Only alphanumeric entries are permitted incode parameters. This 
means that names for codes can only be made up of letters and or 
numbers. Special characters such as the underscore “_”, the dash “-”, 
the ampersand “&” , etc. are not recognized.
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About System Reserved Values

Only users with Super-User access will be able to select and deselect the Is 
System option. In addition Super Users can also create new values and flag 
them for Govern.NET system use. 

Algebraic Formula: The Algebraic formula is created as the information is 
entered. This formula can also be modified in this space.

Add Function group

The following functions can be used to create formulas:

 Add Operator group

The following digits and operators can be used when creating formulas.To add 
any of the functions or operators, ensure that your cursor is placed in the 
Algebraic Formula parameter.

Note: System constants are reserved for use by the Govern.NET system and 
as such should not be modified or deleted without a full understanding 
of the implications. Deletions of system values can damage the 
Govern.NET system, rendering it inoperable. Modifications that are 
made to System values should always be noted. When a system wide 
update is performed, these modifications may be overwritten. 

Absolute Value Function Arc Tangent Function Cosine Function

Exponential of e 
Function (e= 2.718282)

Integer part of a number 
(not rounded)

Integer part of a number 
(rounded)

Natural Logarithm 
Function

Base 10 Logarithm 
Function

Sign Function (results to 
1 or –1)

Sinus Function Square Root Function Tangent Function

Rounded to 0 decimal 
places

Rounded to 2 decimal 
places

Rounded to 6 decimal 
places

Back Space Clears Last Entry
Clears the Algebraic 
Formula Text box
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Create a Custom Formula with the Formula 
Editor

In the following example we will create a formula that will be used to convert 
Square Footage into Acres. After some research, we find that the formula for 
this conversion is as follows:

Acres = (Area) / 43560

Where... Area = Length x Width (i.e. Size of the lot)

For this conversion we will need to include a SQL query that will retrieve the 
Lot Size for our calculation. A query called LOTSIZE was created in a SQL 
Definition Setup example. See Create a Simple SQL Query on page 232 in 
the SQL Definition Setup section of this guide for instructions.

Inserts the Digit 7 Inserts the Digit 8 Inserts the Digit 9

Inserts the Digit 4 Inserts the Digit 5 Inserts the Digit 6

Inserts the Digit 1 Inserts the Digit 2 Inserts the Digit 3

Inserts a zero Inserts a decimal point

Integer Division 
Operator Division Operator Multiplication Operator

Subtraction Operator Addition Operator Exponential Operator

Insert an Opening 
Parenthesis

Insert a Closing 
Parentheses

Insert an Opening 
Bracket

The Brackets are used 
for enclosing database 
tables and fields.

Insert a Closing Bracket
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To create a custom formula...

1. In the Govern New Administration (GNA), select Editors (tab) > Formula 
Editor...

2. In the Formula Editor form click New .

3. Enter CNVRTACRS (i.e. Convert Acres), in the Name of Formula field (2).

4. Click the Expand button  to display the hidden parameters that need to 
be completed.

5. For the Short Description field, enter Convert Acres (3).

Consider Null as 0: Select this option to consider Null as 0 during the 
calculation process. Null represents the absence of a value and normally if 
one operand within the formula is Null, the result of the formula is Null. When 
this option is selected, Null is recognized as 0 and the formula returns a 
numeric value.

Is System: This flag / option is reserved for constants that are designated as 
Govern.NET system constants.

About System Reserved Values

Only users with Super-User access will be able to select and deselect the Is 
System option. In addition Super Users can also create new values and flag 
them for Govern.NET system use. 

Note: The location of this option is outside of any of the groups in the form.

Note: System constants are reserved for use by the Govern.NET system and 
as such should not be modified or deleted without a full understanding 
of the implications. Deletions of system values can damage the 
Govern.NET system, rendering it inoperable. Modifications that are 
made to System values should always be noted. When a system wide 
update is performed, these modifications may be overwritten. 
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6. Click in the Long Description field (4) to copy the Short Description; you 
may add additional descriptive information to the name.

7. Under the Algebraic Formula field (5), click inside; you will see your 
flashing cursor.

8. In the Insert in Formula group, look for the Add Query: field; click the drop-
down menu and select LOT_SIZE from the list; the LOT_SIZE variable will 
be added to the Algebraic Formula field.

9. Under Add Operator click the Divide symbol “/”.

10. Next, manually type 43560 into the field or enter it with the numeric pad in 
the Add Operator group.

Your formula will now look like the following... {LOT_SIZE}/43560

Note: Ensure that your cursor is placed inside the field before selecting the 
Add Query field.
© 2014 MS Govern Page 155



Govern New Administration (GNA)
The resulting value from this calculation will need to be rounded; the rounding 
will be dependent upon the number of decimal places required. In this 
instance we will round to two (2) decimal places.

11. Place your cursor at the beginning of the formula and click RN2 in the Add 
Function group. The following character will be added RN2(.

12. Enter a closing bracket “)” at the end of the equation.

13. The final requirement is to add an additional bracket around the whole 
equation so as to avoid any errors when it is used with other formulas that 
may not have brackets around them.

14. The final formula will look like this, (RN2({LOT_SIZE}/43560)) (5); click 
Save (6)

The formula will appear on the left hand side under the Formulas List (B).  
These formulas can be added to a logical expression created through the 
Logical Expression Block Editor, and added to a customized database field or 
linked to any field. See Logical Expression Editor on page 171 for details.

Insert in Formula group

To include a value from a database field, query, keyword or constant, in a 
formula, select the item from the drop-down list in the Insert In Formula group. 
You can include as many of these values as needed, by making multiple 
selections. The item is added where the cursor is placed in the Algebraic 
Formula edit box. For example, you could retrieve two values from the 
database, using Selection Queries, and add these values together.

The following restriction applies:

Note: When functions are added, ensure that opening and closing brackets 
are matching.

All fields, selected from the Fields list, must be associated with the same 
function.
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Add Function: You can include functions to your formula by selecting the 
drop down menu (A) for a list of available functions. 

The queries need to be defined through the SQL Query Editor. To include a 
query, select it from the list. The query name is displayed in the Algebraic 
Formula edit box between braces, { }. To create a new query, click “...” beside 
the Add Query drop-down menu, and display the SQL Definition Setup form. 
See  SQL Query Editor on page 229 for more information.

Add Query: You can include one or more queries in a formula (B). These 
queries must be Selection queries; i.e., used to retrieve data from one or more 
fields.

The queries need to be defined through the SQL Query Editor. To include a 
query, select it from the list. The query name is displayed in the Algebraic 
Formula edit box between brace brackets, { }. To create a new query, click 
“...” beside the Add Query drop-down menu, and display the SQL Definition 
Setup form. See  SQL Query Editor on page 229 for more information. 

Tables: To include a database field in a formula, you need to select the table 
first, from the Tables drop-down list.

For example, in the following formula:

{depr_year}-[MA_BUILDINGS.EYB]

The Effective Year Built (EYB) of the current building record is subtracted 
from the Depreciation Year, the year used in calculating the depreciation 
(depr_year).

The Depreciation Year query {depr_year} retrieves the depreciation year 
from the SY_RETRY table, by specifying values for the SECTION_ NAME 
and KEY_NAME fields:

Select KEY_VALUE From SY_RETRY Where SECTION_NAME=str(Year 
Id,4) and KEY_NAME='depreciation year'
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Consider Null as 0: Select this option to consider Null as 0 during the 
calculation process. Null represents the absence of a value and normally if 
one operand within the formula is Null, the result of the formula is Null. When 
this option is selected, Null is recognized as 0 and the formula returns a 
numeric value.

When there is a 2nd language, or multiple languages, ensure that these 
description fields are also completed.

Add Keywords: Select a keyword from the drop-down list to include it in the 
formula. Keywords are used to retrieve a value currently in memory; such as ~ 
parcel id ~ to retrieve the parcel id of the current record. Keywords are 
displayed in lowercase, between tildes, ~ ~.

Govern Keywords

The following table lists the available keywords for the formulas.

Note: The location of this option is outside of any of the groups in the form.

For example, to include the building sequence for the current building 
record, in the formula, select the ~building sequence~ keyword.

Code Keyword Description

ar_id Account Receivable ID Unique identification number of the 
current Account Receivable record

key_counter Activity ID Identification number of the current 
Activity record

ac_id Aircraft ID Unique identification number of the 
current Aircraft Excise Tax record

br_id Bankruptcy ID Identification number of the current 
Bankruptcy record

bt_id Boat ID Unique identification number of the 
current Boat Excise Tax record

bldg_id Building ID Identification number of the current 
Building

bldg_seq Building Sequence Sequence number of the current 
Building
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cc_id Cash Collection ID Identification number of the current 
Cash Collection record

co_id Complaint ID Identification number of the current 
Complaint record

*date Current Date The Current Date

dept Department The Department code

frozen_id Frozen ID Identification number of the current 
Frozen record

haz_id Hazard ID Identification number of the current 
Hazard record

h_id Hearing ID Identification number of the current 
Hearing record

in_id Inspection ID Identification number of the current 
Inspection record

land_id Land ID Unique identification number of the 
current Land

mb_id Misc. Billing ID Identification number of the current 
Miscellaneous Billing account

misc_id Miscelleaneous ID Identification number of the current 
Miscellaneous Billing account

mv_id Motor Vehicule ID Identification number of the current 
Motor Vehicle Account 

na_id Name ID Unique identification number of the 
current Name

of_id Offence ID Unique identification number of the 
current Offense record

p_id Parcel ID Unique identification number of the 
current parcel 

pm_id Permit ID Unique identification number of the 
current Building Permit, Electrical 
Permit, General Permit, Plumbing 
Permit, Permit to Name, Animal 
License, Business License, License to 
Name, Approval, Bond, Decision, 
Prosecution or Appeal record

Code Keyword Description
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Add Constants: Select a constant from the drop-down list, to include it in 
the formula or click “...” to create a new constant. Constants are displayed 
between ampersands (& &). See  Constant Value Editor on page 146 for 
more information.

Fields: After selecting the table, select the field from the Fields drop-down 
list. The value of this parameter for the current record is included in the 

pp_id Personal Property ID Identification number of the current 
Personal Property account

pp_det_id PP Detail ID Unique identification number of the 
current Personal Property Item

folio_id Project Folio ID Identification number of the current 
Project Folio

prj_id Project ID Identification number of the current 
Project record

tax_id Real Estate ID Identification number of the current 
Real Estate Tax record

sale_id Sale ID Identification number of the current 
Sale record

st_acct_id Self Reported Tax Acct 
ID

Identification number of the current 
Self Reported Tax Account record

st_id Self Reported Tax ID Identification number of the current 
Self Reported Tax record

si_id Site ID Identification number of the current 
Site

sa_id Special Assessment ID Identification number of the current 
Special Assessment record

tax_map Tax Map Number Tax Map Number of the current record

usr_id User ID Unique identification number of the 
current user

ub_id Utility Billing ID Unique identification number of the 
current Utility Billing account

year_id Year ID Year identification of the current 
record

Code Keyword Description
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formula. These selected tables and fields are displayed in uppercase, 
between square brackets; for example, [AC_ EXEMPTIONS.FROZEN_ID].

Executing Formulas and Logical Expressions

Business Entity Developers and Defining 
Formulas

Developers that are designing Business Entities should note that when 
defining a formula, take note all fields used in the formula. These fields will 
need to be included when designing the Entity in the Business Entity Designer 
(BED). For example, you are designing a formula that will use the following 6 
fields from the MA_BUILDINGS table:

In the BED you will need to enter each of the 6 field names as Attributes, and 
configure each one accordingly.

Note: When formulas and logical expressions that include keywords or 
database columns, are executed, all the applicable functions need to 
be open.
Alternately, you can add a Selection Query to the formula or logical 
expression, in order to retrieve values from database fields.

Appearance in Formula (Fields) Table Attribute Name Used

[MA_BUILDINGS.BA8010_VA] MA_BUILDINGS BA8010_VA

[MA_BUILDINGS.BA8020_VA] MA_BUILDINGS BA8020_VA

[MA_BUILDINGS.BA8030_VA] MA_BUILDINGS BA8030_VA

[MA_BUILDINGS.BA8040_VA] MA_BUILDINGS BA8040_VA

[MA_BUILDINGS.BA8050_VA] MA_BUILDINGS BA8050_VA

[MA_BUILDINGS.BA8061_VA] MA_BUILDINGS BA8061_VA
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Refer to the Business Entity Designer Release 5.0 user guide for details about 
designing Entities. 

Best Practices for Creating Formulas in Govern

When creating formulas in the Formula Editor, constants should be defined in 
the Constant Value Editor rather than entered as a “hard coded” value. This 
methodology allows constants, to be quickly updated when a rate change is 
authorized. In addition as a constant, there are no issues with using it in other 
formulas.

Troubleshooting Self Reported Tax Formulas

When creating formulas that are to be configured for use in the SRT module, 
issues may arise with formulas that explicitly use floating point numbers, i.e. 
numbers with decimal points. For example the number “0.07”, as a result of 
the presence of the decimal point has been known to cause issues in SRT 
calculations.
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Workaround for Decimal Point error in SRT Formula

For a situation where a floating point number must be used in an SRT formula, 
a practical workaround is to define the number as a fraction. For example, the 
number (0.07) can be represented fractionally as (7/100).

i.e. (7/100) = 0.07

The formula to calculate the value of the item after Sales Tax can be written as 
follows...

totItemVal = [itemVal + (itemVal * (0.15))]

where...

Sales Tax = 15%   Value of Item = itemVal   Total Value of Item = totItemVal

This formula, when rewritten in the prescribed workaround format, would 
appear as follows:

totItemVal = [itemVal + (itemVal * (15/100))]       Note: 15/100 = 0.15

Alternate Method using Constants

The above example of defining constants as a fixed number is often referred 
as “hard-coding”. Instead of “hard-coding” a constant it is recommended that 
the constant be expressed with a name; in the above example the name 
salesTax would be used. If a value is to be reused in numerous locations, it is 
preferable to define it as a constant.

The formula would then be written as follows:

totItemVal = [itemVal + (itemVal * salesTax)]
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Now salesTax is defined in the system with a value. Constants are defined in 
Govern with the Constant Value Editor that is found in the Govern New 
Administrator (GNA).

The salesTax constant would be defined in the Constant Value Editor as 
having a value of “0.15”.

The end result of using constants is that the formula will be easier to “read”. In 
addition, when a change to the salesTax value is required, the change to the 
value is made in one location in the Constant Value Editor; all locations that 
use the constant will be automatically adjusted. Refer to the section for the 
Constant Value Editor on page 146 of the Govern New Administration (GNA) 
release 5.1 user guide.

Note: Fractional values are not accepted by the Value field in the Constant 
Value Editor.
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Field Mask Editor

With the Field Mask editor, you can define a set of Field Masks that can then 
be applied to fields in the Business Entity Designer (BED). Applying a field 
mask automatically formats the data entered in the field according to a defined 
pattern. For example, you can define a pattern for telephone numbers and 
apply it to a Telephone field in the BED. Then, if the user enters 18005551212 
in an OpenForm, this is automatically formatted as 1-800-555-1212.

Use this editor for phone numbers, postal or ZIP codes, Tax Map Numbers, 
Social Security Numbers, etc.

To access the Field Mask Editor, in the Govern New Administration (GNA):

1. Select Editors (tab) > Field Mask Editor... (A)

Overview

Note: By default the fields on a form are “collapsed”, i.e. they are not fully 
visible. This is to give the form a cleaner appearance. Additional fields 
can be displayed with a click on the Collapse/Expand button.
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Field Mask Editor Command Buttons

New: Click New  to clear the screen so you can create a new Field 
Validation Mask.

Save: Click Save  to save a new record or modifications to an existing one.

Delete: Click Delete  to remove the current record.

Closing the Editor

To close the editor, click the Close Window button in the upper right hand 
corner of the form.

Field Mask Editor - Format Tab Parameters

Name: Enter a name for the field mask. This appears in the drop-down list 
that is displayed when you apply the mask.

English Short Description: Enter a short description to identify the 
department. This is useful for fast data entry and look-ups if space is limited on 
the forms.

English Long Description: Enter a long description to identify the 
department. This will be displayed for look-ups on forms and will be normally 
used for reporting.

Second Language Fields

When there is a 2nd language, or multiple languages, ensure that these 
description fields are also completed.

Note: When you click on New, the button changes to Cancel  ; this will 
allow you to cancel the creation of the current record. The Cancel 
button is present until the new record is saved.

Note: Only alphanumeric entries are permitted incode parameters. This 
means that names for codes can only be made up of letters and or 
numbers. Special characters such as the underscore “_”, the dash “-”, 
the ampersand “&” , etc. are not recognized.
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Is System: This flag / option is reserved for constants that are designated as 
Govern.NET  system constants.

About System Reserved Values

Only users with Super-User access will be able to select and deselect the Is 
System option. In addition Super Users can also create new values and flag 
them for Govern.NET system use. 

Field Mask: In this parameter, enter the text string that will be used for your 
field mask.

The following tables list the symbols that can be used in field masks. The 
second table lists symbols that can be used for Tax Map Numbers only:

Valid Field Masks

Note: System constants are reserved for use by the Govern.NET system and 
as such should not be modified or deleted without a full understanding 
of the implications. Deletions of system values can damage the 
Govern.NET system, rendering it inoperable. Modifications that are 
made to System values should always be noted. When a system wide 
update is performed, these modifications may be overwritten. 

Symbol Description

# Numeric value. Exact number of digits must be entered as defined in 
the “New Database Field Creation”.

 You can use the “-” (Dash) to separate the values.

9 Numeric value left justified compressed with trailing zeroes.

d Numeric value left justified compressed with trailing zeroes.

Z Numeric value right justified compressed with leading zeroes.

0 Numeric value right justified compressed with leading zeroes.
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Valid Masks for Tax Map Number Fields Only

 (To use with the “0”, “9”, “d” and “Z” masks only):

> Alpha & Numeric values. Alphabetic characters must be in uppercase. 
If only ONE “>” is entered, then the number of digits entered can be 
LESS than defined in the “New Database Field Creation” Size. 

Otherwise, the exact number of characters must be entered as 
defined.

You can use the “-” (Dash) to separate the values.

< Alpha & Numeric values. Alpha in lowercase. If only ONE “<” is 
entered, then the number of digits entered can be LESS than defined 
in the “New Database Field Creation” Size. Otherwise, the exact 
number of characters must be entered as defined. You can use the “-” 
(Dash) to separate the values.

A Alpha character in Uppercase. Number of characters entered must be 
as defined in “New Database Field Creation” Size. 

You can use the “-” (Dash) to separate the values.

^ Used to separate different possible masks in the same pattern also 
used as an OR clause.

! Alpha and numeric values as entered, both uppercase and lowercase. 
You can use the dash, — to separate values.

“ ” Leaves a blank space before the next series of characters, in the same 
text box.

Example:
A zip code should have 5 digits but may have a dash and 4 other digits. 
The pattern could be: #####^#####-####

Symbol Definition

. Displays the next series of characters in another text box with the 
period in between.

: Displays a single “.” Inside the series of characters, in the same 
text box.

Symbol Description
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A note to Users accessing Govern Remotely 

Create a Zip Code Field Mask

In the following example we will create a custom Zip Code Number. This field 
mask will accommodate the United States zip code format, and the Canadian 
postal code format. The background information required is that US zip codes 
can be 5 numeric digits, or in a format called ZIP+4. ZIP+4 includes the 
standard five digits plus a hyphen and four more digits. The Canadian postal 
code uses six alpha-numeric (6) characters; the Alpha and Numerical 
characters alternate starting with and alpha character. For example H8T 2M3. 
The first character is always an alpha, and there is a space between the first 
three characters and the last three.

To create our custom mask...

“” Displays the next series of characters in another text box.

- Displays a “-” (Dash) inside the series of characters, in the same 
text box.

Note: Users should note that parameters with field masks that are designed 
to accept hyphen separated entries, e.g. Telephone Numbers, Tax 
Maps, will display in OpenForms as a parameter with individual fields. 
These individual fields can be accessed with the tab key (A).

The Field Mask for the above would look like the like the following  
“XXX-”XXX-XXX-X”, each of the grouped X’s are separated. Users 
that are accessing Govern over a Remote Link, e.g. VPN should pay  
attention to the tab sequence when pressing the Tab key to jump to 
the next parameter. Over a remote connection, in the Tax Map 
parameter, the tab key will not move the cursor to the next field of the 
Tax Map number, rather it will jump to the Include Inactive parameter 
(1).  This behavior only applies to remote connections to Govern.

Symbol Definition
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1. In Govern New Administration (GNA), select Editors (tab) > Global Field 
Validation Mask Editor...

2. In the Field Validation Mask Editor form, click New.

3. In the name field, enter zippostalcode.

4. Enter a Short Description of US Zip & Cdn Post in the field.

5. Click into the Long Description field, the Short Description will be copied 
into the Long Description, add any additional information to the name.

6. In the Field Mask field, enter the following mask pattern:

#####^#####-####^A#A #A#       
Note that the grey box represents a space character. 

7. Click Save to save the mask.

Based on the information that was provided, the mask will format the following:

Five (5) numerical characters OR 5 characters a dash and then four (4) more 
numerical characters, OR six (6) alternating alpha and numerical characters. 
The caret symbol “^” represents an OR condition. 
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Logical Expression Editor

Create customized logical expressions, using the Govern New Administration 
(GNA) Logical Expression Block Editor. Logical expressions can be used in 
Mass Appraisal and Permit Fee calculations; when created they can then be 
linked to any field.

Uses for Logical Expressions

In the previous generation of Govern, i.e. Govern for Windows, Logical 
Expressions were used in two (2) principal areas, on calculated values, and 
for validation. Logical Expressions may now also be used to obtain the status 
of a control in the OpenForms Designer (OFD).

Calculated Values and Logical Expressions

When a logical Expression is used on a calculated value, the logical 
expression is attached to a field. The expression is interpreted and returns a 
value. For example, you could say that if a user selects a check box in the 
application, the Logical Expression could return one value, but if the check box 
is not selected, then another value is returned.

Using Logical Expressions in Validations

In the Business Entity Designer (BED), you are able to attach a Logical 
Expression to a field. The result of the Logical Expression can be TRUE or 
FALSE. Any condition can be entered in the Condition section, The IF section 
is used to validate one field against another. These sections are strictly for 
Field Values. After constructing your Logical Expression, it will return a TRUE, 
1, or FALSE, 0; when TRUE the field is valid, If FALSE the field is invalid.

Logical Expressions in the OpenForm Designer (OFD)

This is the third way to use Logical Expressions, and is only possible with the 
.NET architecture. In the OpenForm Designer (OFD), we can get the status of 
a control. Controls that are updated or executed can be made to return a value 
as part of the Business Rules. The returned values can be attached to a 
Logical Expression that can say that if there is a value in a field, set that field 

Overview
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to be viewable. This is similar to the status flags that are set in the Govern 
Security Manager (GSM). 

In the MoD there are flags specifically for Logical Expressions. Flags such as, 
CanAddLogExp, CanExecuteLogExp, CanUpdateLogExp, 
CanDeleteLogExp allow for User Interface (UI) validation.

For example, inspections with a status of complete, i.e. all data parameters 
have been completed, a Logical Expression query can be used to say that the 
status of the inspection is FALSE. If parameters are incomplete, the status 
can be set to TRUE. In this example, the Logical Expression can be used to 
enable or disable a UI field.

Note: These flags, when set, override any flags that may be set by the 
Govern Security Manager (GSM). For example if an entity is set not to 
be visible through a flag in the MoD, if this entity is used in a Business 
Model that is now set to be visible through the GSM, parameters that 
are attached to that entity will still not be visible.
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To access the Logical Expression Editor, in the Govern New Administration 
(GNA)...

1. Select Editors (tab) > Logical Expression Editor...

In a Logical Expression, a Temporary Field can be specified that can hold any 
value. For example, a temporary field can be used to hold a value generated 
from a query, a database field, or from user input. See Using a Temporary 
Field on page 186.

Logical Expression Editor Command Buttons

New: Click New  to clear the form so that you can enter new data. 

Save: Click Save  to save a new Logical Expression or any modifications 
to an existing one. Logical expressions are saved to VT_USR_LOGEXP.

Delete: Click Delete  to remove the current record from the database.

Closing the Editor

To close the editor, click the close window button in the upper right hand 
corner of the form.

Note: By default the fields on a form are “collapsed”, i.e. they are not fully 
visible. This is to give the form a cleaner appearance. Additional fields 
can be displayed with a click on the Collapse/Expand button. 

Note: When you click on New, the button changes to Cancel  ; this will 
allow you to cancel the creation of the current record. The Cancel 
button is present until the new record is saved.
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Logical Expression Editor - Expression Tab 
Parameters

Expression Name: Enter a name or code for the logical expression.

English Short Description: Enter a short description. This is used for fast 
data entry and look-ups if space is limited on forms.

English Long Description: Enter a long description. This is displayed 
during look-ups and on forms and reports.

Second Language Fields

When there is a 2nd language, or multiple languages, ensure that these 
description fields are also completed.

Is System: This flag / option is reserved for constants that are designated as 
Govern.NET  system data.

About System Reserved Values

Only users with Super-User access will be able to select and deselect the Is 
System option. In addition Super Users can also create new values and flag 
them for Govern.NET system use. 

Message: If required, when your logical expression returns an error enter a 
text string that will be displayed on the error message.

Note: Only alphanumeric entries are permitted incode parameters. This 
means that names for codes can only be made up of letters and or 
numbers. Special characters such as the underscore “_”, the dash “-”, 
the ampersand “&” , etc. are not recognized.

Note: System constants are reserved for use by the Govern.NET system and 
as such should not be modified or deleted without a full understanding 
of the implications. Deletions of system values can damage the 
Govern.NET system, rendering it inoperable. Modifications that are 
made to System values should always be noted. When a system wide 
update is performed, these modifications may be overwritten. 
Page 174 © 2014 MS Govern



Logical Expression
Editor
Logical Expression Block: Compose your logical expressions in this edit 
box. There is no limit to the number of statements you can add.

The following operators can be used:

Insert in Formula group - Add Query

It is under the add query parameter that the types of query to be inserted into 
the expression block is selected.

Add Query: There are two (2) drop-down menus under the Add Query 
parameter. The first parameter acts as a filter for the types of queries that will 
be displayed in the second parameter. The displayed queries can then be 
added to the Logical Expression Block.

Selection options for the filter are: 

• All - Select this option to display all queries that are available.
• Select - When selected, this option will display only selection queries.
• Action - This option display only action queries, i.e. update and delete 

type queries.

Operator Definition

= Equal to

> Greater than

< Less than

<> Different from

<= Less than or Equal to

>= Greater than or Equal to

IN Value represented by the first expression as present in the second

AND (xxxx) AND (xxxx)

OR (xxxx) OR (xxxx)
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Building Logical Expressions 

You can compose your logical expressions in the Logical Expression Block 
edit box, or copy and paste an expression from another file. Your logical 
expression can be made up of an unlimited number of statements, constants, 
formulas, keywords, queries, database fields, numeric values and strings.

Logical Expression Statements

The logical expression can be built from the following types of statements: IF... 
THEN... ELSE, DO, RETURN and IN.

IF… THEN… ELSE… Statements

This type of statement executes a group of statements, conditionally, 
depending on the value of the logical expression.

The following rules apply:

1. IF, THEN and ELSE must be written in uppercase.

2. A space must be entered between the statement and the action.

3. Only Select Queries can be used with the IF statement. For more 
information on queries, see  SQL Query Editor on page 229.

The syntax is as follows:

DO Statement

This type of statement executes an action. 

The following rules apply:

1. DO must be written in uppercase.

2. A space must be entered between the statement and the action.

3. It must be followed by an action.

IF condition THEN
statement
ELSEIF elseifcondition THEN
elseifstatement
ELSE elsestatement
ENDIF
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4. The action must be followed by a “;” (semi-colon).

5. Only Action Queries can be used with the DO statement. For more 
information on queries, see  SQL Query Editor on page 229. Also refer to 
the  Insert in Formula group - Add Query on page 175 for selection 
options.

The syntax is as follows:

RETURN Statement

This type of statement returns a value.

1. RETURN must be written in uppercase.

2. A space must be entered between the statement and the action.

3. The action must be followed by a “;” (semi-colon).

The syntax is as follows:

You can enter any of the following, after the RETURN: 

• Select Query: from the Add Query group drop down list. The query 
name must be entered between braces, { };  Refer to the  Insert in 
Formula group - Add Query on page 175 for selection options.

• Formula: from the Formulas drop down list. A formula must be entered 
between bar delimiters, “| FORMULA |”.

• String: ‘text’. A string is entered between single quotation marks,” ‘ ‘ ”.
• Date: #2004#

IF condition THEN
DO action;
ELSEIF elseifcondition THEN
DO action;
ELSE
DO action;
ENDIF

IF condition THEN
RETURN value;
ELSEIF elseifcondition THEN
RETURN value;
ELSE
RETURN value;
ENDIF
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• Value: 999
• Keyword: from the Keywords drop down list. A keyword must be placed 

between tildes, ” ~ ~”.
• TRUE: in uppercase
• FALSE: in uppercase
• A database field name must be entered, with the table, between square 

brackets, [TABLE.FIELD].

IN Statement

The following rules apply to the IN Statement:

1. An item list separated with a comma (,) must be placed after the IN 
operator.

2. The item list must be delimited with quotation marks (“)

3. The item list must contain at least two items.

4. The items in the list must be of the same type; i.e., numeric OR string

5. If the list contains items of different types, the items must be delimited with 
single quotation marks, noting that the type will be converted to a string.

6. All lists must be terminated with a semicolon in order to be valid.

Statement Correct / Incorrect Comments

IN “A,B,C,D”;  Incorrect Missing single quotes.

IN “10,20,30,40”;  Correct

IN “10,A,B,C”;  Incorrect Mix of numeric and string datatypes.

IN “‘10’,‘A’,‘C’,‘D’”;  Correct Correct but all items including number in 
quotes will be compared as string 
datatypes.

INA,B,C,D;  Incorrect No space after operator, and no quotation 
marks.

IN “‘A’”;  Incorrect More than one item is required

IN “A,B”;  Incorrect Character datatypes must have single 
quotes.

IN “‘10’,‘A’,‘B’,20”;  Incorrect Last numeric datatype is missing single 
quotes.
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Logical Expression Comparison Operators

IN “‘10’,‘20’,‘30’”;  Correct Correct but will be compared as string 
datatypes, therefore cannot be compared 
with a numeric datatype.

IN “‘A’,B”;  Incorrect Second characters is missing single 
quotes.

Operator Description How to use…

= Is the value represented by the first 
expression is equal to the value 
represented by the second?

0 = 0  True   

0 = 1  False

A = A  True

A = B  False

<> Is the value represented by the first 
expression not equal to the value 
represented by the second?

0 <> 1  True

0 <> 0  False

A <> B  True

A <> A  False

> Is the value represented by the first 
expression greater than the value 
represented by the second?

1 > 0  True

2 > 2  False

1 > 3  False 

>= Is the value represented by the first 
expression less than or equal to the 
value represented by the second?

1 >= 0  True 

2 >= 2  True

1 >= 3  False

< Is the value represented by the first 
expression less than the value 
represented by the second?

0 < 1  True

2 < 2  False

3 < 1  False 

<= Is the value represented by the first 
expression greater than or equal to 
the value represented by the second?

0 <= 1  True 

2 <= 2  True

3 <= 1  False

Statement Correct / Incorrect Comments
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Logical Operators

Adding Formulas, Database Fields, Queries, 
Keywords and Constants

To include a value from a formula, database field, query, keyword or constant, 
in a logical expression, select the item from the drop-down list. You can 
include as many of these values as needed, by making multiple selections. 
The item is added where the cursor is placed in the Logical Expression 
Block edit box. For example, you could make a comparison of two values, 
retrieved through Selection Queries.

IN Is the value represented by the first 
expression found in the second?

1 IN “1,2,3,4,5”  
TrueA IN “A,B,C,D,E” 
 True

9 IN “1,2,3,4,5”  
FalseZ IN 
“A,B,C,D,E”  False

Operator Description How to use…

AND The And operator performs logical conjunction on two 
Boolean expressions. That is, if both expressions 
evaluate to True, then the And operator returns True. 
If either or both expressions evaluate to False, then 
And returns False.

True AND True   True

True AND False  False

False AND True   False

False AND False  False

OR

The Or operator performs logical disjunction on two 
Boolean expressions. If either expression evaluates to 
True, Or returns True. If neither expression evaluates 
to True, Or returns False.

True OR True   True
True OR False  True
False OR True   True
False OR False  False

Operator Description How to use…
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The following restriction applies:

To create a new formula, query or constant, from the Logical Expression Block 
Editor, click the drop-down list for the item. 

Add Formula: To include a value calculated through a formula, select the 
formula from the drop-down list. Formulas are displayed between bar 
delimiters, ex. |FORMULA_NAME|. 

To create a new formula, click “...” to display the Formula Editor. See  Formula 
Editor on page 150 for more information.

Add Keyword: Select a keyword from the drop-down list to include it in the 
logical expression. Keywords are used to retrieve a value currently in memory; 
such as ~ parcel id ~ to retrieve the parcel id of the current record. Keywords 
are displayed in lowercase, between tildes, ~ ~. 

All fields, selected in the Fields list, must be associated with the same function.

IF |IMP_VALUE| > 0 THEN
RETURN |IMP_VALUE|;

ELSE
RETURN 0;

ENDIF

Note: When the logical expression is run, the functions, associated with the 
formula must be open.

For example, to include the building sequence for the current building record, in 
the logical expression, select the ~building sequence~ keyword.

For example, 
IF ~parcel id~ > 0 THEN
RETURN ~parcel id~;
ELSE
RETURN 0;
ENDIF
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You can also include the keyword, ~textbox value~, in a logical expression, to 
include a value entered by the user in a text box:

The following table lists and describes available keywords.

For example, 
IF ~textbox value~ > 100000 THEN
RETURN False;
ELSE
RETURN TRUE;
ENDIF

Code Keyword Description

ar_id Account Receivable ID Unique identification number of the 
current Account Receivable record

key_counter Activity ID Identification number of the current 
Activity record

ac_id Aircraft ID Unique identification number of the 
current Aircraft Excise Tax record

br_id Bankruptcy ID Identification number of the current 
Bankruptcy record

bt_id Boat ID Unique identification number of the 
current Boat Excise Tax record

bldg_id Building ID Identification number of the current 
Building

bldg_seq Building Sequence Sequence number of the current 
Building

cc_id Cash Collection ID Identification number of the current 
Cash Collection record

co_id Complaint ID Identification number of the current 
Complaint record

*date Current Date The Current Date

dept Department The Department code

frozen_id Frozen ID Identification number of the current 
Frozen record

haz_id Hazard ID Identification number of the current 
Hazard record
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h_id Hearing ID Identification number of the current 
Hearing record

in_id Inspection ID Identification number of the current 
Inspection record

land_id Land ID Unique identification number of the 
current Land

mb_id Misc. Billing ID Identification number of the current 
Miscellaneous Billing account

misc_id Miscelleaneous ID Identification number of the current 
Miscellaneous Billing account

mv_id Motor Vehicule ID Identification number of the current 
Motor Vehicle Account 

na_id Name ID Unique identification number of the 
current Name

of_id Offence ID Unique identification number of the 
current Offense record

p_id Parcel ID Unique identification number of the 
current parcel 

pm_id Permit ID Unique identification number of the 
current Building Permit, Electrical 
Permit, General Permit, Plumbing 
Permit, Permit to Name, Animal 
License, Business License, License to 
Name, Approval, Bond, Decision, 
Prosecution or Appeal record

pp_id Personal Property ID Identification number of the current 
Personal Property account

pp_det_id PP Detail ID Unique identification number of the 
current Personal Property Item

folio_id Project Folio ID Identification number of the current 
Project Folio

prj_id Project ID Identification number of the current 
Project record

tax_id Real Estate ID Identification number of the current 
Real Estate Tax record

Code Keyword Description
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sale_id Sale ID Identification number of the current 
Sale record

st_acct_id Self Reported Tax Acct 
ID

Identification number of the current 
Self Reported Tax Account record

st_id Self Reported Tax ID Identification number of the current 
Self Reported Tax record

si_id Site ID Identification number of the current 
Site

sa_id Special Assessment ID Identification number of the current 
Special Assessment record

tax_map Tax Map Number Tax Map Number of the current record

usr_id User ID Unique identification number of the 
current user

ub_id Utility Billing ID Unique identification number of the 
current Utility Billing account

year_id Year ID Year identification of the current 
record

~textbox value~ Validation of the user input for a field 
on a function

~textbox valuen~ Numeric text box value

~textbox valuec~ Alphabetic text box value

~textbox valued~ Date type text box value

Note: To validate data entry in a Logical Expression, you can use the 
keyword ~text box value~

For example, 
IF ~textbox value~ > 100000 THEN
RETURN False;
ELSE
RETURN TRUE;
ENDIF

Code Keyword Description
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Tables: To include a database field in a logical expression, you need to select 
the table first, from the Tables drop-down list.

Add Query: You can include either Action Queries, i.e., queries that perform 
some action, such as updating records in one or more tables, adding records 
to a table or deleting records from a table, or Selection queries; i.e., used to 
retrieve data from one or more fields, in a logical expression.

The queries need to be defined through the User-Defined Queries Setup form. 
To include a query, select it from the list. The query name is displayed in the 
Logical Expression Block edit box between braces, { }. For example, {AG_ 
VALUE}.

To create a new query, click “...”. This opens the SQL Definition Setup form. 
See  SQL Query Editor on page 229 for more information.

The following conditions apply:

• Only Select Queries can be used with the IF statement.
• Only Action Queries can be used with the ACTION statement.

Fields: After selecting the table, select the field from the Fields drop-down 
list. The value of this field for the current record is included in the logical 
expression. These selected table and field are displayed in uppercase, 
between square brackets; for example [AC_ EXEMPTIONS.FROZEN_ID].

For example, in the following logical expression:

IF {APP_VALUE} > 0 THEN
   RETURN |APP_VALUE|;
ELSE
   RETURN 0;
ENDIF

The Appraised Value of the current record is retrieved, through the 
{APP_VALUE} Selection query, and if the value is positive it is returned by the 
logical expression.

IF [PC_PARCEL.P_ID] > 0 THEN
   RETURN [PC_PARCEL.P_ID];
ELSE
   RETURN 0;
ENDIF
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Add Constants: Select a constant from the drop-down list, to include it in 
the formula or click “...” to open the Constant Value Editor and create a new 
constant. Constants are displayed between ampersands (& &). See  Constant 
Value Editor on page 146 for more information.

Message: Enter a message to be displayed if the validation fails.

Dates, Numeric Values and Strings: You can also include dates, 
numeric values and strings, as follows:

• Dates are displayed between crosshatches: IF A = #2004111# THEN
• Numeric values are displayed: IF A = 999 THEN
• Strings are displayed between single quotation marks: IF A = ‘text’ THEN

Using a Temporary Field

You can include a temporary field in a logical expression. This field can hold 
any value, such as one generated from a query, database field or user input.

To include a temporary field, add the following to the beginning of the logical 
expression:

To include multiple temporary fields, enter each value separately:

IF &TAX_RATE& > 0 THEN
   RETURN &TAX_RATE&;
ELSE
   RETURN 0;
ENDIF

SET ?TMP1? = <value>, where <value> is the value you are using

SET ?TMP1? = <value1>
SET ?TMP2? = <value2>
 where <value1> and <value2> represent the values you enter
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In an example we see that within our IF/ELSE block, we have the following:

For example, the following logical expression is based on a keyword and 
database field:

When written as above, the statement line is executed repeatedly. Should the 
IF statement contain one or more queries system performance could be 
severely impacted.

The above logical expression can be written using temporary fields, as 
follows:

IF (~year id~ - [MA_BUILDINGS.YEAR_BUILT]) <= 10 THEN
   RETURN 6;
ELSEIF (~year id~ - [MA_BUILDINGS.YEAR_BUILT]) <= 20 THEN
   RETURN 5;
ELSEIF (~year id~ - [MA_BUILDINGS.YEAR_BUILT]) <= 30 THEN
   RETURN 4;
ELSE
   RETURN 3;
ENDIF

SET ?TMP1? = ~year id~ 
SET ?TMP2? = [MA_BUILDINGS.YEAR_BUILT] 
IF (TMP1 - TMP2) <= 10 THEN
   RETURN 6;
ELSEIF (TMP1 - TMP2) <= 20 THEN
   RETURN 5;
ELSEIF (TMP1 - TMP2) <= 30 THEN
   RETURN 4;
ELSE
   RETURN 3;
ENDIF
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Best Practices for Logical Expressions

Logical Expression Structures

For our example we would like to execute a logical expression with the 
following structure...

IF |FORMULA| > {Query} THEN
RETURN |FORM2|;

ELSEIF |FORMULA| < {Query} THEN
RETURN |FORM2|;

ELSEIF |FORMULA| = {Query} THEN
RETURN = 3;

Best Practices dictates that the above structure be rewritten as follows:

SET ?Formula_Result? = |FORMULA|;
SET ?Query_Result? = {Query};
IF ?Formula_Result? > ?Query_Result? THEN

RETURN |FORM2|;
ELSEIF  ?Formula_Result? < ?Query_Result? THEN

RETURN |FORM2|;
ELSEIF  ?Formula_Result? = ?Query_Result? THEN

RETURN = 3;

When the logical expression is written using temporary fields as above, the 
initial results are “cached”, as a result the same query and results are not run 
repeatedly in each statement line. As a result of this method, system 
performance is not impacted.

Improve Performance by Improving Design 

When a Logical Expression is not written to run efficiently, the design of the 
expression could potentially impact the performance of the Govern 
application. 

EXAMPLE:

IF ({BA1} = -1) AND ({BA2} = -1) AND ({BA8240} = 0) THEN RETURN 
|PBR1|;

ELSEIF ({BA1} = -1) 
AND ({BA2} = -1) 
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AND ({BA8240} > 0) 
THEN RETURN |BA_PARK|;

ELSEIF ({BA1} = -1) 
AND ({BA2} > -1) 
AND ({BA8240} > 0) 
THEN RETURN |BA_PRK_OV|;

ELSEIF ({BA1} = -1) 
AND ({BA2} > -1) 
THEN RETURN |PBR2|;

ELSEIF ({BA2} = -1) 
AND ({BA1} > -1) 
THEN RETURN |PBR3|;

ELSEIF ({BA2} > -1) 
AND ({BA1} > -1) 

THEN RETURN |PBR4|;
ENDIF

In the above example, although the logical expression is valid and will run, as 
a result of the design, the {BA1} and {BA2} queries are run six (6) times, and 
the {BA8240} query three (3) times. Each time a query is run, system 
resources are required, this potentially impacts system performance. To 
prevent this situation from occurring, instead of calling the queries directly, 
Variables can be declared to hold the result of the queries. 

Using Variables when constructing Logical Expressions

The above example can be rewritten is as follows:

EXAMPLE:

SET ?V_BA1?={BA1};
SET ?V_BA2?={BA2};
SET ?V_BA8240?={BA8240};
IF (?V_BA1? = -1) AND (?V_BA2? = -1) AND (?V_BA8240? = 0) 
THEN RETURN |PBR1|;

ELSEIF (?V_BA1? = -1) 
AND (?V_BA2? = -1) 
AND (?V_BA8240? > 0) 

THEN RETURN |BA_PARK|;
ELSEIF (?V_BA1? = -1) 

AND (?V_BA2? > -1) 
AND (?V_BA8240? > 0) 

THEN RETURN |BA_PRK_OV|;
ELSEIF (?V_BA1? = -1) 
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AND (?V_BA2? > -1) 
THEN RETURN |PBR2|;

ELSEIF (?V_BA2? = -1) 
AND (?V_BA1? > -1) 
THEN RETURN |PBR3|;

ELSEIF (?V_BA2? > -1) 
AND (?V_BA1? > -1) 

THEN RETURN |PBR4|;
ENDIF

In the above optimized version of the original example, using the SET 
statement the results of the three (3) queries were declared as variables called 
?V_BA1?, ?V_BA2?, and ?V_BA8240?. The queries would be run once, the 
results would then be cached in memory and reused. An advantage here is 
that should the value be changed in the system by another user the result of 
our code fragment would not be impacted as we are still using the cached 
result. 

Executing Formulas and Logical Expressions

Note: In release 5.1 of the Logical Expression editor in GNA, when a 
variable is used multiple times in a query, formula, or data field, the 
system will display a warning.

Note: When executing formulas and logical expressions that include 
keywords or database columns, ensure that all database columns 
have been mapped to an attribute.

Alternatively, you can add a Selection Query to the formula or logical 
expression, in order to retrieve values from database fields. See 
Selection Queries on page 235.
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Resource File Editor

Resource files typically contain data that is intended to be deployed with 
applications. This data can be in the form of text strings, and occasionally 
images. The Resource File also allows the storage of different language 
versions used for localization of the user interface.

The Govern.NET Resource Files contain text, headings, labels, exceptions 
and error messages that appear in the applications within the suite. Other 
areas and applications that access resource files are the, Mobile Inspector, 
the eComponents Web pages and their respective Help files.

To access the Resource File Editor, in the Govern New Administration (GNA):

1. Select Editors (tab) > Resource File Editor...

Overview
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Resource File Structure

The resource file hierarchy is as follows:

(ROOT) Resource File Name (1) > Module (2) > Function (3) > Key (4)

Resource File Module

The Resource File Editor allows you to access and make modifications to the 
contents of the Govern Resource File. In the file each item or Module is saved 
containing one or more Functions.

The modules are organized as follows:

Note: New modules are indicated with a NEW!.

Module Type of information

AR Electronic payment transactions

BE Text and messages for the Business Entity Designer (BED)

BP Batch Process text and messages.

BR Bankruptcy messaags

BW Web audit and Web translation error messages

CC Credit Card Processor error messages

CI Text for the DeployEZ™ Installer

CO eComponent error messages
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CR Cadastral Renewal text

CX Text and messages for the Govern Security Manager (GSM)

DE Property Control messages and text

ES Text and messages for the Dynamic Search pane in Govern.NET

GI Text and messages for the embedded  Search pane in 
Govern.NET

GL Text and messages for Govern FMS module

IN Inspection business rules

MA Text and messages for the Govern.NET Mass Appraisal module.

MB Text and messages for the Govern.NET Miscellaneous Billing 
module.

MD Text and error messages for the Govern Model Designer (MoD).

ME MelissaData business rules

MO Inspection Scheduling messages

NA Business rules for Name and Address records

OD OpenForms Designer

OF Text and messages for OpenForms.

PC Business rules for Property Control records

PM ePermit business rules

QT Text and messages for Govern QueryTool

RB Text and messages for the Govern.NET ribbon menu interface.

SB Subscription Plan business rules and renewal notices

SC Data Synchronization process text and error messages.

SF Authentication messages

SL GIS Application text and messages

SM Text and messages for the Govern Security Manager .  module.

ST Messages and labels for the Govern.NET Self-Reported Tax 
module.

Module Type of information
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Resource File Function

Records are resource files that are organized by module. For example, text 
that might be related to payments might appear under AR (Accounts 
Receivable) and permit text under PM (Property Management). The modules 
are further subdivided according to the type of information they may contain.

Resource File Keys

Each separate Record, may contain multiple Key’s. Each key will contain 
three (3) columns titled, Key (this is the key name),  English (or your first 
language), and French (a second language). Each of these fields is a text 
field. Typically, keys are grouped by Function and Module.

The Key is a unique identifier for the text within the function, and should not be 
modified. You can, however, modify any of the French or English text, in 

SY System wide messages and error messages

TE Test translation text

TX Tax business rules

UB Business Rules for the Utility Billing searches

UL UEL Table related text (Quebec)

US NEW! Entries for the Govern User Registry

WB Text and error messages for the Web pages

WD Text and error messages for the Govern New Administration 
(GNA) and DeployEZ™  Publisher                                                                                                                                                                   

WF Business rules for the Permit Activities

WP Web Profile business rules

WZ Text and messages for the Data Access Block and Web 
Configuration

Module Type of information
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order to create customized Web pages. For example, you can change labels, 
headings and error messages to match your organization’s Web site.

Modifying Text in the Resource File Editor

Use the following procedure to modify any of the text that is saved to the 
Resource File Editor. This includes all the labels, headings, exceptions and 
error messages that appear on a Mobile Inspector, eProfile and eComponent 
Web pages.

To modify the text:

1. In the Govern New Administration (GNA), select Editor (tab) > Resource 
File Editor...

2. Select File > Open (Ctrl  + O)

3. Navigate to the directory where GovernNet.en.resources and 
GovernNet.fr.resources are located. By default, these files are 
located in a folder called ResourceFiles. This folder is created in the root 
of the MS Govern installation; the folder is called ResourceFiles.

4. Select and open one of these files. Both files will open in the Editor.

WARNING:
It is critical that the name of a Key should never be modified. Modifying 
the name of a key can potentially disable the correct functioning of a 
module.

Note: An ampersand (&) before a word or letter displays an underline; for 
example, &File, E&xit, &Help appears as File, Exit and Help. The F, 
x and H in this example are hotkeys; i.e., Alt + F displays the File 
menu, Alt + H displays the Help menu and Alt + F, X closes the 
application.

To display an ampersand on the Web, you need to enter two 
ampersands (&&) in the Resource files; for example to display Cat & 
Dog Licenses, enter Cat && Dog Licenses.
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5. Click File > Find on the .NET Resource Editor main menu bar or click 
Ctrl + F on your keyboard, to locate the text you want to modify.

6. Enter the text string that you want to locate in the Find textbox.

7. Check Exact Match if you want to locate the whole word or phrase exactly 
as entered.

8. Click Find to locate the text or click Cancel to close the Find form without 
any further actions.
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9. If the text was found, right-click on the text string to display a floating 
menu; select Edit... (1) to open the Resource Files Text Editor.

10. Make your modifications directly in the English String (2) and French 
String (3) text boxes, as required.

11. Click OK.

12. Click File > Find Next, on the .NET Resource Editor, or F3 on your 
keyboard, to locate the same text in another file, if required.

13. Click File > Save, or Ctrl + S, when you have completed your 
modifications. Both the French and the English files are saved. 

14. Click File > Close the file. A confirmation message appears if there are 
any unsaved modifications. You need to save the file in order to save your 
modifications.

Note: You should not modify the Label or Key, Function, or the Module.

Note: When you click OK, this closes the text box. You need to save the file 
in order to save your changes.
© 2014 MS Govern Page 197



Govern New Administration (GNA)
Similarly, when you click Exit, a confirmation message appears if there are 
any unsaved modifications.

Upgrading Resource Files

Merging Resource Files

Performing an upgrade to the next version of one of MS Govern’s eGovern – 
Public Self Service Portal can lead to loss of modifications made to the 
resource file. In order to avoid losing these modifications, you will need to run 
the Resource Files Merge process.

In running the resource file merge process, new Keys, containing the new text 
and features, are added to your existing file while existing keys are left 
untouched.

To merge two resource files together:

1. Click File > Merge on the .NET Resource Editor main menu bar, or click 
Alt + F, M, to open the Merging Resource Files process.

2. Click Browse beside the Base File parameter and navigate to the new file 
that you want to merge with your existing file.

3. Click Browse beside the File to include text box and navigate to your 
existing file.

Note: The Resource File Merge feature is required for upgrades only.
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4. Click OK. All the new keys will be added to your existing file. All existing 
text is left as is. If the merge was successful a confirmation window will 
appear; click OK. 

Click Cancel to close the form without merging the files.

Resource File Locking and IIS

Management of User Changes to Resource Files

Internally the Govern system uses the following methodology to maintain 
resource files and manage any user modifications.

The Methodology

The methodology for updating the resource files located in the ResourceFile 
folder of  the deployment directory is as follows:

When changes are made to the Resource file by the user, the modifications 
are not saved directly into the GovernNet.xx.resources files (xx = 2 letter 
culture language, e.g. en = English, fr = French, etc.). A new file called 
GovernNetClient.xx.resources is created that holds all user modifications.

When a new deployment is prepared and is ready for installation a three (3) 
step process occurs:

Note: Users of Govern’s eGov should note that when the Internet Information 
Services (IIS)  is running, resource files cannot be maintained by the 
Resource File Editor. IIS locks the files making it inaccessible. In order 
to access the resource file, you must stop the IIS service. This can be 
performed through the Control Panel; Control Panel > Administrative 
Tools > Services > Internet Information Services (IIS) Manager
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1. The old GovernNet.xx.resources files on the client are deleted.

2. A new empty file called GovernNet.xx.resources is created on the client, 
and the user changes within the GovernNetClient.xx.resources files are 
appended to these newly created files.

3. Now a second append is performed by combining the new 
GovernNet.xx.resources file located on the server to the one on the client 
(this is the one with the appended user changes). The resulting resource 
file is then updated on the server.

This process will ensures that all client changes are kept when the resource 
file is updated, in addition the server will always maintain a version of the 
resource file with all user changes.

Note: User modifications to resource files should be made to the 
GovernNet.xx.resources file. The system will internally manage the 
changes. Users should NOT modify the GovernNetClient.xx.resources 
file.

Note: Users of the eGovern - Public Self Service Portal  should note that the 
resource files containing the content of the eGovern menu Help text, 
i.e. GovernNetHelp.en.resources and GovernNetHelp.fr.resources 
are separate from the main system resource files. These files are also 
maintained with the GNA Resource File Editor, but should be backed 
up in a separate location.
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Govern’s Search Configuration (A) tools allow you to design and configure 
your own search forms in Govern.NET and for the Govern eProfiles and 
eComponents.

There are three (3) Search Configuration tools; each one corresponding to the 
steps of the configuration. The process is as follows:

1. Create the parameter or search object, using the Search Object 
Management tool. See Dynamic Search Objects Management on 
page 202.

2. Create a style combining search objects, using the Search Style 
Management tool. See Dynamic Search Style Management on page 210.

3. Create a style group, using the Search Group Management tool. See  
Dynamic Search Group Management on page 226.

Once you have created your search styles and style groups, you can link them 
to the eProfile, ePayment or ePermit by adding them through a web site form 
under the Menu Setup form in Govern New Administration (GNA). 

Accessing Dynamic Search Configuration Tools

To access the Dynamic Search Configuration tools in GNA:

1. Click Editors (tab) > Dynamic Search Configuration > Dynamic Search 
Objects.

Overview

Tip: You can keep all three tools open on your desktop and arrange them to 
optimize your available space. Windows can be cascaded, or tiled 
horizontally or vertically by selecting any of the options under the  
Windows menu in the Govern System Config & Admin application.
© 2014 MS Govern Page 201



Govern New Administration (GNA)
Dynamic Search Objects Management

All items that appear on the Search pages, including the search criteria and 
the labels are referred to as Objects. To display the objects on a Search page, 
you need to link them to a Search Style.

Through the Dynamic Search Object Editor, you can create the Search 
Objects and assign properties and behaviors to them.

The Search Objects Management tool has three sections (1), (2), (3):

Available Objects: Available Objects list box displays the existing search 
parameters or Objects. Once a Search Style is applied, the objects can be 
added to the Search page and used as search criteria.

Properties: The Properties section displays the attributes of the selected 
object. Use the Properties section to create a new object or to modify or delete 
the attributes of an existing object.
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Behaviors: Behaviors define how the data appears on the Web, and how 
they are stored in the database.

Creating an Object

An object is a parameter that can be used as a condition for a search. 
Alternatively a series of different objects can be collected together as a group. 
For example, objects such as House No.(From) (Location) and House No. (To) 
(Location) can be used as part of a group that allows the user to enter an 
address range in a search for parcels. 

To create an object:

1. In GNA, select Editors (tab) > Dynamic Search Configuration > Dynamic 
Search Objects...

2. When the Search Management Objects form appears, click Clear All 
Entries to reset the Properties and Behaviors parameters.

3. In the Code field, enter a string to identify the object in the database; use a 
maximum of 15 characters.

4. In the English Short Description field (or the Short Description field for 
your first language), enter a description using a maximum of 25 
characters.

5. For the English Long Description field, enter a description up to a 
maximum of 50 characters.

6. Repeat steps 4 and 5 for the second language parameters.

7. In the Table and Column drop-down menus, select the Govern database 
table and column, that will be used for the search.

8. From the Control Type drop-down menu, select one of the following:
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Selecting a Control Type

Control Type Description

Check Box Select this control type to display a check box to 
the user.

Note: When you select the Check Box control type, 
you need to consider the Checked option, under 
Behaviors. Select Checked if the object is to be 
selected (by default.

Combo Box There are three options for the combo box:

User Query: Select this option to display items from a 
customized query. Then enter the query in the Query 
text box.

System Table: Select this option to display items from 
a system table.

User Table: Select this option to display items from a 
user table.

Label Select this type to display the object as a label or 
heading. 

Text Memo Select this type to display a Memo field, for notes and 
comments. This type can accept an unlimited number 
of characters.

Textbox There are nine textbox types. Select one of the 
following options to define the type of entry to accept.

Alphanumeric: Select Alphanumeric to accept all 
alphanumeric characters.
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Textbox Currency: Select Currency to accept numeric 
characters, decimals, commas, spaces and currency 
symbols, such as the dollar sign ($). Entries are 
formatted according to the currency standards of the 
cultures entered on the Web Configuration tab of the 
Data Access Block.

For example, if en-ca and fr-ca are entered, $50.00 or 
50,00 $ are accepted.

Date: Select Date to accept alphanumeric and special 
characters. The date is formatted according to the 
setting selected on the Updata Retry.

Date / Time: Select Date / Time to accept alpha-
numeric and special characters. This is formatted 
according to the server. 

Numeric with Decimal: Select Numeric with 
Decimal to accept numeric characters and decimals 
only. No letters or special characters will be accepted.

Numeric without Decimal: Select Numeric without 
Decimal to accept numeric characters only. No 
decimals letters or special characters will be accepted.

Pattern: Select Pattern to apply a field mask or 
pattern to the data entry. The field mask automatically 
formats the data entered in the field according to a set 
pattern. For example, you can define a pattern for 
phone numbers and apply it to the Telephone fields. If 
the user enters 18005618168, this is automatically 
formatted as 1-800-561-8168.

When you select Pattern, the Pattern Name and 
Custom Pattern fields appear. You can select a 
pattern previously saved to the Govern database or 
create a new one.

Tax Map Number: Select Tax Map Number to apply 
the mask or pattern, saved in the Govern database, to 
the user entry tax map number.

Time: Date / Time: Select Time to accept alpha-
numeric and special characters. This is formatted 
according to the server. 

Control Type Description
© 2014 MS Govern Page 205



Govern New Administration (GNA)
9. Select all behaviors that apply to the object.

10. Click Add to add the new object to the Available Objects list box and to 
the USR_WEB_SEARCH_OBJ table. 

Create a Parcel ID Object

In the following example we will create a Parcel ID object which, when 
referenced, will be used for entering parcel ID numbers.

1. In the Search Object Management form, click Clear All Entries to start a 
new entry.

2. Enter pcParcelIDseg in the Code field.

Behavior Description

Encrypt Select Encrypt to encrypt the data in the database.

Force Uppercase Select Force Uppercase to save and display the user 
entry in uppercase.

Mask Entry with (**) Select this behavior to mask the user entry with 
asterisks, as with password entries.

Perfect Match Select Perfect Match to accept a full and exact match 
only. For example, to retrieve an account, the user 
must enter the full account number. A partial number is 
ignored.

Checked The Checked behavior applies only to the Check Box 
control type.

Select this option to display a checked box, by default.

Deselect this option to display an unchecked box, by 
default.

Visible This behavior is selected by default, meaning that if 
the object is added to the Web page, it will be 
displayed and made visible to the user. 

Deselect this behavior to make the object invisible to 
the user.
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3. Enter “Parcel ID Seg” in the English Short and Long Description, repeat 
the same description, or the following translation, “ID de la propriete seg” 
in the French Short and Long Description fields..

4. Under Control Type, select Textbox - Numeric without decimals.

5. Select PC_PARCEL for the table type.

6. The Column that will be used is P_ID; there will be no Default Value.

Take note of the code name that the object is given so that you can reference 
it for other examples.

Create a Tax Map Object with Default Values 

Certain municipalities may have specific requirements for Tax Map numbers. 
For example a specific numeric sequence may be required as part of the Tax 
Map number. To minimize errors during frequent entry, a default sequence 
may be set with the requisite numbers. In the following example we will create 
a Tax Map search object that will have default values in the fields.

In the Search Objects Management editor...

1. Click New.

2. Enter pcTaxMapSeg in the Code field.

3. Enter English short and long descriptions called Tax Map Number Pre

4. Repeat the short and long descriptions for the French fields

5. Select a Control Type of Textbox - Tax Map Number.

6. Select PC_PARCEL from the Table drop-down menu.

7. Select TAX_MAP_UFMT from the Column drop-down menu

The Default Value is where the required sequence is entered. When a Tax 
Map mask looks like the following: "##-###-##-##-####", and it needs to 
contain a default sequence with the following “-110-33-”, i.e. all tax maps will 

Note: When a Short Description is entered and you click in the Long 
Description field, it is copied into the Long Description field.

Note: The system will only allow one pattern for the Tax Map Number. The 
mask for this pattern is defined in the Global Field Validation Mask 
Editor. 
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contain these numbers, this sequence can be entered in the Default Value 
field:

Enter this sequence: "-110-33-"; without quotation marks.

Do not use this sequence: "XX-110-33-XX-XXXX"

“X” represents space characters. 

8. In the Default Value field (A), enter -110-33- with no spaces before or after 
the sequence.

9. Click Save, to add the new object to the list. 

10. If any additional changes are required, make them, then click Save to save 
the object again.

Note: When entering values into the Default Value field, DO NOT enter any 
quotation “ “ marks; only the dash “-” and the numbers are required.

Note: Space characters in the Default Value field are not required and will 
not work.
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The resulting object when used in the Govern search form will appear with the 
entered sequence as a default (A). 

Modifying an existing Object

To modify an object:

1. Highlight the object in the Available Objects list box.

2. Make any required changes to the parameters on the form.

3. Click Save.

Deleting an Object

To delete an object:

1. Highlight the object under the Available Objects column on the left hand 
side (LHS).

2. Click Delete; a confirmation window will appear.

3. Click Yes to delete, or No to cancel.
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Dynamic Search Style Management

Use the Dynamic Search Style management form to create search styles. A 
Search Style displays the Objects that appear on the Search page, these 
include search criteria and labels, and when initiated, launches an SQL query.

The Dynamic Search Style Management tool consists of two parts (1), (2):

Available Styles (by Sequence): The Available Styles list box displays 
the existing search queries or Styles. To view the details on a style, highlight it 
in the list.

Styles: The Styles tab displays details on the selected object. Details include 
a list of the linked objects and the SQL query.

Linked Objects 

The linked objects are listed in the order that they appear on the Web page.
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To modify an Object Sequence:

Linked Objects:  Linked Objects appear on the Web page in the order they 
are listed in the sequence.

Click Up to move the object towards the top of the list; so 
that it is performed nearer to the beginning of the 
sequence.

To move the object towards the end of the list, click 
Down. When moved down it is performed closer to the 
end of the sequence.

Click Add to open a secondary form 
where you can select objects to add to 
the sequence.
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Highlight the object or objects that you want to 
add (1). Then, click Add (A) on the secondary 
form.

To remove an object from an object sequence, 
highlight the object, in the Linked Objects list box 
and click Remove.

Creating a Style

To create a new style:

1. Click New  to clear the form.

2. In the Code field, enter a string, with a maximum of 15 characters, to 
identify the style in the database.

3. From the Key to Retrieve drop-down menu, select the reference ID to 
retrieve in the search.

4. In the English Short Description field (or the Short Description field of 
your first language), enter a description to a maximum of 25 characters.

5. In the English Long Description field, enter a description to a maximum 
of 50 characters.

6. Repeat steps 4 and 5 for the French, Spanish (or your second language) 
fields.

7. Select the objects to link to the style, using the Add button.

8. Define the order of the Object Sequence, using the Up and Down buttons.

9. Compose your query in the Query edit box, or copy and paste it from 
another application.

10. Click Add, under the Available Styles list box to add it to the list.

Modifying a Style

To modify an existing style:

1. Highlight the style in the Available Styles list box.

2. Make your change on the form.

3. Click Save to resave the style with the new parameters that have been 
search.
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Deleting a Style

To delete a style:

1. Highlight the object in the Available Styles list box.

2. Click Delete.

Creating a Dynamic Search Style Query

Design the Query

In the following example we will create a query that will perform a search by 
Parcel ID (P_ID). This query will use an object that was created in an earlier 
example in this document. See Create a Parcel ID Object on page 206.

In the database, the table that is being searched is called PC_PARCEL. In 
addition we will also retrieve information from other columns in that table. The 
additional information that would be of value would be the Tax Map Number, 
Subdivision, the Effective Year, and Inactive Year.

A basic SQL query would consist of three parts, a SELECT statement, a 
FROM statement, and a WHERE conditional clause.

The following is our example statement...

SELECT PC_PARCEL.P_ID, PC_PARCEL.TAX_MAP, PC_PARCEL.SUBD, 
PC_PARCEL.LOT, PC_PARCEL.EFFECTIVE_YEAR, 
PC_PARCEL.INACTIVE_YEAR FROM PC_PARCEL WHERE 
PC_PARCEL.P_ID=pcparcelidseg

The SELECT statement indicates the columns that are to be displayed in the 
Results pane.

The FROM statement will indicate the table that the columns are to be 
selected from.

The WHERE clause is used as a filter for the results, i.e. we say “WHERE” 
PC_PARCEL.P_ID is equal “=”  to the pcParcelID2 object.

Note: A basic understanding of Structured Query Language (SQL) queries is 
a prerequisite for this example.
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The pcParcelID2 object is a search object that was been created in the 
Search Objects Management form. See Create a Parcel ID Object on 
page 206.

Creating the Query in GNA

To build the Query in Govern New Administration (GNA)...

1. In GNA select Setup > Search Configuration > Manage Styles.

2. To start a new entry, click Clear All Entries.

3. In the Code field, enter pcParcelID2.

4. In the English Short and Long Description fields, enter By Parcel ID2.

5. Enter Par ID de la Properiete in the French Short and Long Description 
fields. 

6. In the Linked Objects (by sequence) field, click Add (1); this will display an 
Available Objects screen (2).

7. In the Available Objects screen, select the parcel ID object that was 
created in the Create a Parcel ID Object on page 206, Parcel ID Seg. 
Click Add (3).

Note: Take note of this name as it is the name that will be used to reference 
the query when you are creating something like a Search group.

Note: This is the approximate translation of the English text that was 
entered. This entry is not critical as it is simply used by users to 
identify the type of search, but entries must be made in all fields.
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8. You will be returned to the Search Styles Management form (A). 

At this stage you are ready to enter the query that was designed earlier. If you 
find the Query field space too restrictive when typing, one method you can use 
is to create the query in a text editor. After typing in the statements, copy and 
paste it into the Query parameter.

Type in the query as follows:

SELECT PC_PARCEL.P_ID, PC_PARCEL.TAX_MAP, PC_PARCEL.SUBD, 
PC_PARCEL.LOT, PC_PARCEL.EFFECTIVE_YEAR, 
PC_PARCEL.INACTIVE_YEAR FROM PC_PARCEL WHERE 
PC_PARCEL.P_ID=

When we compare the above statement to the one that was create earlier, the 
object called pcParcelID2 has been left out. The reason for this is that when 
we want to include objects that are in the Govern system, the Search Styles 
Management form can take care of the entry and append any required special 
characters that the system may require.
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To specify the Parcel ID object in your query...

9. Place your cursor immediately after the “=” sign (1) in your query 
statement, under the Linked Objects (by sequence) field (2), double-click 
on the Parcel ID Seg.

10. The object name is addded to the query; click Save.

Note: In the above final statement you will note that there is no space before 
or after the “=” sign. This is one of thesyntax rules that should be 
followed when creating queries.
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For a list of SQL query rules that should be followed in GNA, see the 
Appendix, SQL Syntax Rules for GNA on page 378.

Viewing Results in Govern

When the style has been saved, it can be seen in Govern. 

To view the Search Style in Govern...

1. Open a Profile in Govern.

2. From the Ribbon, select Views tab; Predefined Searches > Search Styles 
> By Parcel ID 2.

3. Click the Predefined Searches tab to display the Search form.
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4. The search form will display your object (A) and when you perform a 
search, the columns that you had requested in your query will be displayed 
(B).

Query Result Column Titles

As seen above (B), when results are displayed, the titles used for the 
requested columns are those of the database tables. When keeping an 
enduser in mind, column names used in the table, although acceptable for a 
database programmer, usually do not offer too much value to an end-user. For 
example, a column titled ”P_ID” is more understandable if it were called 
“Parcel ID”, or “SUBD” if it were called “Subdivision”.

Change Column Titles with an Alias

To customize the display of the column titles in our query results,’ display titles 
that are descriptive to the user will involve the use of an Alias. The syntax for 
using an alias in our SELECT statement is as follows...

SELECT PC_PARCEL.P_ID AS ‘Parcel ID’

The SELECT statement is used to indicate the columns that are to be 
displayed in the query results. AS is used to designate the alias name to be 
used for the resulting column title.

Note: When using AS ensure that the alias name is surrounded by an 
opening and closing single quote, e.g. ‘Alias_Name’.
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If one were to modify the following Dynamic Search query for a search by 
Inspector, the following statement...

SELECT PC_PARCEL.P_ID,
PC_PARCEL.TAX_MAP,
PM_INSPECTIONS.INSPECTION_DATE,
PM_INSPECTIONS.STATUS,
NA_NAMES.NAME_INDEX
FROM PC_PARCEL,
PC_LK_PARCEL_INSP,
PM_INSPECTIONS,
NA_NAMES
WHERE PC_PARCEL.P_ID=PC_LK_PARCEL_INSP.P_ID 
AND PC_LK_PARCEL_INSP.IN_ID=PM_INSPECTIONS.IN_ID 
AND PC_LK_PARCEL_INSP.MASTER_DEPT=PC_LK_PARCEL_INSP.DEPT 
AND PC_LK_PARCEL_INSP.MASTER_DEPT=department 
AND PM_INSPECTIONS.NA_ID=NA_NAMES.NA_ID 
AND NA_NAMES.NAME_INDEX LIKE @ininspector_0

...can be rewritten with aliases using the AS statement...

SELECT PC_PARCEL.P_ID AS 'Parcel No.',
PC_PARCEL.TAX_MAP AS 'Tax Map No.',
PM_INSPECTIONS.INSPECTION_DATE AS 'Inspection Date',
PM_INSPECTIONS.STATUS,
NA_NAMES.NAME_INDEX AS 'Inspector Name' 
FROM PC_PARCEL,
PC_LK_PARCEL_INSP,
PM_INSPECTIONS,
NA_NAMES
WHERE PC_PARCEL.P_ID=PC_LK_PARCEL_INSP.P_ID 
AND PC_LK_PARCEL_INSP.IN_ID=PM_INSPECTIONS.IN_ID 
AND PC_LK_PARCEL_INSP.MASTER_DEPT=PC_LK_PARCEL_INSP.DEPT 
AND PC_LK_PARCEL_INSP.MASTER_DEPT=department 
AND PM_INSPECTIONS.NA_ID=NA_NAMES.NA_ID 
AND NA_NAMES.NAME_INDEX LIKE @ininspector_0

Column Titles That Should Not Be Used

It should be noted that when you select an alias name for your column titles, it 
should not be the same as one of Govern’s Keywords. 
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For example in the above, the obvious column title of ‘Parcel ID’ was not 
used, instead ‘Parcel No.’ was used. The reason for the change is that 
‘Parcel ID’ is a system reserved keyword.

Refer to Govern Keywords on page 158 for a list of KEYWORDS THAT 
SHOULD NOT be used.

To use the above modified query in Govern.NET, in GNA either create a new 
query or for this example, modify an existing query.

1. Select Editors (tab) > Dynamic Search Configuration > Dynamic Search 
Styles...

2. In the Web Search Styles Management form, select an existing style, or 
create a new style. See Creating a Dynamic Search Style Query on 
page 213 for details.

3. Modify the query statements in the Query parameter.

4. Click Save  to save the modifications (A).
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In Govern.NET...

5. Perform an Inspector search in Govern.NET; specify By Inspector (1).

6. Enter a required name in the parameter (2) or directly click Search for 
Results (3).

7. You will note that the column names are using the specified alias titles.

Dynamic Search Queries on the Web

The process to create queries that are to be accessible on the web is the 
same as creating Dynamic Search queries. The major difference is in the 
location where the aliases are to be defined.

For Web searches column titles are defined in the resource file. This allows for 
the re-use of the column titles in other searches. For example if the P_ID is 
defined as Parcel No., it will always display as Parcel No. whenever it is used. 

Note: Alias names are not case sensitive, titles are presented in capital 
letters (A).
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This approach centralizes the definitions and minimizes the chances of error 
when multiple aliases have to be defined in each search style.

To make the entries into the resource file, you will need to use the Govern 
Resource Editor. The Resource Editor is included in GNA. Under Editors (tab) 
> Resource File Editor. See Resource File Editor on page 191 for details 
about using the Resource File Editor.

Modifying Web Search Result Column Headings

To make alias entries in the Resource File...

1. In GNA, select Editors (tab) > Resource File Editor. 

2. In the Resource File Editor  select File > Open...

3. Navigate to the root directory of your deployment; in the ResourceFiles 
folder, select the GovernNet.en.resources resource file.

In the Resource File, the function that you will be looking for is called 
WEB_CO_SEARCHPANEL. This function is located in the Web (WB) module 
of the Resource File.

4. In the column on the left hand side; click on the “+” beside WB to expand it 
and view all the functions within the module, or perform a  search for the 
string with the find menu option. See

Note: The Resource File is located in the root directory of the deployment 
folder and should only be edited by a system administrator.

WARNING: Editing Resource files should only be done by qualified 
individuals with Administrator privileges.
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5. When the WEB_CO_SEARCHPANEL function has been located, click to 
select it; the keys will be displayed in the pane on the right hand side.

Format for Entering the Alias Key

When the keys for the aliases are entered into the function, they must be 
named in a format that the system is expecting. The format to be used is as 
follows:

COLmyHEADING_CH

Where myHEADING is the title of the column in the table. The entry is padded 
with “COL” on the left hand side and “_CH” on the right hand side. For 
example if we wanted to enter a column title called SUBD, the entry would be 
COLSUBD_CH the alias title to be used will be Division.

To make your entry you will need to use the Resource File Text Editor. In the 
Resource File Text Editor, the Label parameter will contain the “padded” key 
entry, and the alias that will be used is entered in the text section of the form.

To add an alias to the function...

1. To add an alias to the WEB_CO_SEARCHPANEL function,  on the left 
hand side, right click on the function name; select Add Entry... (A) from 
the floating menu.

Note: The Resource File is shared by all applications in the MS Govern .NET 
suite. Any additions made to this file will automatically be updated.

Note: The COL and _CH padding are mandatory for your entry to be 
recognized by the system.
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2. In the Resource File Text Editor, enter the column name into the Label 
parameters (1).

3. Enter the alias column name in the English String and other language 
parameters (2), (3).

4. Click OK to accept the change.

When entered, this aliased column title will be displayed online.

Note: Unlike the the column titles in Govern.NET, titles will be displayed as 
they are entered, i.e. in both upper and lower cases.
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Before Alias

After Alias

Note: All column header aliases will apply to all search style queries 
containing the same field name or alias name. In addition, search style 
queries using aliases are required to use the alias name instead of the 
field name in the table.
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Dynamic Search Group Management

Use the Dynamic Search Group management tool to group together multiple 
Search Styles. 

The Dynamic Search Group management tool consists of two parts:

Available Groups: The existing groups appear in the Available Groups list 
box (1). To view the details on a group, highlight it in the list.

Search Groups: The Search Groups tab displays details on the selected 
group (2).

Creating a Group

To create a group:

1. Click New  to reset the form; so that you can enter new data.
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2. In the Code field, enter a string, with a maximum of 15 characters, to 
identify the style in the database.

3. In the English Short Description field (or the Short Description field of 
your first language), enter a description to a maximum of 25 characters.

4. In the English Long Description field, enter a description to a maximum 
of 50 characters.

5. Repeat steps 4 and 5 for the French, Spanish (or second) language 
fields.

6. Select the styles to link to the group, using the Add button.

7. Click Add, under the Available Groups list box to add it to the list.

Modifying a Group

To modify a group:

1. Highlight the group in the Available Groups list box.

2. Make your change on the form.

3. Click Save .

Changing the Style Order

To change the order of the linked styles:

Click Up to move the style towards the top of the list; so 
that it is performed nearer to the beginning of the 
sequence.

Click Down to move the style towards the end of the list; 
so that it is performed closer to the end of the sequence.

Click Add to open a secondary form where you 
can select styles to add to the group.
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Highlight the style or styles that you want to add 
(1) and click Add (2) on the secondary form.

To remove a style, highlight it in the Linked 
Styles list box and click Remove.

Deleting a Group

To delete a group:

1. Highlight the object in the Available Group list box.

2. Click Delete .
Page 228 © 2014 MS Govern



SQL Query Editor
SQL Query Editor

The Govern New Administration (GNA) SQL Query Editor allows you to create 
both Action and Selection SQL queries. Selection queries are used to search 
and view data, while Action queries allow you to update, or delete data in the 
database. As with the SQL Query editor in the Govern for Windows Admin, the 
queries you design are validated for syntax.

To access the SQL Query Editor in GNA:

1. Select Editors (tab) > SQL Editor...

Overview

Note: By default the fields on a form are “collapsed”, i.e. they are not fully 
visible. This is to give the form a cleaner appearance. Additional fields 
can be displayed with a click on the Collapse/Expand button (A). 
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SQL Query Editor Command Buttons

New: Click New  to clear the screen so you can create a new SQL Query. 

Save: Click Save  to save a new query or modifications to an existing one.

Delete: Click Delete  to remove the current record.

Closing the Editor

To close the editor, click the Close Window button in the upper right hand 
corner of the form.

SQL Query Editor Parameters

Query Name: Enter a name or code to identify the query.

For the queries that retrieve data and display a value, you can add the 
following characters to the beginning of the name. These characters format 
the value in the result: 

For example, the following query retrieves the appraised value of the property 
and formats it as the Currency without decimals type:

Note: When you click on New, the button changes to Cancel  ; this will 
allow you to cancel the creation of the current record. The Cancel 
button is present until the new record is saved.

Character Format Type Example

$ Currency with decimals $2,000.25

@ Currency without decimals $2,000

#! Numeric with decimals 2,000.25

. Numeric without decimals 2,000

Query Name:  @GetApp
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English Short Description: Enter a short description to identify the 
department. This is useful for fast data entry and look-ups if space is limited on 
the forms.

English Long Description: Enter a long description to identify the 
department. This will be displayed for look-ups on forms and will be normally 
used for reporting.

Second Language Fields

When there is a 2nd language, or multiple languages, ensure that these 
description fields are also completed.

Is System: This flag / option is reserved for constants that are designated as 
Govern.NET  system data.

About System Reserved Values

Only users with Super-User access will be able to select and deselect the Is 
System option. In addition Super Users can also create new values and flag 
them for Govern.NET system use. 

Warning: Enter a message to be displayed before the query is executed, in 
this optional field. For example, if you are linking a query to the Delete button 
of a function, create a message to notify the user that one or more records will 
be deleted. The user can confirm or cancel the action.

Query: SELECT appraised_value FROM MA_MASTER WHERE p_id 
= parcel id and frozen_id = frozen id and 
year_id = year id

Result: $288,000

Note: System constants are reserved for use by the Govern.NET system and 
as such should not be modified or deleted without a full understanding 
of the implications. Deletions of system values can damage the 
Govern.NET system, rendering it inoperable. Modifications that are 
made to System values should always be noted. When a system wide 
update is performed, these modifications may be overwritten. 
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Alternate Connection Key: Database connections are usually set in the 
General Settings form, they can be overridden if required. An alternate 
Connection Key can be specified.

Query (SQL): Enter the new SQL Query statement or modify an existing 
one, in this edit box.

Creating Queries

Create a Simple SQL Query

For this example we will create a basic SQL query that will retrieve lot size 
information from the Govern table (Table: MA_LAND).

The query will need to get the lot size entry under the LOT_SIZE column in the 
MA_LAND table. The query should look like the following:

SELECT MA_LAND.LOT_SIZE

This means that we need the LOT_SIZE column...

FROM MA_LAND

...from the MA_LAND table...

WHERE MA_LAND.YEAR_ID = Year ID AND MA_LAND.FROZEN_ID = 
Frozen ID AND MA_LAND.LAND_ID = Land ID

...the YEAR_ID is the same as the current Year ID, the FROZEN_ID is the 
same as the current Frozen ID, and the LAND_ID is the same as the current 
Land ID.
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To create a simple query...

1. In GNA, select Setup > Editors... > Sql Queries Editor...

2. Click New (1) to start a new query.

3. Enter LOTSIZE2 in the Query Name field (2)

4. In the Short Description field enter Lot Size (3)

5. Click into the Long Description field (4), the Short Description will be 
copied into the Long Description, add any additional information to the 
name.

6. Click in the Query (Sql) field (5); begin typing in the query created earlier.

SELECT MA_LAND.LOT_SIZE FROM MA_LAND 
WHERE MA_LAND.YEAR_ID=Year ID AND 
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MA_LAND.FROZEN_ID=Frozen ID AND 
MA_LAND.LAND_ID=Land ID

7. To save the new query, click 
Save (6); if an error exists within 
the query, the system will not 
allow it to be saved. You will be 
presented with a dialog box like 
the following; click OK and make 
any necessary corrections to the 
syntax of the query.

8. The new query will appear under the SQL Definition List (A) on the left 
hand side.

The query will appear on the left hand side under the SQL Definition List. 
When saved this query will be accessible for use in formulas and logical 
expressions. See Formula Editor on page 150 and  Logical Expression 
Editor on page 171 for details.

Query Types

You can compose and store both Action Queries and Selection Queries in the 
SQL Query Editor. To retrieve or to use a value from the current record; for 
example, while running a query from a function or formula, you can include a 
keyword. See  Using Keywords on page 237 for details.

Note: When entering the query, ensure that there are no spaces before and 
after the “=” sign. For other syntax rules, see SQL Syntax Rules for 
GNA.

Note: To minimize the chances of errors when composing your queries,  
refer to SQL Syntax Rules for GNA on page 378 for details.

Note: Keywords can be included on the SQL Definition Setup form, only.

Note: On the SQL Definition Setup form, you must use SQL syntax for 

Microsoft® Access®.
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Selection Queries

Selection Queries are used to retrieve records from one or more specified 
tables, according to the selection criteria.

The syntax is as follows:

For example, the following query, retrieves the City District name from the 
PC_AREA table for the record matching the current parcel ID, frozen ID and 
year.

Action Queries

Action Queries are used to perform actions, such as updating records in one 
or more tables, adding records to a table, deleting records from a table or 
creating a new table or index.

This section provides simple examples of Update, Append and Delete 
Queries. Since the SQL Definition Setup form is used for queries that are run 
multiple times, it is better to compose and run a Create Query from outside 
Govern.

Update Queries

Update Queries are used to modify records in one or more tables, by changing 
values in specified tables and fields, according to certain criteria.

The syntax is as follows:

For example, the following query enters the value abc in the Fire District field 
of the PC_AREA table, wherever the value for this field is null.

SELECT [column] FROM [table] WHERE [criteria]

SELECT DIST_CITY FROM PC_AREA WHERE p_id=parcel id and 
frozen_id=frozen id and year_id = year id

UPDATE table.* SET value WHERE criteria

UPDATE pc_area SET dist_fire = ‘abc’ WHERE dist_fire IS 
NULL
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Update Queries are typically used when you need to change multiple records 
in a table or records in multiple tables.

Insert Queries

Insert Queries are used to add a single record to one or more table. You need 
to specify the fields to which you are adding values and the value for each 
field. Otherwise, the default value or Null is entered.

The syntax is as follows:

For example, the following query adds a record to the VT_USR_NAMECODE 
table, entering the values ENG, LD, ITR and In Trust in the language, 
department, code, short description fields.

You can also append multiple records to a table, by first selecting the records 
in another table. For this, a Selection Query is added to the Append Query.

Delete Queries

Delete Queries are used to remove records from one or more tables.

The syntax is as follows:

For example, the following query, add records containing the year 2004 are 
deleted from the PC_AREA table.

Tip: You do not obtain a list of results from running this type of query. To 
verify which records will be changed, you can run a Selection Query 
using the same parameters and criteria and view the Results screen.

INSERT INTO table (column list) VALUES (value list)

INSERT INTO vt_usr_namecode (language,dept,code,short_desc) 
VALUES (‘ENG’,’ ’,’ITR’,’In Trust’)

DELETE [table.*] WHERE criteria

DELETE FROM pc_area WHERE year_id = 2004
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Using Keywords

You can include a keyword in a query to retrieve or perform an action on a 
value in the current record, or the record most recently saved and still in 
memory. 

To include a keyword, double-click in SQL Definition Setup form. This displays 
the following list of keywords (Table: VT_SY_BRULE):

Tip: The Delete Query deletes more than the specified fields, it deletes the 
entire record. To delete data from specific fields only, create an update 
query that changes the values to Null.

Code Keyword Description

ar_id Account Receivable ID Unique identification number of the 
current Account Receivable record

key_counter Activity ID Identification number of the current 
Activity record

ac_id Aircraft ID Unique identification number of the 
current Aircraft Excise Tax record

br_id Bankruptcy ID Identification number of the current 
Bankruptcy record

bt_id Boat ID Unique identification number of the 
current Boat Excise Tax record

bldg_id Building ID Identification number of the current 
Building

bldg_seq Building Sequence Sequence number of the current 
Building

cc_id Cash Collection ID Identification number of the current 
Cash Collection record

co_id Complaint ID Identification number of the current 
Complaint record

*date Current Date The Current Date

dept Department The Department code
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frozen_id Frozen ID Identification number of the current 
Frozen record

haz_id Hazard ID Identification number of the current 
Hazard record

h_id Hearing ID Identification number of the current 
Hearing record

in_id Inspection ID Identification number of the current 
Inspection record

land_id Land ID Unique identification number of the 
current Land

mb_id Misc. Billing ID Identification number of the current 
Miscellaneous Billing account

misc_id Miscelleaneous ID Identification number of the current 
Miscellaneous Billing account

mv_id Motor Vehicule ID Identification number of the current 
Motor Vehicle Account 

na_id Name ID Unique identification number of the 
current Name

of_id Offence ID Unique identification number of the 
current Offense record

p_id Parcel ID Unique identification number of the 
current parcel 

pm_id Permit ID Unique identification number of the 
current Building Permit, Electrical 
Permit, General Permit, Plumbing 
Permit, Permit to Name, Animal 
License, Business License, License to 
Name, Approval, Bond, Decision, 
Prosecution or Appeal record

pp_id Personal Property ID Identification number of the current 
Personal Property account

pp_det_id PP Detail ID Unique identification number of the 
current Personal Property Item

folio_id Project Folio ID Identification number of the current 
Project Folio

Code Keyword Description
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For example, in the following query, the parcel id, frozen id and year id 
keywords are used to retrieve the appraised property value from the MA_ 
MASTER table, where the P_ID, FROZEN_ID and YEAR_ID fields match the 
values for the current record.

Best Practices for SQL Queries

When creating SQL queries, it is good practice to specify both the table and 
the field names in your WHERE query statement.  

prj_id Project ID Identification number of the current 
Project record

tax_id Real Estate ID Identification number of the current 
Real Estate Tax record

sale_id Sale ID Identification number of the current 
Sale record

st_acct_id Self Reported Tax Acct 
ID

Identification number of the current 
Self Reported Tax Account record

st_id Self Reported Tax ID Identification number of the current 
Self Reported Tax record

si_id Site ID Identification number of the current 
Site

sa_id Special Assessment ID Identification number of the current 
Special Assessment record

tax_map Tax Map Number Tax Map Number of the current record

usr_id User ID Unique identification number of the 
current user

ub_id Utility Billing ID Unique identification number of the 
current Utility Billing account

year_id Year ID Year identification of the current 
record

SELECT appraised_value FROM ma_master WHERE p_id=parcel id 
and frozen_id=frozen id and year_id=year id

Code Keyword Description
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EXAMPLE 1: The Original query below would function in Govern for 
Windows, but would result in an error in Govern.NET. In order for it to function 
in Govern.NET it is  necessary to include the table name in the WHERE 
statement. This was done in the Corrected example by using a “.” as a 
separator.

Specifying the table name in the WHERE statement is a good practice to 
follow when building SQL queries.

Original
select count(*) 
from pm_lk_permit_name,na_company_info 
where key_id = permit id 
and pm_lk_permit_name.na_id = na_company_info.na_id
and link_type = 'contr' 
and cont_type = 'SI' 
and (in_exp_date < current date or in_exp_date is null) 

Corrected
select count(*)
from pm_lk_permit_name,na_company_info
where pm_lk_permit_name.key_id = permit id
and pm_lk_permit_name.na_id = na_company_info.na_id
and pm_lk_permit_name.link_type = 'contr'
and na_company_info .cont_type = 'SI'
and (na_company_info.in_exp_date < current date or 
na_company_info.in_exp_date is null)
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EXAMPLE 2: Another example of a query is the following. This is a SELECT 
query for PRIMARY_LAND

Controlling Appearance of Results in the Govern 
Treeview

One feature of the Govern.NET application is the users ability to control the 
appearance of results in the Treeview. This feature will appeal to users that 
perform queries that require that they display a Tax Map as opposed to a 
Parcel.

FOR EXAMPLE:

In the following query, the Tax Map Number (‘TAX_MAP’) is being replaced 
with the Roll Number (‘ROLL NO’).

SAMPLE LISTING: 

Name: ParcelDesc001 

SELECT 

CASE 

WHEN A.NON_PARCEL_FLAG = -1 AND NON_PARCEL_ID > 0 THEN  'PREMISE ID: ' || 
CAST(A.NON_PARCEL_ID AS VARCHAR(30))  ||  '  '   || B.CURRENT_TENANT   

Original
SELECT DISTINCT 
  I.PRIMARY_LAND 
FROM 
  PC_LEGAL_INFO I LEFT JOIN 
  PC_AREA A ON A.P_ID = I.P_ID
WHERE
  I.P_ID = Parcel ID AND 
  I.YEAR_ID = Year ID AND
A.FROZEN_ID = Frozen ID

Corrected
SELECT PC_LEGAL_INFO.PRIMARY_LAND  FROM PC_LEGAL_INFO WHERE 
PC_LEGAL_INFO.P_ID = Parcel ID  AND PC_LEGAL_INFO.YEAR_ID = 
Year ID AND PC_LEGAL_INFO.FROZEN_ID = Frozen ID
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WHEN A.NON_PARCEL_FLAG = -1 AND NON_PARCEL_ID IS NULL THEN  'P ID: ' || CAST(A.P_ID 
AS VARCHAR(30)) 

ELSE  'ROLL NO: ' || A.TAX_MAP 

END

FROM PC_PARCEL A LEFT JOIN V_PC_OCCUPANT_CURRENT_TENANT B ON A.P_ID = B.P_ID 

WHERE A.P_ID = 261362 AND ROWNUM = 1

When the above sample code is incorporated in the query, results with Tax 
Map numbers will be displayed with the Roll Number.

SQL Query Editor Custom Control

Developers that are creating custom queries for their users have options for 
presenting their SELECT query results. As a custom Control, it must be 
launched from a form. A generic custom control is available to present query 
results in a pop-up window, or embedded in a grid under a tab in MS 
Govern.NET.

Note: The following section requires use of the Govern Model Designer 
(MoD); refer to the MS Govern Model Designer (MoD) release 5.0 
user guide for details about using the application. 
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Custom Control Display Methods

As stated above, there are two (2) display options or Methods used for query 
results:

LoadQueryForModalWindow: This method is used for displaying popup 
windows. The trigger, a button in the form tab area is clicked by the user and it 
launches the query. The results of the query are displayed in the resulting 
popup window.

LoadQuery: The LoadQuery method is used to embed the results in a 
separate tab area. For this type of display, a new tab is required.

Configuring Results in a Popup Window

In the following example, we will insert a custom control in the Building 
Permits tab of the Building Permits openform. This control will display the fee 
history for a building permit record. The method of display for our query results 
will be in a popup window.

To set up and display results of this query in Govern.NET we will need to 
follow these steps...

Step 1 - Design a query

The query that will be used for the Fee History popup is one that is already 
available in the SQL Query Editor in GNA. Queries can contain keywords like 
P_ID that can be used to filter parcels. For our example we need a SELECT 
query that will return the fee history for a permit record. This type of query is 
part of the reference database. When developing your own SQL queries, refer 
to the SQL Query Editor on page 229 of this guide for details. The query that 
will be used is called Fee History (Permit), or more accurately, its Query 
Name, pmFeeHistoryPM. Take note of the Query Name, it will be the one that 
will be selected in the Model Designer (MoD).

Step 2- Setup the Custom Control in the MoD

The Custom Control is added and configured in the MoD. It is here that the 
method that the Custom Control is presented in a form is defined. For our 
example the display method will be a popup window, i.e. 
LoadQueryForModalWindow.

In the Model Designer (MoD)...
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1. At the Cell level (A), right click and select the Add custom control option.

2. Locate the newly created Custom Control entry and click to select it.

3. On the right hand side in the Property Explorer pane modify the controls 
flags as follows:

Section Flag Name Settings Comments

defaultaccessrights CanExecuteLogExp

Misc DividerTabSequence 1 The tab number that control 
button will appear in

Action Settings (...)

Assembly Name WPFCustomControl.dll

Class Name ViewQuery

Method Name LoadQueryForModalWindow Method indicating that popup 
window is to be used for results

Embedded Image Icon_ActionButns Image for button

External Image

Is Alone False

Is Overlapped False

In New Row True

First Row True

In New Column True

First Column True

Is Always Visible False

ToolTip Click to display Fee History Tool tip description of button
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4. Click Save to save the modifications that have been made to the Model.

As the OpenForms Model has been modified, a synchronization process will 
be required in the Govern Security Manager (GSM).

Width 700 Display width of popup

Height 350 Display height of popup

Left 0

Top 0

Start in New Window True Indicates that new windows is 
required

OpenInModalWindow True Will open as a popup

Will Be Closed False

Will Be Opened False

Arguments

Return Property

Return Property

Special Feature None

Query pmFeeHistoryPM Name of query to be run - taken 
from GNA

Report

Connection

Activate Force 
Refresh

False

Call Without Data False

Show Label False

To Be Audited False

Label Text Fee History Label for the window

Section Flag Name Settings Comments
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Step 3 - Synchronizing in the GSM

The Synchronize All button is used when modifications have been made to the 
settings of any of the Govern applications, or changes have been made that 
will affect the database.

In the GSM...

1. Click Synchronize All. 

2. Close the application.

Step 4 - Review and Test in MS Govern.NET

After the synchronization in the Govern Security Manager (GSM), the control 
can now be displayed in MS Govern.NET.

In MS Govern.NET...

1. Open the Land Management profile.

2. Perform a property search; open a record.

3. Double click on the Building Permits OpenForm. 
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4. You will note the addition of a new button in the tab.

5. When you hover your pointer over the button, you will see the Click to 
display Fee History text that was entered in the ToolTip flag in the MoD.

6. Click the button; a popup window titled Fee History is displayed with the 
results of the pmFeeHistoryPM SQL query.

The contents that are displayed in the Popup Window are the results of the 
query that is associated with the custom control. Other SELECT queries may 
be substituted for the one in the above example. 

Configuring Results in a Separate Tab

In this example, instead of a Custom Control button triggering a popup window 
that displays the query results, the results will be displayed in a permanently 
displayed tab. As with the popup display method above, we will again need to 
first design a query in the SQL Query Editor. For the sake of simplicity, we will 
use the same query as above, pmFeeHistoryPM. The only change this time 
will be in the manner that the query results are displayed.

Step 1 - Design a query

This example is using a query that is available in the Govern reference 
database. It can be seen through the SQL Query Editor in GNA. Users should 
always take time to review the design of their SELECT query to ensure that 
the results are as requested.

The query that will be used for this example is called Fee History (Permit). 
Take note of the Query Name, pmFeeHistoryPM, it will be used to set a flag 
field in the Model Designer (MoD).
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Step 2- Setup the Custom Control in the MoD

The Custom Control in this example will be used to display query results. 
These results will be in a separate tabbed area within the Building Permits tab 
of the Building Permits OpenForm. We first need to create a tab called Fee 
History.

When working with tabbed forms, when you click at the Cell level, in the 
Property Explorer, under the Misc heading, there can be three (3) settings for 
the Zone View Mode flag:

• Table - This setting, is not recommended for embedding the Custom 
Control; results will not be displayed correctly and the preset contents of 
the tab will not be legible.

• OneByOne - If this is the setting, when inserting the custom control, 
ensure that it is the last item in the list of entities, i.e. it should appear at 
the bottom of the list (C).

• Divider - A flag setting of Divider is the ideal setting.

To create the tab in the Model Designer (MoD)...

In the Model Designer (MoD)...

1. In the center pane, click at the Cell level (A).

Note: Refer to the Govern Model Designer (MoD) release 5.0 user guide for 
additional details about the Business Model (BM) flag settings.
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2. On the right hand side in the Property Explorer pane (B) click to expand 
the Dividers flag; increase the Count flag by one (1). The extra one will be 
the additional tab that the results grid will be embedded in.

3. Click Save to save the change

You will note that after the save, a new flag called Divider “X” has been 
created, where “X” is the previous number of dividers plus the one 1 that was 
added. For example if the previous number of dividers was 3, the newly 
generated divider flag name will be Divider 4.

4. Enter the name Fee History in the Divider 4 field (2), this will be the label 
of the tab.

5. Return to the center pane and right click Building Permits at the Cell level; 
select Add custom control, from the floating menu.

6. Locate the newly created Custom Control entry and click to select it.
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7. On the right hand side in the Property Explorer pane modify the controls 
flags as follows:

Section Flag Name Settings Comments

defaultaccessrights CanExecuteLogExp

Misc DividerTabSequence 4 Tab number that custom 
control grid will appear in

Action Settings (...)

Assembly Name WPFCustomControl.dll

Class Name ViewQuery

Method Name LoadQuery Method indicating that an 
embedded grid is to be used

Embedded Image Icon_ActionButns Image for button

External Image

Is Alone True

Is Overlapped False

In New Row True

First Row True

In New Column True

First Column True

Is Always Visible True

ToolTip Fee History Tool tip description of button

Width 600 Display width of popup

Height 400 Display height of popup

Left 0

Top 0

Start in New Window False Indicates that new window is 
required

OpenInModalWindow False Will open as a popup

Will Be Closed False

Will Be Opened False

Arguments
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8. Click Save to save the modifications that have been made to the Model.

The OpenForms Model has been modified, you will need to go to the Govern 
Security Manager (GSM) and select Synchronize All. 

Step 3 - Synchronizing in the GSM

In the GSM...

1. Click Synchronize All. 

2. Close the application.

Return Property

Return Property

Special Feature None

Query pmFeeHistoryPM Name of query to be run - 
taken from GNA

Report

Connection

Activate Force 
Refresh

False

Call Without Data False

Show Label False

To Be Audited False

Label Text Fee History Label for the window

Section Flag Name Settings Comments
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Step 4 - Review and Test in MS Govern.NET

After the synchronization in the Govern Security Manager (GSM), the control 
can be displayed in MS Govern.NET.

In MS Govern.NET...

1. Open the Land Management profile.

2. Perform a property search; open a record.

3. Double click on the Building Permits OpenForm. 

4. You will note the presence of the Fee History tab.

5. Click to select the tab, you will see the embedded Fee History grid.

6. Click the button; a popup window titled Fee History is displayed with the 
results of the pmFeeHistoryPM SQL query.

The contents displayed in the grid are the results of the query that is 
associated with the custom control. Unlike the popup window, the results are 
permanently displayed. Other SELECT queries may be substituted.

Troubleshooting Queries

During the development of queries, it may be necessary to determine why the 
designed query is having performance issues, i.e. taking too long to run, or 
causes the system to “hangs”. In Govern there are trace logs built in the 
system that can be enabled to assist in troubleshooting. Refe r to Diagnostic 
Configuration form Trace Log on page 424 for details.
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System Validation Table Editor

Maintain the System Validation Tables in this form. These tables are used to 
validate the information entered in the various fields. Create and maintain the 
elements of the tables on the Validation Codes form.

To access the System Validation Table Editor, in the Govern New 
Administration (GNA):

1. Select Editors (tab) > System Validation Table Editor...

WARNING: System Validation tables are never to be in any way modified or 
deleted unless directed by Govern Technical Support. Modifications to 
System table can lead to severe damage to the application.  With an 
understanding of the implications, users are free to modify User 
tables.

Overview
© 2014 MS Govern Page 253



Govern New Administration (GNA)
System Validation Table Editor Command 
Buttons

New: Click New  to create a new System Validation Table.

Save: Click Save  to save any changes to an existing validation table or to 
save a new table.

Delete: Click to select an existing Validation table from the List of Validation 

Table list on the left hand column; click Delete  to delete the table.

Securable: Select Securable to enable administrators to secure the codes 
within the validation table. Refer to the Vertical Security section of the GSM 
release 4.6, or later guide.

Codes: Click Codes to access the code editor for the validation table.

Closing the Editor

To close the editor, click the close window button in the upper right hand 
corner of the form..

System Validation Table Editor - Properties Tab

List of Validation Table: This column contains the list of the existing 
system validation tables; newly added tables will appear in this list.

Note: When you click on New, the button changes to Cancel  ; this will 
allow you to cancel the creation of the current record. The Cancel 
button is present until the new record is saved.
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Table Name: This field displays the name of the table. Use a descriptive 
name such as acctNum for Account Number. Table names can be a maximum 
of eight characters.

English / French Description: Use these fields to enter a brief description 
or title for the table.

Creating a System Validation Table

To create a new validation table...

1. Click New to clear the form fields.

2. Enter a Table Name.

3. Enter an English Description and a French Description in the description 
fields.

4. Click Save to create a new System Validation Table.

After the save, the new system validation table is added to the list column on 
the left hand side. To add codes to the new table, click Code, and follow the 
steps for Adding a System Validation Table Code on page 255.

Adding a System Validation Table Code

To add codes to a new validation table:
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1. Either follow the steps above to create a new system validation table, or 
select an existing table from the List of Validation Table column on the left 
hand side (1).

2. Click Codes to display the Code Editor form.

3. Click New (A) to clear the forms fields for a new code entry.

4. Enter a Code Name (1); enter English Short and English Long 
Descriptions, and any other 2nd language descriptions in the required 
fields (2).

5. Click Save (3).

Note: When you click on New, the button changes to Cancel  ; this will 
allow you to cancel the creation of the current record. The Cancel 
button is present until the new record is saved.
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User Validation Table Editor

Maintain the User Validation Tables in this form. These tables are used to 
validate the information entered in the various fields. Create and maintain the 
elements of the tables on the Validation Codes form.

To access the User Validation Table Editor, in the Govern New Administration 
(GNA):

1. Select Editors (tab) > User Validation Table Editor...

User Validation Table Editor Command Buttons

New: Click New  to create a new System Validation Table.

Overview

Note: When you click on New, the button changes to Cancel  ; this will 
allow you to cancel the creation of the current record. The Cancel 
button is present until the new record is saved.
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Save: Click Save  to save any changes to an existing validation table or to 
save a new table.

Delete: Click to select an existing Validation table from the List of Validation 

Table list on the left hand column; click Delete  to delete the table.

Securable: Select Securable to enable administrators to secure the codes 
within the validation table. Refer to the Vertical Security section of the GSM 
release 4.6, or later guide.

Codes: Click Codes to access the code editor for the validation table.

Closing the Editor

To close the editor, click the Close Window button in the upper right hand 
corner of the form.

User Validation Table Editor - Properties tab

Table Type: The Table Type is system-generated and is used, as follows:

• R: Regular
• A: Accounts / Receivable
• C: Property Control (for multimedia and zoning information)
• B: Property Control (for the Property Area function)
• M: Mass Appraisal
• P: Permits and Inspections
• S: Super User
• T: Tax: Aircraft, Boat, Motor Vehicle, Personal Property and Real Property
• U: Utility Billing

All tables created with the User Validation Table form are automatically 
assigned the Regular table type.
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List of Validation Tables: This column contains the list of the existing 
system validation tables; newly added tables will appear in this list.

Table Name: This field displays the name of the table. Use a descriptive 
name such as acctNum for Account Number. Table names can be a maximum 
of eight characters.

English / French Description: Use these fields to enter a brief description 
or title for the table.

Creating a User Validation Table

To create a new user validation table...:

1. Click New to clear the form fields.

2. Enter a Table Name.

3. Enter a description in the Description fields.

4. Click Save to create a new User Validation Table.
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Adding a User Validation Table Code

To add codes to a new or existing validation table:

1. Either follow the steps above to create a user validation table, or select an 
existing table from the List of Validation Table column on the left hand side.

2. Click Codes to display the Code Editor form.

3. Click New to clear the form fields.

4. Enter a Code Name; enter Short and Long Descriptions, and any other 
second language descriptions in the required fields.

5. Click Save.

Deleting a User Validation Table Code

To delete a Validation Table code...:

1. Either follow the steps above to create a new user validation table, or 
select an existing table from the List of Validation Table column on the left 
hand side.
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2. Click Codes to display the Code Editor form.

3. Select an existing code from the List of Codes column on the left hand 
side.

4. Click Delete; a dialog box will appear to confirm the deletion. 

5. Click Yes.

A Note about Validation Table Codes in the GNA

When  the Verify the Existence, and Creation of Database Object process is 
run in GNA, the Govern user validation tables; i.e, the tables that are preceded 
by VT_USR_ in the Govern database are transferred to a single VT_USER 
table. During this process all codes are also transferred. Note that there is no 
process to copy the codes for User Validation tables that are created in GNA 
to Govern for Windows.

Permit Type Validation

In the Code Editor, it is possible to configure the system to apply a name type 
validation. This validation or filter is based upon the permit type that is being 
created. By default, when linking a name type, regardless of what permit type 
is being selected the system will display all name types. This applies to linking 
a name to a Complaint/Greivance/Request For Service/Workflow, Offence/
Violation, or Permit/License/Certificate permit type in Govern.NET.  When 
there are many name types in the list, the searching process for the name type 
can be tedious. When the validation filter is used, only the name types that 
apply to the permit type is displayed.

Permit Types that can be filtered are as follows:

• Complaints/Workflows/Grievance/Request for Services
• Offences/Violations
• Permits/Licenses/Certificates
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To apply a filter to a name 
type...

1. In GNA select Editors 
(tab) > User Validation 
Table Editors.

2. In the User Validation 
Table Editor (A), under 
the List of Validation 
Tables look for Name 
Types (1).

3. Click Codes, to display 
the Code Editor.

4. In the Code Editor, select 
a code from the List of 
Codes column on the left 
hand side. 

5. Under the Permit Type drop down menu, select the permit type that the 
code will be filtered by (3).

6. Click Save  on the tab.

Now in MS Govern.NET, when making a link to a permit type that matches the 
filter, only the filtered name types appear in the list.

Note: When no Permit Type filter is applied in GNA, the name type will be 
visible for all Permit Types.
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Data Mapping Editor

When an external application, e.g. a GIS application, is required to 
communicate with the Govern system, it will need to understand how data is 
stored within the system. Govern’s Web service methods accept requests, to 
Retrieve, Update, or Delete data.

The Data Mapping Editor allows users to map specific tables and columns 
within the Govern database to unique Data Element Names. When the 
application makes a request from Govern, the data element names must be 
included in the methods that are sent to the Web services.

There are specific rules that are required when making a request to the Web 
Service, e.g. the Data Element Name of the data map must exist, or the parcel 
ID requested must exist in the database, etc. Refer to the MS Govern Property 
Control System Service API guide for the list of methods and file structure 
details. 

There are three (3) tables in the Property Control section that can currently be 
updated, (Table: PC_AREA, PC_PARCEL, and PC_LEGAL_INFO). 

To access the Data Mapping Editor...

1. In GNA select Setups/Editors > Editors > Data Mapping Editor... 

Overview
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Data Mapping Editor Command buttons

New: To create a new  data mapping record click New. 

Cancel: Use Cancel to cancel the creation of an new entry. The Cancel 
button replaces the New button a save of the entry is made.

Save: Click Save to save a new record or any changes to an existing record. 
New records will appear under the List of Data Mappings column on the left 
hand side of the editor.

Delete: After selecting an existing mapping record from the List of Data 

Mappings list on the left hand column, click Delete  to delete the record.

Data Mapping Editor parameters

Choosing Data Element Names

The names that are used for Data Elements must ensure that no Special 
Characters or Reserved Keywords are used. Refer to Govern Keywords on 
page 158 for a list of keywords that should not be used.

Oracle Users and Data Element Names

Due to the case sensitivity of table names, a convention of all Uppercase or all 
Lowercase names should be decided upon. Do not use any Oracle Keywords 
for Data Element Names.

Data Element Name: Specify a Data Element Name for the mapping 
record. This is a unique name that must be included in the request from the 
external application to the Web service. 

Enter a descriptive name for the mapping record that will be used in the 
following parameters:

Note: This field has a maximum of 15 characters; no special characters or 
spaces are allowed.
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English Short Description: Enter a short description for the mapping 
record. This is useful for fast data entry and look-ups if space is limited on the 
forms.

English Long Description: Enter a long description for the mapping 
record. This will be displayed for look-ups on forms and is normally used for 
reporting.

Second Language Fields

When there is a 2nd language, or multiple languages, ensure that these 
description fields are also completed; i.e. French Short Description, and 
French Long Description

Table Name: From the drop down menu, select the name of the Govern 
table that the data will be mapped to. Available tables are:

• PC_LEGAL_INFO
• PC_AREA
• PC_PARCEL

Column Name: The table columns that are listed are filtered according to 
the table that is selected in the Table Name parameter.

Creating a Data Map record

To create a data map record, use a Data Element Name that will be 
acceptable to the requesting external application. This name will be used in 
the method that will be sent to the Web service.

1. In GNA, select Setups/Editors > Editors > Data Mapping Editor...

2. Click New in the Data Mapping Editor.

3. Locate the parameter called Data Element Name; enter the Data Element 
Name.
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4. If not expanded click the expansion arrow  (A) to display the additional 
parameters in the form; complete the parameters..

5. Select a table from the Table Name drop down menu. 

6. Choose a column name within the table that was selected.

7. Click Save to save the mapping record to database.

When the external application makes a request to the web service, if the Data 
Element Name is in the method, the data will be retrieved, updated or deleted 
from the Govern database.

Testing a Web Service Request

As an example, we want to make a request that will obtain the tax map and the 
zoning information of the following Parcel ID’s, 16800, 16804, and 16807. This 
can be done in three (3) steps.

STEP 1 - Create the data mapping records

It is necessary to create the data mapping records for the elements that will be 
called in the method structure. For our example we will be using the 
pcTaxMap and areaZoning elements.

1. In GNA select, Setups/Editors > Editors > Data Mapping Editor...

2. Click New, to create a new Data Mapping Record.

3. Enter a Data Element Name of pcTaxMap.
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4. Click to expand the fields and enter an English Short and Long 
Description; enter PC Tax Map as a description.

5. The tax map information will be coming from is the PC_AREA table in the 
ZONING column; select PC_PARCEL for the Table Name, and TAX_MAP 
for the Column Name.

6. Click Save to save your mapping record.

Repeat the above steps to create the areaZoning data element. Use PC Area 
Zone as the description. The Table Name and Column Name are PC_AREA 
and ZONING

STEP 2 - Create the XML request structure

Refer to the Service Contract section of the MS Govern Property Control 
System Service API guide; this will provide you with the expected structure of 
the MSGovern_GetElementValue function. From the guide we obtain the 
following information:

Function MSGovern_GetElementValue (
ByVal strXmlElement As String ) As String
The retrieve elements must in structure of xml:
<?xml version="1.0" encoding="utf-8"?>
<getElementValue>
<ParcelIds>
<ParcelId value="16800"/>
<ParcelId value="16807"/>
<ParcelId value="23452"/>
</ParcelIds>
<ElementItems>
<ElementItem name="areaZoning"/>
<ElementItem name=" areaSchDist "/>
</ElementItems>
</getElementValue>

For our example we will use the following...

<?xml version="1.0" encoding="utf-8"?>
<getElementValue>

<ParcelIds>
<ParcelId value="16800"/>
<ParcelId value="16804"/>
<ParcelId value="16807"/>

</ParcelIds>
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<ElementItems>
<ElementItem name="pcTaxMap"/>
<ElementItem name="areaZoning"/>

</ElementItems>
</getElementValue>

The Parcel ID’s that we are requesting are specified within the <ParcelIds> 
tags. our Element Items are specified within the <ElementItems> tags. Note 
that the names are identical to what was specified in GNA in STEP 1 above.

STEP 3 - Validate the XML request with the Test Client

Locate the WcfTestClient.exe application that is included with the WCF PC 
Web Services package. This program is usually located in a folder called Test 
Application. Refer to the MS Govern Property Control Service Setup and 
Configuration guide for details about using the test application. 

1. Start the test application; add the WCF Service.

2. On the left hand side, under the list of available methods in the service, 
locate the MSGovern_GetElementValue() method.

Note: Verify that the XML structure is identical to specifications in the MS 
Govern Property Control System Service API document.

Always ensure that the Element Item name is identical to the one 
created in GNA. 
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3. Double click on the method to load it in the Test Client.

Note: A limitation of the supplied test client is that Return characters and 
Line feeds are not recognized.  These characters must be manually 
removed in the editor. 

As an example, the following formatting will become a single line when 
the returns and line feeds are removed.

<?xml version="1.0" encoding="utf-8"?>
<getElementValue>
   <ParcelIds>
      <ParcelId value="16800"/>
      <ParcelId value="16804"/>
      <ParcelId value="16807"/>
   </ParcelIds>
   <ElementItems>
      <ElementItem name="pcTaxMap"/>
      <ElementItem name="areaZoning"/>
   </ElementItems>
</getElementValue>

becomes...

<?xml version="1.0" encoding="utf-
8"?><getElementValue><ParcelIds><ParcelId value="16800"/
><ParcelId value="16804"/><ParcelId value="16807"/></
ParcelIds><ElementItems><ElementItem name="pcTaxMap"/
><ElementItem name="areaZoning"/></ElementItems></
getElementValue>

The above is only a charateristic of this test client; other clients may 
differ in behavior.
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4. Copy the single line version of your XML code and paste it into the Value 
field in the Test Client.

5. Click Invoke; any errors will be displayed in a dialog box.

6. When the action is successful, a response is displayed in the Response 
pane of the Test Client.

Viewing the Results

In the Test Client, the request and response parameters can be displayed in 
two (2) modes, Formatted, and XML. You can switch between the two views 
with a click on the corresponding tabs along the bottom of the Request pane. 
When you are in XML mode results from the successful requests to the 
Service can be observed. 
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Batch Process Definitions

This section describes the GNA Batch Process Definitions form. Use this form 
to define how you want your batch processes to appear and run in 
Govern.NET. This includes setting up the menus and submenus for organizing 
your batch processes, configuring whether each process is run on a single 
server or on multiple servers, associating one or multiple reports, and finally 
synchronizing the batch process definitions and adding permissions. 

When complete, the batch processes are displayed in Govern.NET as in the 
following screen shot: 

This procedure has two major steps:

•  Configuring Batch Process Definitions on page 273
•  Adding Batch Processes Definition to Govern on page 290 

Overview
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Configuring Batch Process Definitions

This section describes the following topics:

• User Interface
• Creating a Category on page 277
• Deleting a Category on page 279
• Selecting a Category on page 280
• Defining a Batch Process on page 284
• Defining the Transaction Type on page 286
• Defining the Transaction Mode on page 287
• Adding a Report on page 287
• Deleting a Batch Process Definition on page 289

Batch Process Definitions User Interface

This section provides a tour of the Batch Process Definitions UI. The interface 
is comprised of a treeview, the definition form, and a secondary window for 
creating the menus and submenus or categories. 

To access the Batch Process Definitions form:

1. Launch Govern New Administration (GNA).

2. Select Batch Process > Definitions.

Overview
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About the Treeview

Once you create menus and define batch processes, the selected items are 
listed in a treeview on the left of the form. You can display or hide the treeview 
according to your preference.

To hide the treeview:

Click the drop-down arrow ; Then, select Auto hide from the 
context menu:

Click the Pin . When it is in a horizontal position, the 
treeview is in the Auto Hide position. 
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To display the treeview in the default position on the left of the interface, do 
one of the following:

• Select Dockable from the menu.
• Click on the Batch Processes Definitions tab on the left of the form.

• Click the Pin to change it to a vertical position .

About Batch Process Definitions

You can view, add, or modify a batch process definition, as described later in 
this section.

To display or hide the English and French long and short descriptions, click on 

the arrow beside the text box at the top of the form.
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About the Menu Manager

The Menu Manager form is used for creating the menus and submenus for 
organizing your batch process definitions in Govern.NET.

To access the Menu Manager

1. Launch Govern New Administration (GNA).

2. Select Batch Process > Definitions.

3. Click the ellipsis button  beside the Category text box.

If categories are already created, they are listed on the left. You can expand a 
category to view secondary levels if they exist. The name of selected menu is 
displayed on the right. You can expand the name to view the English and 
French short and long descriptions.
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Creating a Batch Process Category

The first step is to create categories for your batch processes. The categories 
are used for displaying the batch processes in the Govern .NET menu. Create 
as many categories as required in order to facilitate user input.

To create a Batch Process:

1. Launch Govern New Administration (GNA).

2. Select Batch Process > Definitions.

3. Click the ellipsis button  beside the Category text box. This opens the 
Menu Manager.

The Menu Manager is used for creating categories for the batch 
processes. You can have multiple levels. For example, you could group 
batch processes by module, such as: Accounts / Receivable, Tax Billing, 
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and Mass Appraisal. Then, you could add another level that groups 
processes according to when they need to be run; i.e., daily, monthly, or 
yearly. You can create any type of category that is useful for your 
organization.

4. Enter a name for the category in the text box at the top right. This is 
automatically added to the English Long Description field. 

5. Click the button to the left of the text box where you entered the 
category name. This expands a menu with additional descriptions.

6. Add an English Short Description and French Short and Long 
Description as required. These fields are optional.

7. Click Save  to add the category to the menu.

If you click the Select button without saving your new category, the 
following confirmation message appears:
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Deleting a Menu Category

To delete a menu category from the Menu Manager:

1. Launch Govern New Administration (GNA).

2. Select Batch Process > Definitions.

3. Click the ellipsis button  beside the Category text box to open the 
Menu Manager.

4. Expand the applicable menu.

5. Select the category from the Menu list on the left.

6. Click the Delete button  in the menu at the top right.
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The following confirmation message appears:

7. Click Yes to delete the record.

Selecting a Category for the Batch Process

You need to define the processes under the categories to which they are 
assigned and will appear in Govern.NET. Before defining a batch process, 
select the menu category where it will be saved. 

To select a Batch Process:

1. Launch Govern New Administration (GNA).

2. Select Batch Process > Definitions.
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3. Click the ellipsis button  beside the Category text box to select the 

category for the batch process. This opens the Menu Manager.
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4.
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5. Expand the root menu to display the submenus.

6. Select the applicable submenu or category.

7. Click the Select button . 
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The root menu and all submenus are displayed in the Category text box 
and in the Parent Path text box. The existing batch processes are listed 
on the left.

Defining a Batch Process

Use the following process to name the definition and to associate it with a 
Govern Batch process.

To define a Batch Process:

1. Select the category where you are defining the process as described 
under Selecting a Category for the Batch Process on page 280.

Note: You need to define the processes under the category to which they are 
assigned and will appear in Govern. 
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The batch processes already defined for the category are displayed in the 
treeview on the left.

2. Click the New button . 

3. Enter a code for the new batch process definition. This is a required field.

4. Select a Govern batch process from the Process drop-down list. This is a 
required field.

5. Enter a name for the record in the text box at the top right. This is 
automatically added to the English Long Description field. 

6. Click the button to the left of the text box where you entered the name. 
This expands a menu with additional descriptions.

7. Add an English Short Description and French Short and Long 
Description as required. These fields are optional.

8. Click the Save button to add the category to the menu.
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If you click the New button without saving your modifications, the following 
confirmation message appears:

Defining the Transaction Type

The Govern batch processes can be run synchronously or asynchronously. If 
they are run synchronously, they are run on the same server. If run 
asynchronously they are run on multiple servers at the same time. 

Select Synch or Asynch as required. For processes with multiple 
transactions, it is recommended to use asynchronous processing as this 
spreads the load over multiple servers and makes for faster processing time.

Pool #: For Asynchronous processes only, enter the maximum number of 
transactions to be handled by the client servers at any one time. 

This works as follows: If you are running asynchronous batch processing, 
there is one master server that manages all the transactions and is 
responsible for sending them to the client servers. The value In the Pool # field 
indicates the maximum number of transactions to send out by the master 
server at any one time.

Scenario: Running a Batch Process Asynchronously

The following scenario illustrates how asynchronous batch processing works. 
The parameters are as follows:

• Master server: one
• Client servers: five
• Transactions: 50,000
• Pool #: 50

The master server sends out the first 50 transactions to the client servers. 
Each server is responsible for ten transactions. As soon as a server completes 
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one transaction, the master server sends it another. This continues until all 
transactions have been processed. However, there are never more than 50 
transactions being handled by the client servers at any given time.

Defining the Transaction Mode

Select one of the following transaction modes for the process.

• Break If One Transaction Failed: the process terminates when the 
transaction fails. 

• Roll Back If One Transaction Failed: the process terminates when a 
transaction fails and all the transactions that were completed are 
cancelled. Computations are returned to the starting point.

• Continue If One Transaction Failed: Continue to run the process even if 
a transaction fails.

Adding a Report

Use the following procedure to associate one or more reports with the 
selected batch process.

To add a report: to the batch process:

1. Launch the Batch Process Definitions form.

2. Select the category for the process as described under  Selecting a 
Category for the Batch Process on page 280.

3. Select the batch process from the treeview on the left.

4. Click Add Reports. 
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5. Select one or more reports from the Choose the Reports menu. 

6. Click Select Reports.

Tip: You can select multiple reports using the left mouse button.
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The selected reports are displayed in the List of Reports text box. The 
parameters for the report are displayed in the Report Parameters list box.

The List of Parameters text box displays the parameters that can be included 
in the report and that can be used to build an external report; for example, 
these could include Date To and Date From fields. The purpose is to give you 
the exact reference and wording of these fields. 

Deleting a Batch Process Definition

To delete a batch process:

1. Launch the Batch Process Definitions form.

2. Select the category for the process as described under  Selecting a 
Category for the Batch Process on page 280.

3. Select the batch process from the treeview on the left.

4. Click the Delete button . 
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Adding Batch Processes Definition to 
Govern

When you have defined your batch processes, you need to add them to 
Govern.NET. In order to do this, you need to launch the Govern Security 
Manager and synchronize your new processes between GNA and 
Govern.NET. Then, you need to assign access permissions.

Synchronizing Batch Process Definitions

When you have synchronized your new batch process definitions, they appear 
on the Govern.NET menu.

To synchronize the new batch processes:

1. Launch the MSGovern Security Manager (GSM). 

2. Select your database connection key.

Overview
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3. Right-click on Applications and select Synchronize menu from the drop-
down list. A confirmation message appears.

4. Click Yes on the confirmation message.

Granting Permissions to Batch Processes

Use the following procedure to assign access permissions to the new batch 
process definitions. You can grant permissions by batch process, batch 
process menu, or by batch process definition. 

1. Launch the MSGovern Security Manager (GSM). 

2. Select your database.

3. Expand Applications > MSGovern.NET > Batch Process > Batch 
Process. 

4. Continue to expand the menus until you are the level where you want to 
grant permission.

5. Right-click on the item that you want to secure.

6. Define the permissions and exclusions as required and as described in the 
Govern Security Manager guide.
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GNA Utilities

The Govern New Administration (GNA) contains system administrative tools, 
data import and export tools, and database maintenance utilities.These 
programs are software routines and utilities used to configure and maintain 
databases for Govern applications. 

Database Utilities

Release 6.0 of the GNA consolidates processes that were available as 
separate utilities in previous releases. The following are overviews of their 
uses.

Active Directory Integration Tool

The unidirectional Active Directory Integration Tool allows for the importation 
of users from Active Directory into Govern’s user database. Once imported 
into Govern, administrators can then manage which forms and functions users 
will have access to through Govern’s Administration program. See Importing 
Active Directory Users into Govern on page 335

Connection Key Management

This form is used to create or modify the parameters for a Connection Key. 
This form allows you to specify required parameters, access credentials, and 
any additional parameters required. See The Connection Key Management 
form on page 340

Overview
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This form allows you to change the default parameters found in the 
Connection Key General Parameters Management form. See Connection Key 
General Parameters Management on page 345

Country Corrections in NA_NAMES table

This process is required to clean up the text field used in early versions of 
Govern for Windows. See Country Corrections in NA_NAMES table on 
page 368

Database Utilities
• Database Verification - The Database Verification is a process that 

should be run after defining the database connections and configuring 
your Web sites with GNA. Run this process to verify that these objects are 
present. This process can be run, for example, whenever new tables are 
added to the Govern database or when a database object becomes 
corrupted. See Processing a Database Verification on page 297 for 
details. Within the process are the following subprocesses; note the two 
(2) that are optional.

• Creating Govern System Stored Procedures - This process is to 
be run only upon the recommendation of your Govern Support 
representative. A situation that would warrant the use of this process 
would be when performing a major upgrade. 

• Verifying Database Objects - The Database Verification process, 
when first run, required database objects are loaded. You can run 
Verify Database Objects Existence to update the database. The only 
difference between this option and the Database Verification option 
is that this option does not include the test to verify the location of the 
VT_USR and VT_SYSTEM tables. See Verifying Database 
Objects on page 309.

• Rebuild VT System Table (OPTIONAL) - In running the Database 
Verification, the VT_SYSTEM table is created and all Govern’s 
System Validation (VT_SY) tables are copied to it. You can run this 
process separately, as required. An example of use is when VT_SY 
tables are added to the Govern database. See Verifying Database 
Objects on page 309.

• Rebuild VT User Table (OPTIONAL) - When you run the Database 
Verification process, the VT_User table is created and all Govern’s 
User Validation (VT_USR) tables are copied to it. Running this 
process will rebuild the VT_User table. You can run this process 
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separately, as required. See Rebuild the VT_USER Table from 
VT_USR on page 304.

• Verify VT_USR Table Indexes (SQL Server Only) - When 
transferring all VT_USR_XXX table to the .NET VT_USER table, or 
performing a database upgrade with Updata, indexes may be lost 
during the procedure. Lost indexes can be recreated with the 
Verifying VT_USR Table Indexes Existence (SQL Server Only) 
process. See Verifying VT_USR Table Indexes (SQL Server 
Only) on page 305.

• Recompile Database Objects (Oracle Only) - Database upgrades 
can invalidate schema objects. This process will recompile invalid 
schema objects. See Recompile Database Objects (Oracle Only) on 
page 305.

• Create Govern System Stored Procedures - The Govern system 
requires a minimum set of basic procedures to be present in the database, 
in order to access and manage current, and future stored procedures. 

This procedure must be run at least once in order to build the tables that 
are required to access Govern’s System Stored Procedures. See Deleting 
All MS Govern Stored Procedures on page 307

• Create only Tables needed for Dynamic Search Component - This 
process is to be run only by users that are already using Web components; 
configuration information will be migrated to new tables while preserving 
old settings. See Deleting All MS Govern Stored Procedures on page 307.

Use of Upper and Lowercase when Naming 
Database Tables

Users of Govern for Windows and OpenForms should note the following; the 
SQL database used in Govern for Windows has no issues with naming 
database tables with uppercase or lowercase characters. In openForms, all 
tables must be in uppercase characters. When there is a conversion process 
from Govern for Windows to OpenForms, any tables with lowercase 
characters are automatically converted to uppercase. In a conversion, what 
needs to be considered are tables names from external sources, e.g. Marshall 
& Swift. For a SQL database, when these external source table names are 
converted from lower to uppercase for OpenForms, there are no issues. 
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Oracle users should note that the same type of conversion mentioned above 
will result in duplicate keys. This is identified when performing the Verify 
Database Objects Existence process. See Verify Database Objects on 
page 300.

Sample Script to Identify Lower Case Table Names

To avoid any issues, verify that table names are in uppercase. The following 
script can be run to identify any lower case table names in external database 
sources:

SELECT DISTINCT(UPPER(TABLE_NAME))
FROM VT_USER
WHERE TABLE_NAME=LOWER(TABLE_NAME)

When tables with lowercase names have been identified, users can then 
create and run their own custom script to change the lowercase characters 
into uppercase.
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Import / Export Tools

The Import / Export Tools submenus contains the tools that can be used for 
customizing new databases. This can include preparing mobile databases, 
copying database structures, or updating OpenForms profiles from a 
reference database.

• Copy Database Table Structure - After creating an empty database that 
will be used for a mobile deployment, this process will copy the structure of 
the master database to the mobile database. This process should be run 
for empty, newly created databases. See Initialize Mobile Database on 
page 311.

• Initialize Mobile Database - The Provision Mobile Database process is 
used to remove synchronization objects, i.e. triggers and tracking tables. 
In addition to this, the process checks to see whether required database 
objects, exist in the mobile database so that there are no errors when 
provisioning an existing database. See Initialize Mobile Database on 
page 311.

• Initialize OpenForms Environment - The Initialize OpenForms 
Environment process is used principally to transfer OpenForms™ models 
from one database to another. This refers to all OF_XXX type tables. This 
process can be used to duplicate the OpenForms profiles from one 
database to another. 

• Export Data to File - The Export Data form is used to export content from 
a specified database to an .XML file. See Export Data to File on page 315 
for details.

• Import Data from File - The Import Data form is used to import content 
from an XML data file into a database. See Import Data from File on 
page 329 for details.

Overview
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Processing a Database Verification

The following is a list of the Database Objects that are updated:

• System Stored Procedure
• Miscellaneous Corrections
• Tables
• Post System Stored Procedures
• Sequences (Oracle Only)
• Columns
• Indexes
See  Verify Database Objects on page 300 for details.

• Copying all VT_SYSTEM Table Records

Overview

Note: You need to run the Database Verification process after defining the 
database connections and configuring your Web sites. This updates 
your databases so that they can be accessed by the Govern 
OpenForms™ applications.
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• Copying all VT_USER Table Records.
• Views - This process will create the standard virtual tables or “Views” that 

are required by select OpenForms.
• Post Miscellaneous Corrections. See Miscellaneous Corrections on 

page 301.

To access this process:

1. In GNA select the Utilities tab.

2. In the Database Utilities group, select Database Verification...

3. In the form, click Start to begin the process,

This process can be run repeatedly to verify that the database objects 
mentioned above are present. This could be done for example, whenever 
tables are added to the Govern database or when a database object becomes 
corrupted. You can alternate the running of this process with the Verify DB 
Objects Existence process. See Verifying Database Objects on page 309.
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System Stored Procedures

Stored procedures are subroutines that are available to applications accessing 
a relational database. Stored Procedures are automatically created, in 
Govern, when the user performs a search or modifies a table by updating, 
inserting or deleting a record. 

In order to be able to access and manage the database, a minimum set of 
basic procedures must be present in the database to access and manage 
current, and future stored procedures. 

The Create MS Govern System Stored Procedures option is incorporated 
during first time access to the database to create a required minimum set of 
procedures. This procedure must be run at least once in order to build the 
tables that are required to access Govern’s System Stored Procedures. This 
process prepares the database by creating tables such as Sy_Gov_Sel_Sys.

To access this process:

1. Select Utilities (tab) > Database Uitlities > Database Verification

2. When complete, click Exit.

Overview
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Verify Database Objects
Database Objects are objects that make up a relational database. These are 
objects that are used to store or reference data. Examples of database objects 
are tables, columns, indexes, and stored procedures.

This process creates the following required database objects the first time it is 
run. When the process is repeated, it verifies that the following database 
objects are present:

• System Stored Procedure
• Miscellaneous Corrections
• Tables
• Post System Stored Procedure
• Sequences (Oracle Only)
• Columns
• Indexes
• New VT_SYSTEM Table Records
• New VT_USER Table Records
• Views
• Post Miscellaneous Corrections
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System Stored Procedures

This process creates system stored procedures. These stored procedures are 
required by the Data Access Block (DAB).

Stored procedures are saved to SY_STORED_PROC_LIST and the 
parameters used in the search or modification are saved to the SY_STORED_ 
PROC_PARAM table.

The procedures in SY_STORED_PROC_LIST can begin with the following:

• s_: Select
• i_: Insert
• d_: Delete
• u_: Update

Examples of parameters stored in SY_STORED_PROC_PRM are:

• @na_id: This parameter is equal to the current NA_ID
• @user_id: This parameter is equal to the current user ID
• @internet_acct: This parameter is equal to the current Internet account

Miscellaneous Corrections

The Post Miscellaneous Corrections process performs the following actions:

1. Removes the blank spaces from the CODE column, In the VT_USR_ 
STATE table. All values in this column are state and provincial codes and 
are two characters in length.

2. Creates the records, in the VT_SY_ECOMP_FIELDS table, using a stored 
procedure.

3. Creates records, under the Validation Table Brule heading, in the 
VT_SYSTEM table.

4. Creates records, under the Validation Table LangIdent heading, in the 
VT_SYSTEM table.

5. Creates records, under the Web_PayType heading, In the VT_SYSTEM 
table.

6. Encrypts the nonencrypted number in the CC_CC_WEB table.

7. Updates the codes, under the table <month>, in VT_SYSTEM.
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8. Transfers old column data to new ones.

Tables

For a complete list of the tables that are required for the eProfile and 
eComponents, refer to the MSGDatabaseStructureMods.xml file.

Post System Stored Procedures

This is a correction script, i.e. cleanup procedures, for Govern Stored 
Procedures.

Sequences (Oracle Only)

For Oracle users, this process loads the Sequences required by the .NET 
applications. Sequences are used for generating numbers for autonumber 
fields.

Columns / Indexes

This process will verify the columns and indexes of the database. It ensures 
that columns types are correct, and rebuilds indexes if required.

New VT_SYSTEM Table Records / New VT_USER Table 
Records

When running, these processes will verify any changes in Miscellaneous 
Structure improvement tables.

Views

A SQL View is the equivalent of a Virtual Table. Views are generated as a 
result of a SQL query. When the query is run, the resulting “virtual tables” are 
then referenced like a normal table. This process verifies the presence of 
views that are required by specific OpenForms.

Post Miscellaneous Corrections

This script is a final cleanup process for the Miscellaneous Corrections.
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 Rebuilding the VT_SYSTEM Table

This is an optional process that is part of the Database Verification process. 
In running the Complete Database Check process, the VT_SYSTEM table is 
created and all Govern’s System Validation (VT_SY) tables are copied to it. 
Run this process when new VT_SY tables are added to the Govern database.

To run this and other processes in the Govern New Administration (GNA):

1. Select: Utilities (tab) > Database Utilities > Database Verification.

2. In the Check database Utility form, click the Rebuild the VT_SYSTEM 
table from the VT_SY tables checkbox (A), this will enable the process. 

3. Click Start.

4. When the process is complete click Press this button to close the 
Windows (A)..
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Rebuild the VT_USER Table from VT_USR

This is an optional process that is part of the Database Verification process. 
When first running the Database Verification process, the VT_USER table is 
created and all Govern’s User Validation (VT_USR_XXX) tables are copied to 
it. This sub process can be run as often as required; for example, every time 
user validation (VT_USR) tables are added to the Govern database or when 
converting from Govern for Windows to Govern tables.

To run this and other processes in the Govern New Administration (GNA):

1. Select: Utilities (tab) > Database Utilities > Database Verification.

2. In the Check database Utility form, click the Rebuild the VT_USER table 
from the VT_USR tables checkbox (A), this will enable the process. 

3. Click Start.

4. When the process is complete click Press this button to close the 
Windows (A)..
Page 304 © 2014 MS Govern



Verify Database Objects
Verifying VT_USR Table Indexes (SQL Server 
Only)

This process is part of the Database Verification process. Table indexes can 
be deleted when performing a database upgrade using the Govern Updata 
application. During the process of transferring all VT_USR_XXX tables to the 
.NET VT_USER table, table indexes that may have been deleted would need 
to be re-created. The Verifying VT_USR Table Indexes Existence (SQL 
Server Only) process will verify the existence of any indexes and create the 
ones that are absent.

To access this process:

To run this and other processes in the Govern New Administration (GNA):

1. Select: Utilities (tab) > Database Utilities > Database Verification

2. When the process is complete click Press this button to close the 
Windows (A)..

Recompile Database Objects (Oracle Only)

This process is part of the Database Verification process. When database 
operations such as upgrades, or application of patches are performed, they 
can invalidate schema objects. When complex dependencies are present, it is 
recommended that invalid objects are recompiled in advance of user calls. 
This process will recompile Oracle database objects.

Note: This process applies for Microsoft SQL Server databases only; it does 
not apply to Oracle databases.
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To access this process:

To run this and other processes in the Govern New Administration (GNA):

1. Select: Utilities (tab) > Database Utilities > Database Verification

2. When the process is complete click Press this button to close the 
Windows (A)..

Completing the Process

When all of the above processes are complete, the progress bars are 
completely filled.

Click Press this button to close the Windows (A) to finalize the process and 
close the form.

Note: This process applies for Oracle databases only; it does not apply to 
SQL databases.
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Deleting All MS Govern Stored 
Procedures

This process is part of the Database Verification process. It will delete all 
Govern stored procedures including the basic stored procedures created 
during the “Create MS Govern System Stored Procedures” process. See 
Deleting All MS Govern Stored Procedures on page 307.

To run this and other processes in the Govern New Administration (GNA):

1. Select: Utilities > Database Utilities > Delete All MS Govern Stored Pro-
cedures.

2. Click Start to begin the process. For a description of these objects, see 
Verify Database Objects on page 300

Overview
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3. When the process is complete click Press this button to close the 
Windows (A)..
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Verifying Database Objects

This process is part of the Database Verification process. The database 
objects that make up a relational database are used to store or reference data. 
When the reference database has been updated, Verifying Database Objects 
processes are run to ensure that the latest database objects are updated from 
the reference database.

When this process is run for the first time, it creates the following required 
database objects:

• Stored Procedure Sy_Gov_Sel_Sys
• Tables
• Sequences (Oracle Only)
• System Stored Procedures
• Columns
• Indexes

When the process is repeated, it verifies that the same database objects are 
present, plus any new objects in the reference database.

To run this and other processes in the Govern New Administration (GNA):

1. Select: Utilities (tab) > Database Utilities > Delete All MS Govern Stored 
Procedures.

2. Click Start to begin the process. For a description of these objects, see 
Verify Database Objects on page 300

Overview
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3. When the process is complete click Press this button to close the 
Windows (A)..
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Initialize Mobile Database

Part of the creation of a mobile database is creating an empty database that 
will be used for a mobile deployment, it is necessary to copy the structure of 
the master database to the mobile database. After transferring the structure of 
a master database to an empty mobile database, it is necessary to initialize 
the database by copying the parameters of the Govern master database to the 
mobile database. For example in the case of a mobile database that is 
intended for use by appraisers, the parameters that will be required to fill the 
forms on the mobile system should then be transferred. 

For details about Mobile database installations, refer to the Govern Mobile 
Guide.

To access this process:

Overview

Note: This process should only be run once, after the Copy Database 
Tables Structure process on an empty database. Running this 
process on a database that is being used will result in the destination 
database being overwritten by the source.
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1. In GNA select Utilities (tab) > Import / Export Tools > Initialize Mobile 
Database 

Mobile Database Initialization Tool Command 
Buttons

Start: Click Start to begin the transfer process

Cancel: To end the transfer process, click Cancel. 

Mobile Database Initialization Tool Parameters

Mobile Deployment Name: Select the name of your mobile deployment.

Temporary SQL Database Connection Key: Select the temporary SQL 
database connection key.

Mobile Deployment Connection Key: This menu will contain the list of 
available Mobile Deployment connection keys.
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Shared Folder to Copy DB to: When the mobile database has been 
prepared, this is the shared network location that the database will be copied 
into. 

Source Database Connection Key: Select the connection key that is 
used to access the database that contains the data to be copied.

Tables parameters to group

Before starting the process, you may select/deselect any, or all of the following 
tables.

• Mobile Appraisal (MA_PARM)
• Mobile Auditor
• Mobile Inspections

Copy Tables From group

Starting Year / Ending Year: When a specific year range is to be 
processed for the mobile database, select the available starting years and 
ending year.

Note: The size of some of the tables being processed can be a factor in the 
processing time.

Note: If no Starting Year or Ending Year is specified, all years will be 
processed. If only a Starting Year, or only an Ending Year is selected, 
all years starting with, or up to the selected ending year will be 
processed.
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Processing group

The Processing group will only appear when the process has been initiated. 
Progress can be monitored on the displayed progress bars. When the process 
is complete this group will disappear. 
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Export Data to File

The Export Data form is used to export data structures from a specified 
database to an .XML file. The form allows you to export data settings through 
a step by step drill down process. The process is able to export everything 
from an entire database structure consisting of Modules, Module Elements 
(ME), and Module Element Components (MEC). The export process requires 
the user to select what elements of their database are to be exported. The 
export steps follow the Govern hierarchy. The hierarchy is as follows:

Modules Module Elements (ME) Module Element (ME) Components

Open Form Profile AR, Business Assessment, LM, Name & 
Address, Project Folio, PC, SRT

Open Form (OF) Model e.g. AR, Animal Lic’s, Bldg Permits, etc.

Business Model (BM) List of all BM’s, e.g. CAMA Audit, CAMA Land, 
etc.

Business Entity (BE) All BE’s that are listed in the database

Security List of Security for Existing Roles, e.g. Insert/
Update, Update Only, View Only, etc.
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During the export process, user selections will determine what options are 
presented in the next step. When exporting entities, all required 
dependencies, i.e. tables, are also exported. The resulting exported file can 
then be imported to another database using the Import Data utility, see Import 
Data from File on page 329 for details about this process.

Exporting a Module Element

As an example, an administrator can design a new Profile and then wishes to 
export it. During the export process it will be necessary for them to make 
decisions as to what is to be exported. In their selection a single profile may be 
selected, or all profiles within the database.

System 
Configuration

Dynamic Search Group List of All Dynamic Searches

Dynamic Search Style All Dynamic Search Styles

Constant List of all Constants

Formula All Formulas

Logical Expression List of All Logical Expressions

SQL Queries All SQL Queries

NEW!  Govern 
Tax

Cap Levy Group List of all Cap Levy groups

Levy Group All Levy groups

Levy Code List of Levy codes

Exemption Group All Exemption groups

Exemption Code List of all Exemption codes

SWIS Code All State Wide Information System (SWIS) codes

Averaging Assessment Values List of the Average Assessment Values

Note: Individual user Module Elements and ME Components will vary from 
the above depending on which Govern modules have been purchased 
and licensed.

Modules Module Elements (ME) Module Element (ME) Components
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To demonstrate the steps involved in the export process, a single Profile will 
be exported. During the export, any associated security settings related to 
roles can be selected.

Security and Module Elements 

By default when a profile is selected for export, any securities associated with 
the profile are also exported. However this security is not functional until it is 
associated with user roles. This means that a profile will not be accessible 
until securities relating to roles have been established. A reason to export a 
module or module elements without security might be when new security 
settings are to be established, or have been established in the database that 
the file will be imported into.

Exporting Module Elements without Security...

When new securities for roles are to be defined, then it is not necessary to 
select the Security option for export.

To export Module Elements without security...

1. Open GNA and select Utilities > Import / Export Tools > Export Data to 
File.
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2. In the Export form, Source Connection Key: field, select a Connection 
Key of the database that you will be extracting data from.

3. Look for the Save to: field, click Browse to choose a location and enter a 
file name.

4. Click Save, if the file name exists, you will be asked to confirm overwriting 
it. In the Main group, select OpenForm. Click Next.

5. In the next screen, you will note that the Main group has now changed to 
the OpenForm group. The group label is an indication of the level of the 
export process.

6. Click to select Profile. The Next button will become active; click Next

Note: Unless an export filename is specified,  the Export button will not 
become active, regardless of what selections are made.
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7. In the next form, you are presented with the list of Profiles; select one, or 
click the first check box at the top of the list to select all profiles.

8. Note that the Next button has been changed to an Export button. Click 
Export to generate the file.

The presence of the Export button is an indication of the end of the selection 
process. At any point during this process, you can select Previous to return to 
the last step and modify your selection.

Exporting Module Elements with Security...

The Security option should be selected when securities have already been 
established for a database. Typically a development database and a live 
database are virtually identical, in such instances security settings are also 
identical. When an exported data structure is imported with the same security 
settings, the update to the new database will have securities already set.

To export a data structure with securities...
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1. Follow the above steps from 1 to 4. See Exporting Module Elements with-
out Security... on page 317.

2. Click to select Profile, scroll down the list and select Security. The Next 
button will become active; click Next

3. In the next form, you are presented with the list of Profiles; select one, or 
click the first check box at the top of the list to select all profiles.

4. Note that the Next button remains because other options were also 
selected, i.e. Security. Click Next.

5. The next form displays a Security group that contains the roles that ; 
select the security roles that you would also like to export.

6. Click Export to export the data.

The length of the export process is dependent upon the size and complexity of 
the database. Upon completion of the process, a dialog box is displayed.
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7. Click OK to return to the Export form, if there is another export to be 
performed, click Restart to return to the beginning of the process.

OR

8. Click Exit to close the form.

Locate the newly created file that is to be imported from the Save to: directory.

Exporting an Open Form Model

Follow these steps to export an Open Form Model:
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When the Open Form Model to be exported does not require security, or 
securities are to be added at a later time, do not select the Open Form Model 
with the Security option.

1. Open GNA and select Utilities > Import / Export Tools > Export Data to 
File.

2. In the Export form, in the Source Connection Key: field, select a 
Connection Key of the database that you will be extracting data from.

3. Look for the Save to: field, click Browse to choose a location and enter a 
file name.

4. Click Save, if the file name exists, you will be asked to confirm overwriting 
it. In the Main group, select OpenForm. Click Next.

5. In the next screen, you will note that the Main group has now changed to 
the OpenForm group. The group label is an indication of the level of the 
export process.

6. Click to select Open Form Model. The Next button will become active; 
click Next

7. In the next form, you are presented with the list of Open Form Models 
within the database; select one or more models, or click the first check box 
at the top of the list to select all models.

8. Note that the Next button has been changed to an Export button. Click 
Export to generate the file.

Note: Unless an export filename is specified,  the Export button will not 
become active, regardless of what selections are made.
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The presence of the Export button is an indication of the end of the selection 
process. At any point during this process, you can select Previous to return to 
the last step and modify your selection. The length of the process is 
dependent upon the size and complexity of the database. When the process is 
complete, a dialog box is displayed. 

9. Click OK to return to the Export form.

When there is another export to be performed, click Restart to return to the 
beginning of the process; alternatively, click Exit to close the form.

Locate the newly created file that is to be imported from the Save to: folder.
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Exporting a Business Model or Business Entity

When exporting a Business Model or Business Entity follow the above steps, 
i.e. steps for Exporting an Open Form Model on page 321

Exporting Multiple Modules or Module Elements

Thus far, with the exception of Exporting Module Elements with Security... on 
page 319, we have only exported single Module Elements (ME). Realistically 
we may need to export more than one module element at a time. For example 
if multiple module elements are selected, e.g. the following ME’s:

• Profile
• Open Form (OF) Model
• Business Model (BM)
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For this type of export, there would be multiple stages of user interaction 
before the export option is presented. We wouould need to make selections 
for Profiles, Open Form Models, and Business Models.

To make an export of multiple Module Elements (ME’s)...

1. Open GNA and select Utilities > Import / Export Tools > Export Data to 
File.

2. In the Export form, in the Source Connection Key: field, select a 
Connection Key of the database that you will be extracting data from.

3. Look for the Save to: field, click Browse to choose a location and enter a 
file name.

4. Click Save, if the file name exists, you will be asked to confirm overwriting 
it. In the Main group, select OpenForm. Click Next.

5. In the next screen, you will note that the Main group has now changed to 
the OpenForm group. The group label is an indication of the level of the 
export process.

6. Click to select Profile, Open Form Model, and Business Model. The 
Next button will become active; click Next.

7. The next step would be to select one or more Profiles; select Accounts 
Receivable and Land Management

8. Click Next.
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9. In the Open Form Model group, you will notice that some Models are 
already selected, this is an indication that they were already part of the 
profile selected in the previous step; note that you now have the 
opportunity to deselect them if required. 

10. Click Next.

11. The final prompt will be for selecting Business Models (BM); select a BM.

Note: If you click Previous, you will be returned to the previous screen, but 
you will no longer be able to deselect any selections. 
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12. Note that the Next button has been changed to an Export button. Click 
Export to generate the file.

The methodology that is used for exporting multiple Modules or Module 
Elements applies to both OpenForms as well as System data structures. If a 
user were to export multiple System module elements, e.g. Dynamic Search 

Note: Unless an export filename is specified, the Export button will not 
become active, regardless of what selections are made.
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groups, and Dynamic Search Styles, some Dynamic Search group items may 
be preselected, because they are part of the Dynamic Search Style.
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Import Data from File
The Import Data form is used to import content into a database from an .XML 
file. As with the export process, see Export Data to File on page 315 for 
details, there are a series of interactive steps to allow the user to control how 
data is imported. The import process consist of three (3) stages, Reading the 
File, Comparison of the imported data, Data contention (display of the Data 
Import Status, and resolution of data conflicts).

Data Import Status and Data Conflicts

When a file is selected for import, the .XML data file is parsed; any possible 
conflicts with the existing destination database are displayed in the Collisions 
group in the lower portion of the form. The Data Import Status is displayed in a 
drop down menu..

To import a data file...

1. Open GNA and select Utilities (tab) > Import / Export Tools > Import Data 
from File.

Note: This process is not unlike the Initialize an OpenForms Environment 
utility, the difference is that this process is very granular with the 
information that is exported. In addition, during the import process, the 
user is given the option to over write their existing data. Refer to  
Verifying Database Objects on page 309 for details. 
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2. In the Import form, in the Destination Connection Key: field, select a 
Connection Key of the database that you will be importing data into.

3. Look for the File to import: field, click Browse to locate the data file; 
double-click on the .XML file to import it.

4. Click Start, to begin the process.

The process will begin by reading the XML file. 

Data Import Status options

Options can be selected at various levels of the data import process. When 
selecting one of the options at the start of the process, all subsequent levels 
below will also be set to the chosen option.

Note: There may be a slight delay between the selection of the file and the 
return to the Import screen. The length of the pause is dependent 
upon the complexity of the file being read.

Note: If the file to be imported was created with an older version of the 
Govern New Administration (GNA), it may not be compatible. An error 
message is displayed. In such instances, it may be necessary to re-
export the file using the most recent version of the GNA.

Note: Depending upon the size and complexity of the file there may be a 
period of perceived inactivity; 
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Any conflicts are displayed in the lower portion of the form; the status of the 
data to be imported is presented in one of the status codes indicated below.
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Data Import Status Color Codes

The Import process can be run multiple times. Each time the process is run 
users can selectively choose options that were not imported during the 
previous pass.

Color Code Details

Red System This is an indication that this is a system file. 
This data is reserved for the System and will 
not be overwritten.

NOTE- Data that has been designated as 
reserved for the system, will not be overwritten. 
Selecting the Skip option is non-destructive; 
the Import process can be run again and the 
option to Replace can then be selected.

Orange Replace Data with this tag will be replaced, i.e. 
overwritten with newly imported data.

WARNING - When selecting the check box, be 
absolutely certain that you want to overwrite 
your existing data with the one that is being 
imported; this process is not reversible.

New
(Yellow)

New This is data that is new to the database, when 
selected it will be imported.

Skip
(Gray)

Skip The Skip indicator is an indication that a 
conflict exists, but the data in the target 
database will not be replaced with the incoming 
information. When the check box is selected, 
the indicator will display Replace ; the color will 
be Orange.

NOTE- Choosing to leave the Skip option is 
non-destructive; the Import process can be run 
again and the option to Replace can then be 
selected.
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Completing the import process...

5. After resolving the conflicts by selecting or leaving the checkboxes, click 
Next.

6. When you have gone through all levels for the import, click Import when it 
appears.
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7. When the process is complete, an Import Success dialog box is displayed. 
Click OK to return to the Import form.

When there is another import to be performed, click Restart to return to the 
beginning of the process; alternatively, click Cancel to close the form.
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Importing Active Directory Users into 
Govern

Active Directory (AD) is an implementation of the Lightweight Directory 
Access Protocol (LDAP) directory services by Microsoft. LDAP provides 
central authentication and authorization services for Windows based 
computers. AD is available in Windows Server 2000 / 2003 / 2003 R2 / 2015.

The Active Directory MSGovern Integration Tool will allow you to import users 
from Active Directory into Govern’s user database. This administrative 
process is unidirectional in that users are copied from Windows™ Active 
Directory to Govern’s user table (Table: USR_USERFILE); in addition their 
group designations within Active Directory will be carried over and used to 
determine which one of the four Govern access groups they will be assigned 
to. Once imported into Govern, you can then manage which forms and 
functions users will have access to through Govern’s Administration program.

This process can be run periodically for synchronization purposes, e.g. in 
instances when there have been changes in roles or personnel within the 
organization.

Managing Import of Multi-role Active Directory users

In instances where a user being imported is in multiple roles in Active 
Directory, for example thiscould be a user in an Administrator group, as well 
as a Regular group. After this user is imported into Govern, in the Govern 
USR_USERFILE table, they will only appear once as an Administrator. This is 
the role with the highest permission level that they are a member of.

The Permission hierarchy in Govern, highest to lowest is as follows:

• Super User
• Administrator
• Regular
• Read Only

To display the Active Directory and MS Govern Integration Tools:

1. In GNA click to select the Editors tab.
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2. On the ribbon, click the Profile Editor icon.

To display the Active Directory and MS Govern Integration Tool:

1. Select Utilities > Active Directory Integration Tool...
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Active Directory and MS Govern Integration Tool 
Command Buttons

Process: Click Process to begin importing Active Directory users into 
Govern.

View Log File: Click View Log File to display the contents of the log file.

Exit: Click Exit to close this window.

Active Directory and MS Govern Integration Tool 
Parameters

Active Directory Path: This is the Active Directory path.

Log File Path: This is the path to the Active Directory Integration Tool log 
file.

Import Active Directory Users into MS Govern Database: Select this 
option to import Active Directory users into Govern’s database.

User Group Name group

These are the four (4) user access levels available in Govern in their order of 
priority; highest to lowest. 

SuperUser: The SuperUser type has access to all functions, forms and 
features including the system tables. The name that is inserted in this field is 
the one that the administrator has assigned to users with SuperUser level 
access in Active Directory.

Administrator: This type of user will have access to all menu options with 
the exception of the system tables. The name that is inserted in this field is the 
one that the administrator has assigned to users with Administrator level 
access in Active Directory.

Regular: This type of user has access to the functions and forms assigned 
by an Administrator or SuperUser. The name that is inserted in this field is the 
one that the administrator has assigned to users with Regular access in Active 
Directory.
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Read Only : Also known as Inquiry Only, this user is limited to only viewing 
functions and forms as defined by an Administrator or SuperUser. The name 
that is inserted in this field is the one that the administrator has assigned to 
users with Read Only access in Active Directory.

To import Active Directory Users:

1. Select Utilities > Active Directory Integration Tool...

2. Enter the Active Directory path (1).

3. Click to select the Import Active Directory Users into MS Govern 
Database option (2).

4. In the User Group Name group (B), enter the names that have been 
assigned to the different access levels in the Active Directory panel, e.g. 
GovernAdminUsers for Administrator level access

5. Click Process (3) to begin the process or Exit to close the window. 
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Should there be an error with the process, an error message will be displayed. 
Click OK (A) to terminate the process.

At the second prompt, again click OK (B) and review your steps.
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GNA and Connection Keys (CK)
In environments where there are multiple databases, the GNA can access by 
creating secondary and tertiary connection keys.

Creating a Supplementary Connection Key

To create a secondary or tertiary connection key in the GNA...

1. Select Utilities > Connection Key Management...; this will open the 
Connection Key Management form.

The Connection Key Management form

The Connection Key Management form is used to create or modify the 
parameters for a Connection Key. In this form you are able to specify the 
name of the Database Server that you will be connecting to, the Database 
Name, your access credentials, and any additional parameters required to 
optimize your connection. In addition you are able to test, and or delete your 
connection.

Specified parameters are used to build a Connection String. The generated 
Connection String is then used by the system to connect to and access the 
database. Saved connection keys are listed in the left hand pane. 
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Connecting to a SQL Database Server

The following steps are for users of Microsoft SQL 2000 or 2005. Oracle users 
see the requirements for Connecting to an Oracle Database Server on 
page 350.

Creating a Connection Key

To create a new connection key...

1. Click New   on the Connections tab.

In the Connection Key Management form (A), enter the parameters as follows:

Note: Ensure that all text entries made in the Connection Keys Management 
form are capitalized, i.e. in uppercase. The exception would be the 
UserID and Password; both of these can be 
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2. In the Server Type group (1), select the version of Microsoft SQL Database 
that you will be accessing, e.g. Microsoft SQL 2005

3. In the Connections group (2), enter a database connection key name 
following the format below:

EXAMPLE: 

4. In the Database Server parameter (3), enter your database server name 
in capital letters.

5. Enter the name of your database into the Database Name parameter (4), 
again use capital letters.

6. Type your user ID into the User ID parameter (5).

7. Enter the Password (6) that you will use to access the database.

8. Click Save  to save the new connection key.

Prior to successfully saving the connection key, internally a connection string 
is generated and used to connect with the database. If this preliminary 
Connectivity test is successful, to ensure that a valid connection to the 

Database Server Name GOV027

Database Name SCHUYLKILL95

Database Type SQL

Database Connection Key 
Name

SCHUYLKILL95_GOV027_SQL

Note: An underscore( _ ) is used to separate each of the three (3) parts of 
the Connection Key Name:
<DatabaseName>, <DatabaseServerName>, and <DatabaseType>.
All entries must be capitalized.

Note: It is essential that you enter a Connection Key name in the Database 
Connection Key field, otherwise a key will not be properly generated.
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database can be established. A confirmation message appears to indicate that 
the connection is successful:

9. On the confirmation message click OK.

10. Click Save the current item  to save the connection string information.

Setting a Connection Key (CK) as a Default

A default Connection Key (CK) is one that the application will always start with 
until a new one is defined. Any connection key that appears under the List of 
Connection Keys may be used as a default.

To set a Default Connection Key:

1. In the Connection Key Management screen under the List of Connection 
Keys column, click to select the key that you would like to set as the 
default.

2. Under the Connections tab, click Set as Default.

Note: If you receive a message indicating that your connection was not 
successful, click OK, review and verify your settings.

Note: After repeated unsuccessful attempts testing the connection, it is 
recommended that an administrator be contacted. They will verify the 
type of authentication that your login is configured for in SQL, e.g. 
Windows Authentication and/or SQL Authentication.
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3. A verification message will be displayed; click Yes to accept the selected 
Connection Key as your new default.

This connection will remain as the default until a new one has been selected.

Deleting a Connection Key

To delete a Connection Key:

1. In the Connection Key Management screen on the left hand side under the 
List of Connection Key column, click to select the key that you would like to 
delete (A).

2. On the Connections tab click Delete the 
current item.
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A confirmation window will appear; click Yes to delete the key.

Connection Key General Parameters 
Management 

A Connection Pool is a collection of database connection objects. In order for 
a Govern application to communicate with a database, a connection must be 
established with a connection object from the Connection Pool. 

Connection States

Connections can have two (2) states, Active, or Inactive. In the system, 
connections can exist in two (2) ways Physical and Logical. When created in 
the pool by a system request, the connection is Physically and Logically 
active. When a request for the connection to be closed is made by the system, 
the connection becomes Logically inactive, but Physically it is still active in the 
Connection Pool. Creation of a new connection is time intensive, therefore a 
happy medium must be maintained when configuring the parameters for the 
Connection Pool.

Connection Pool Polling Intervals

The Connection Pool is periodically checked, or Polled for inactive 
connections. This process is based upon a user defined interval or a built in 
system rule; inactive physical connections are removed from the connection 
pool during this set time interval or based upon this system rule.

Oracle Systems

Oracle systems have a polling interval of approximately 3 minutes. Every 3 
minutes, the system will review the number of inactive connections in the pool. 
Based upon the Decrement Pool Size setting, the system will reduce the 
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number of connection by the value, up to the minimum number that is 
specified in the Minimum Connection Pool Size parameter.

SQL Systems

The polling intervals for connections to SQL databases, is not user 
configurable. Maintenance of the number of Open connections are handled 
internally by the system, there are no user configurable parameters.

The parameters that are located in the Connection Key General Parameters 
Management form are set by default. Unless instructed by MS Govern 
Technical Support, do not modify these settings as they can impact the overall 
performance of the application. 

To access the Connection Key General Parameters Management form...

1. In the Govern New Administration (GNA) select Utilities > Connection 
Key General Parameters Management...

WARNING: The parameters in this form should only be modified by 
Administrators, and with the understanding that changes 
made will be system wide and will affect all users.
Page 346 © 2014 MS Govern



GNA and Connection Keys
(CK)
Connection Key General Management - General group

Connection Pool (Minimum Size / Maximum Size)

From the Web, the .NET components 
access the database through a 
Connection Pool. Users are able to 
define the minimum and maximum 
number of connections for the pool (A).

• Minimum Connection Pool Size - 
Enter the minimum number of data 
connection objects to be 
established in the pool. (Default = 
1)

• Maximum Connection Pool Size - 
Enter the maximum number of data 
connection objects that can be 
allocated in the pool in the 
Maximum Connection Pool Size 
field. (Default = 50)

Database Cache

The database cache uses system memory to store information that is read 
from the hard disk. The next time the same information is requested, it is read 
directly from memory. Increasing cache size can increase system 
performance, but always ensure that you have sufficient system memory to 
accommodate your settings. Cache sizes are specified in megabytes (MB)

Cache Size (Minimum Size / Maximum Size / Refresh Rate)

Minimum Cache Size: This is the minimum memory size that the system 
will allocate to the cache.

Maximum Cache Size: As the cache size is dynamic, this is the maximum 
memory space that the system will allow the cache to grow to.

Note: Users refer to the About Connection Pool Settings on page 348 for 
additional details about Connection Pool Size settings.
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Cache Refresh Rate: This is the frequency that the cache is refreshed. The 
unit is in seconds, therefore to set the rate to 5 minutes, you would enter a 
value of 300:

300 sec. / 60 sec. = 5 min.

Connection Key General Management - Oracle group

The parameters that are found in the Oracle group of the Connection Key 
General Parameters Management form are used to set the Pool Size 
increment and Pool Size decrement values. See Oracle Systems on page 345 
for details.

Pool Size Increment: The Pool Size Increment value determines the 
number of connections that will be automatically created when a request is 
made to access the database. For example, if a value of three (3) is entered in 
this parameter, even if a single connection is requested, three connections will 
be created in the pool.

Pool Size Decrement: The Pool Size Increment value will determine the 
number of connections that will be closed when a request is made. For 
example, a value of 5 is entered in this parameter. In a pool of 6 idle 
connections, when a request to close a single connection is sent, 5 of the 6 
idle connections will be closed.

About Connection Pool Settings

The Minimum Connection Pool Size: and Maximum Connection Pool 
Size: fields are used to determine the number of connections that will be 
established with the server. 

As an example, a user has a minimum setting of five (5) connections, and a 
maximum setting of ten (10) connections. In the instance of a single query 
request, all 5 requested connections will be created even if only one 
connection is required. When the query transaction has been completed, the 
created connections will be removed during the Connection Pool polling 
interval. Likewise, if 11 connections are required for a process, since the 
maximum specified was 10, the system will hold the last process and 
continuously check until a free connection is available in its assigned pool.

Note: The above parameters are automatically set by the system and do not 
require user modification.
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Performance Issues and Connection Pool Settings

In a multiuser environment, performance issues may be observed as a result 
of connection pool settings. For example, in a 10 user environment, each user 
has a minimum setting of 5 connections and a maximum setting of 100 
connections. Should each user run a single query, there would potentially be 
50 connections running simultaneously, i.e. (5 queries x 10 users = 50 
connection). Should each user reach the maximum number of connections, 
1000 connections would be created.

Connection Pool Settings for Web Sites

Determining the number of potential simultaneous connections is a part of the 
planning procedure for a Web site. Once the anticipated load on the site has 
been determined, the minimum size can be set accordingly. Administrators 
should keep in mind that each site will use one Data Access Block (DAB); 
therefore the parameter setting should be in reference to the number of 
connections. In addition the session Timeout settings for the Web server 
could also be adjusted to ensure that connections are periodically refreshed.

As individual Web site requirements will vary There is no minimum 
recommended setting for the Minimum Connection Pool Size: parameter for a 
Web site.

Recommended Single User Settings

The following are the recommended settings for the Oracle group for a 
single user access to the database:

• Minimum Connection Pool Size: 1
• Maximum Connection Pool Size: 25

• Minimum Cache Size: 50
• Maximum Cache Size: 5000
• Cache Refresh Rate: 300

• Pool Size Increment: 1
• Pool Size Decrement: 3
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Connecting to an Oracle Database Server

The steps to connect to an Oracle database server are similar to those of the 
Microsoft SQL Database Server. Required steps are as follows.

Setting Up User Access for Oracle Connections

In Oracle Enterprise Manager, grant Select access, for the following tables to 
the user defined with the User ID and Password. These details will be used to 
access the database. This is the same information that is entered in the 
Connections group of the Connection Key Management window. See 
Connecting to a SQL Database Server on page 341.

• COL$
• ICOL$
• IND$
• OBJ$

• USER$

Tables with Identical Names in Oracle Instances

CRITICAL: When creating a Connection Key, there are three (3) user roles 
that the Oracle User must be a member of:
Connect
Resource
Govern_User (or the name that has been given to the Govern 
User.) 
If the Oracle user is not a member of all three of the above roles, 
access will not be granted.

Note: Oracle users need to complete the following procedure, in the Oracle 
Enterprise Manager:

Note: All tables are Oracle System Tables.

Note: Oracle databases allow the use of identical table names in two or more 
Instances. The Govern System does not allow the use of identical 
table names, therefore ensure that identical table names are not used 
in any 2 Oracle instances
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Oracle Connections

1. Refer to step 2 of Creating a Connection Key on page 341 to create your 
Database Connection Key. If one has already been created, select it 
from the Database Connection drop-down menu list.

2. Enter the name of the database in the Database Server field.

3. Enter the user identification and password for the server, in the User ID 
and Password fields.

For other Oracle related topics, look at Synonyms in Oracle on page 353. 
Continue with the following steps to complete the procedure.

Note: Ensure that this user is given access to the Oracle database system 
tables, specified under Setting Up User Access for Oracle 
Connections on page 350.
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Managing Multiple Database Connections
In instances when you have multiple database connection keys, the Govern 
New Administration (GNA) allows you to manage the connections to these 
databases. In order to access your databases, you will need to change to the 
corresponding Connection Key.

To change Connection Keys:

1. Select Utilities > Connection Key Management...

2. In the Connection Key Management form, click to select an existing key 
from the List of Connection Keys on the left hand side (A).

3. Click Set as default (B) to select the key.
Page 352 © 2014 MS Govern



Synonyms in Oracle
Synonyms in Oracle

Using Synonyms in Oracle (Best Practices)

An Oracle synonym basically allows you to create a pointer to an object. This 
object can exist in the same database, or in another database. Oracle 
synonyms are used because, by default, when you are logged into Oracle, it 
will look for all objects being queried within your schema, i.e. accounts.

A synonym allows a database administrator to define alternate names for 
existing database objects from other schemas.

Configurable Searches and External queries

With Govern Open Forms, you can build customized queries, open forms, 
Dynamic Searches, etc. based on data in different schemas and/or external 
databases.

Data in a different Schema but same Database Instance

When using a synonym to access data in a different schema but within the 
same database, it is recommended that you add the synonyms directly in the 
govern schema. For example, in a schema called MANTA, if you need to work 
with the tables, it is recommended that you create synonyms with a Govern 
prefix, in the Govern schema for the required tables.

Govern Schema MANTA Schema

Govern.PC_PARCEL Manta.External_table1

Govern.MA_MASTER Manta.External_table2

Govern.PC_ADDRESS Manta.External_table3

Manta.External_table4 (*Synonym) Manta.External_table4

Manta.External_table5 (*Synonym) Manta.External_table5

Manta.External_table6 (*Synonym) Manta.External_table6

Note: When creating synonyms, one limitation is that it is essential that the 
name used by the synonym is the same as that of the original.
© 2014 MS Govern Page 353



Govern New Administration (GNA)
Data in a different Database or Server

When using a synonym to access data in a different database or on a different 
server, there are two (2) methods that can be used.

Method 1

When the data is located in a different database, a connection key will need to 
be generated to access this database. To ensure success, you will need to be 
able to create stored procedures that will be used by Govern, within the 
database and schema. Note that this may not be the preferred methodology 
for System Administrators as this mixes different information within the same 
schema.

An alternative is to create a Govern schema within the other database, and 
use the synonyms to point to the desired tables. When this method is used, 
stored procedures will be created in the Govern Schema along with the 
synonyms. This is a recommended practice.

Method 2

This second method allows you to connect to an external database or server. 
Once a connection has been established, the synonym can be used in your 
current Govern database and schema.

Example of a database link

The following is an example of the commands that can be used to establish a 
database link.

CREATE DATABASE LINK manta.manta_server_name 

CONNECT TO the manta database, IDENTIFIED BY 
manta_password 

USING ‘manta_service_name’;

The above connects to the ‘manta’ database using the net service name 
‘manta_service_name’, and is connected with a username of ‘manta’ and a 
password of ‘manta_password’.

With this, you can do a 

SELECT * FROM upload_address@manta.manta_server_name 
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This will allow you to retrieve the rows from the upload_address table on the 
manta database residing on the manta_server_name Oracle server.

Creating the Synonym

You can also create a synonym in the following manner:

CREATE SYNONYM upload_address for 
upload_address@manta.manta_server_name

So that now you can do a SELECT * FROM upload_address.

Syntax

Create synonym [SYNONYM_NAME] for [SCHEMA].[TABLE_NAME]

Example: CREATE synonym [UPDATE]

Using Synonym for table residing on same 
Server but different Schema

The following steps are for using a Synonym for a table that is on the same 
Server, but in a different Schema.

1. Create a synonym for the MANTA.UPLOAD_PROPERTY table and name 
it GOVERN.UPLOAD_PROPERTY.
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2. Start the Business Entity Designer (BED)

3. Create the UPLOAD_PROPERTY Business Entity (BE); create all 
required attributes and ensure that each attribute matches the 
MANTA.UPLOAD_PROPERTY table.
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4. Select the ParcelInfo Business Model (BM) and add the 
UPLOAD_PROPERTY business entity to it.

5. Click on the ENTITIES (relationship) tab (A) and select 
PC_ParcelInformation as the parent entity and UPLOAD_PROPERTY 
as the child entity
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6. Under the same tab (A), define the relationship between the 
TAX_MAP_UFMT and ROLL_NUMBER attributes

7. Start the Model Object Designer (MoD) and open the PC (Property 
Information) model.
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8. Expand the ParcelInfo item in the loaded Business Model section.  You will 
now see the UPLOAD_PROPERTY Business Entity at the end of the list.

9. Drag the UPLOAD_PROPERTY business entity to the property 
information model.
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10. Select the UPLOAD_PROPERTY cell to change it’s position.
Page 360 © 2014 MS Govern



Synonyms in Oracle
11. Change the Row sequence to 1 and cell sequence to 2.

12. Click Save to save the model.

Note: You may also add action buttons to the UPLOAD_PROPERTY model 
to save/delete/etc…
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13. Start the Govern Security Manager (GSM).  Right click on Applications (A) 
and select Synchronize Profiles from the floating menu.

14. Expand the applications node (A) and confirm that UPLOAD_PROPERTY 
is now present in the Property Control profile (B).

Note: For details about the synchronization process, refer to the Govern 
Security Manager (GSM) release 5.0 for details.
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Verification in Govern

After the synchronization process, the presence of the new tab can be verified 
in Govern.

1.  Start Govern and go to the Property Control profile.

2. Open the Property Information openform.

3. Search for and edit the Property Information for tax map number 
13092095000.  You will now have a tabbed document for the 
UPLOAD_PROPERTY business entity.

4. Click on the UPLOAD_PROPERTY tab and the related data from the 
UPLOAD_PROPERTY business model will be displayed.

All editable fields can be edited and saved.

Using a Synonym for a Table residing on 
another Server and Schema

The following steps are for using a Synonym for a table that is on another 
Server with a different Schema.

1. Create a database link to where the remote tables reside.
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2. Test and validate the new database link

Note: The test must be successful.
Page 364 © 2014 MS Govern



Synonyms in Oracle
3. Export the DDL (save to worksheet) of the synonym 
UPLOAD_PROPERTY that we created earlier.

4. Edit the DDL to add a reference to the database link to the server that we 
are linking to by specifying ‘@WPG11G’ as a suffix to the table name.
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5. Run a test query to verify that the link is working.

We are now querying (and joining), transparently, tables that reside on 
separate Oracle servers.  If you run the MS Govern application, at this point, 
you will obtain identical results.
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A Note about Security for Synonyms

In order for a synonym to function correctly, it is essential that the security be 
set to have access to the external tables that are pointed to by the synonym. 
For example to, to access a MANTA schema, you must have security access 
to the MANTA tables in question..
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Country Corrections in NA_NAMES table
This process is required for cleaning up the text field used in early versions of 
Govern for Windows. This field was created for users to specify countries in 
the NA_NAMES table. Since the field for country names is a text field with no 
validation, errors may have been made during entries, i.e. no standard format 
or codes were maintained. When this table is to be used on the Web, 
validation will occur; users must make a selection from a drop-down menu 
containing pre-defined countries.

This utility is used to “clean up” old codes that exist by allowing you to 
associate them with existing countries. The data found in this column are 
usually Postal codes or Zip codes, or non-standard abbreviations.
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NA_NAMES table
For example, under the Erroneous Country column (A), we may have an entry 
of a zip code, we could correct this by associating or “mapping” that entry to 
the United States.

To correct erroneous country codes...

1. In GNA, select Utilities > Country Corrections in NA_NAMES table...

2. The Country Name Correction form appears; under the column marked 
Erroneous Countries, locate an erroneous code (1).

3. Click the line that the code appears under the Corrected Countries 
column (2).

4. Select the country code that it should be mapped to from the drop-down 
menu (3).
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5. Click Save to Database to save your correction (4).

6. If no mapping is required, or no match can be found for the erroneous 
country codes, click to select the Replace blank corrected countries 
with null values option (3)

7. Click Save to Database to save your changes.

8. To close the form, click Exit.

The next time you access this tool only the country codes that have not been 
matched with a correct country code will be displayed.

Note: Blank corrected countries are replaced with null characters in the 
database.
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APPENDIX A: Glossary

Term Definition

.NET A platform for developing and running applications that use .NET 
technologies. .NET technologies are designed to run on intranets and 
the Internet and to provide centralized data storage, user information, 
services and products that can be delivered and updated on any 
number of integrated servers, client PCs and other devices, all at the 
same time.

.NET Framework The foundation of the .NET platform, providing an environment for 
building and running .NET applications and a library for accessing 
services.

Automatic Clearing House 
(ACH)

A system that provides electronic funds transfer (EFT) between banks, 
included with Govern’s ePayment solution, for processing bill 
payments and permit fees.

Connection Key A string containing all the information needed to automatically connect 
to a site. The connection key is created from the information entered by 
the administrator in Govern’s .NET Configuration Toolkit.

Connection Pooling A supply of database connections that are kept open and available. 
They are used only when requests for data are made. On the Web, this 
is more efficient than maintaining a separate connection for each user.

Data Source A device or area on a computer in which the data are originally created 
and stored.

eComplaint Govern’s eComplaint provides citizens online access to submit 
complaints.

eComponents An electronic component. Govern’s eComponent package includes the 
eProfile, ePayment, ePermit and eComplaints solutions.

eGovernment Government information and services made available over the 
Internet.

ePayment An electronic transaction made over the Internet. Govern’s ePayments 
solution includes ACH and credit card electronic payment 
management.

ePermit An electronic permit initiated over the Internet. Govern’s ePermits 
solution provides online access for submitting both simple and complex 
permit applications that can include multiple permit types, multiple 
name types and multiple additional documents.
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Extensible Markup Language 
(XML)

A standard used to describe the content of data or text. XML is used to 
facilitate searches, and to transfer data between applications. It can be 
used, by any application, on any platform or operating system.

Global Password A single password used to authenticate all users. Normally, users log in 
using their own unique password and the global password is used as a 
secondary authentication. Users are not aware of the global password.

Index An object that lists the key fields and the locations of records in a 
database table. It is used to facilitate and speed up access to a table.

Lightweight Directory Access 
Protocol (LDAP)

A protocol used to locate resources within a directory. An LDAP 
directory can be spread over several servers.

Mobile Inspector Designed for the inspector who needs up-to-the-minute information, 
while working in the field, Govern’s Mobile Inspector solution provides 
online real-time wireless access to the Land Management subsystem.

Object Sequence An Object Sequence defines the order of the search objects on the 
browser screen.

Password Hashing A function that applies an algorithm to a password in order to create a 
one-way encrypted value of a fixed length, a hash value. Hash values 
are stored in the database in place of passwords, because they cannot 
be decrypted. However, since two users can have the same password 
and therefore the same hash value, and since someone with malicious 
intent could obtain a password by entering and comparing values, 
SALT is added to the hash value to increase the security.

Password Prefix A code that is added to the beginning of a user’s password for security 
reasons.

Password Suffix A code that is added to the end of a user’s password for security 
reasons.

PL/SQL A programming language that extends the capabilities of SQL. With 
PL/SQL, you can add procedures to SQL queries. For example, in 
order to obtain certain results, you may normally be required to run a 
series of SQL queries, executing the first on the server, retrieving and 
processing the results on a client; then, executing the next query based 
on those results. Using PL/SQL you can combine these queries into a 
single procedure and run it once on the server. 

Relational Database A method for organizing data in which each data item is stored in only 
one location and is linked, only as required.

Term Definition
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SALT A random string added to increase the security of hashing. Salt creates 
a unique hash value for every user even when multiple users have the 
same password. It prevents hackers from discovering passwords; for 
example, by matching common passwords with hash values.

Search Group A combination of two or more Search Styles that are launched, as a 
unit, in the order specified in the search sequence.

Search Object An item appearing on a Search page, such as a search criterion or 
label. To display search objects on a Search page, you need to link 
them to a Search Style.

Search Style A Search Style launches an SQL query and displays the Objects that 
appear on the Search page, including the search criteria and labels.

Secure Sockets Layer (SSL) The leading security protocol on the Internet. SSL uses public and 
private key encryption to establish secure, encrypted communication 
between Web servers and browsers.

Sequence A procedure used to generate numbers for an autonumber field in an 
Oracle database. Within the Sequence, you can define the starting, 
minimum, maximum and increment values of the automatically-
generated numbers.

Stored Procedure Stored procedures are chunks of code that are stored on the database 
server where they are accessible to all clients and where they can be 
retrieved and rerun without the need for recompiling each time.

The .NET Database Toolkit provides a number of System Stored 
Procedures. In addition, Stored Procedures are automatically created, 
in Govern, when the user performs a search or modifies a table by 
updating, inserting or deleting a record, from a .NET application.

Structured Query Language 
(SQL)

A standardized language used to request information from a relational 
database and to modify records within that database, by inserting, 
updating and deleting data.

System Stored Procedure Essential stored procedures, required by the Data Access Block

Table A database object that contains data of a related type. For example, 
PC_PARCEL, a central table in Govern, contains the parcel ID (P_ID), 
tax map number and other administrative information for all the 
property records referenced in Govern.

Toolkit A set of software routines and utilities. Govern’s .NET toolkits are used 
to configure and maintain the database for the .NET applications.

Term Definition
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Trigger A procedure written in PL/SQL that is automatically launched or fired, 
when a specific action is performed on a database; for example, when 
a record is inserted, updated or deleted. Triggers can be used to 
ensure that data are updated and verified in a consistent manner to 
enforce complex business rules, derive column values automatically, 
prevent invalid transactions, log events transparently, audit 
transactions, or gather statistics.

Term Definition
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APPENDIX B:  Logical Expressions
The following table is a list of the default logical expressions found in the 
Business Entity Designer (BED). They can be edited through the Logical 
Expressions Editor in the Govern New Administration (GNA). These 
expressions are compatible with those created in the Govern Admin 
application of Govern for Windows. Exceptions are the ATTRIB_# and the 
PARAM_# keywords. These keywords are used exclusively in Govern.

• ATTRIB_#*
• PARAM_#*

*The '#' symbol represents numbers, e.g. ATTRIB_1, or PARAM_1. A total of 
up to 10 parameters and attributes can be used, i.e. ATTRIB_0 to ATTRIB_9, 
likewise PARAM_0 to PARAM_9.

TABLE:

Name Expression

IS_BETWEEN IF (ATTRIB_1 >= PARAM_1) AND (ATTRIB_1 <= PARAM_2) THEN
   RETURN True;
ELSE
   RETURN False;
ENDIF

IS_SMALLER IF (ATTRIB_1 < PARAM_1) THEN
   RETURN True;
ELSE
   RETURN False;
ENDIF

IS_SMALLER_OR_EQUAL IF (ATTRIB_1 <= PARAM_1) THEN
   RETURN True;
ELSE
   RETURN False;
ENDIF

IS_GREATER IF (ATTRIB_1 > PARAM_1) THEN
   RETURN True;
ELSE
   RETURN False;
ENDIF
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IS_GREATER_OR_EQUAL IS_GREATER_OR_EQUAL:
IF (ATTRIB_1 >= PARAM_1) THEN
   RETURN True;
ELSE
   RETURN False;
ENDIF

RETURN_MIN_1 RETURN_MIN_1:
IF (ATTRIB_1 <= PARAM_1) THEN
   RETURN ATTRIB_1;
ELSE
   RETURN PARAM_1;
ENDIF

RETURN_MIN_2 RETURN_MIN_2:
IF (ATTRIB_1 <= PARAM_1) AND (ATTRIB_1 <= PARAM_2) THEN
   RETURN ATTRIB_1;
ELSEIF (PARAM_1 <= ATTRIB_1) AND (PARAM_1 <= PARAM_2) 
THEN
   RETURN PARAM_1;
ELSE
   RETURN PARAM_2;
ENDIF

RETURN_MIN_3 IF (ATTRIB_1 <= PARAM_1) AND (ATTRIB_1 <= PARAM_2) AND 
(ATTRIB_1 <= PARAM_3) THEN
   RETURN ATTRIB_1;
ELSEIF (PARAM_1 <= ATTRIB_1) AND (PARAM_1 <= PARAM_2) 
AND (PARAM_1 <= PARAM_3) THEN
   RETURN PARAM_1;
ELSEIF (PARAM_2 <= ATTRIB_1) AND (PARAM_2 <= PARAM_1) 
AND (PARAM_2 <= PARAM_3) THEN
   RETURN PARAM_2;
ELSE
   RETURN PARAM_3;
ENDIF

RETURN_MAX_1 IF (ATTRIB_1 >= PARAM_1) THEN
   RETURN ATTRIB_1;
ELSE
   RETURN PARAM_1;
ENDIF

Name Expression
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RETURN_MAX_2 IF (ATTRIB_1 >= PARAM_1) AND (ATTRIB_1 >= PARAM_2) THEN
   RETURN ATTRIB_1;
ELSEIF (PARAM_1 >= ATTRIB_1) AND (PARAM_1 >= PARAM_2) 
THEN
   RETURN PARAM_1;
ELSE
   RETURN PARAM_2;
ENDIF

RETURN_MIN_3 IF (ATTRIB_1 >= PARAM_1) AND (ATTRIB_1 >= PARAM_2) AND 
(ATTRIB_1 >= PARAM_3) THEN
   RETURN ATTRIB_1;
ELSEIF (PARAM_1 >= ATTRIB_1) AND (PARAM_1 >= PARAM_2) 
AND (PARAM_1 >= PARAM_3) THEN
   RETURN PARAM_1;
ELSEIF (PARAM_2 >= ATTRIB_1) AND (PARAM_2 >= PARAM_1) 
AND (PARAM_2 >= PARAM_3) THEN
   RETURN PARAM_2;
ELSE
   RETURN PARAM_3;
ENDIF

INBETWEEN IF (ATTRIB_1 > PARAM_1) AND (ATTRIB_1 < PARAM_2) THEN
   RETURN True;
ELSE
   RETURN False;
ENDIF

MIN IF (ATTRIB_1 > PARAM_1) AND (ATTRIB_1 = PARAM_1) THEN
   RETURN True;
ELSE
   RETURN False;
ENDIF

MAX IF (ATTRIB_1 < PARAM_1) AND (ATTRIB_1 = PARAM_1) THEN
   RETURN True;
ELSE
   RETURN False;
ENDIF

Name Expression
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APPENDIX C:SQL Syntax Rules for GNA

The Govern Data Access Block (DAB)

The Data Access Block or DAB has several functions in the Govern system. 
One of these functions is to act as the intermediary between the .NET 
applications and the database. SQL queries that are used by Govern must go 
through the DAB. While SQL can be flexible with its syntax, due to its many 
functions, the DAB must be stricter with syntax. In short what may work in 
SQL, mayhave to be modified for the DAB. In fact some of the rules that the 
DAB requires you to follow are good practises for SQL as well.

The following guidelines and examples have been collected to increase your 
level of success with Govern SQL queries.

Basic SQL Query Guidelines

A. Field in Table is Always on the Left Hand Side

When creating your query statement, the field that you are referencing in the 
table should always be on the left hand side (LHS), and the Dynamic Search 
object should always be on the right hand side (RHS).

For example:

In the following SQL statement ...

NOT VALID: WHERE @pmnumber_1=PM_MASTER.PM_NUMBER

Should be written as...

VALID: WHERE PM_MASTER.PM_NUMBER=@pmnumber_1

Note: The above statement is valid in SQL, but it will fail in Govern. The Data 
Access Block (DAB) will not interpret it correctly.
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B. No Spaces Allowed after Logical Operators

For example: 

NOT VALID: WHERE PC_PARCEL.PID1 > PC_PARCEL.ID2 

should be written as...

VALID: WHERE PC_PARCEL.PID1>PC_PARCEL.ID2 

C. Space Before and After LIKE Operator

The LIKE pattern matching operator is used to select only rows that are "like" 
what you specify. When using it ensure that there is a space before and a 
space after the operator.

For example:

NOT VALID: WHERE PC_PARCEL.PID1LIKEPC_PARCEL.P_ID 

should be written as...

VALID: WHERE PC_PARCEL.PID1 LIKE PC_PARCEL.P_ID 

OPERATORS

Symbol Description

= Equal To

<> Not Equal To

> Greater Than

< Less Than

>= Greater Than or Equal To

<= Less Than or Equal To
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D. Always Specify Tables and Fields in Statements

When writing statements, always specify Tables then Fields (TABLE.FIELD). 
This applies even in cases where you are referring to a single table and there 
would be no ambiguity.

For example:

The following statement...

SELECT NA_ID, INDEX, DESC FROM NA_NAMES WHERE 
NA_ID=@nanameid_0

is the same as ....

SELECT NA_NAMES.NA_ID, NA_NAMES.INDEX, NA_NAMES.DESC FROM 
NA_NAMES WHERE NA_NAMES.NA_ID=@nanameid_0

In the first statement we are only specifying the columns in the NA_NAMES 
table. This would not pose as a problem if we are only dealing with one table. 
Realistically, we will often have to interact with multiple tables, and many 
tables have the same column names; this would create an ambiguity. The 
system would not know which table is being referred to.

Advanced SQL Queries

The above section contains general rules that are to be followed when 
creating SQL queries. The following are specific examples of issues with 
advanced queries, and how they may be resolved.

A. Double Brackets Workaround

Database entries in Govern can have three (3) states, TRUE, FALSE, and 
NULL. The NULL is placed in a field as a placeholder when no data is entered. 
TRUE is equal to a value of -1, FALSE is equal to zero (0), and the NULL 
should equate with zero (0). 

A NULL value is treated differently from other values due to its special nature. 
NULL and 0 cannot be compared because they are not equivalent.

The following example demonstrates how the NULL can be handled when it is 
encountered in the database.
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In the following query...

Query

SELECT PC_PARCEL.P_ID, PC_PARCEL.TAX_MAP, 
PC_ADDRESS.FORMATED_ADDRESS, PC_PARCEL.EFFECTIVE_YEAR, 
PC_PARCEL.INACTIVE_YEAR

FROM PC_PARCEL left outer join PC_ADDRESS on 
PC_PARCEL.P_ID=PC_ADDRESS.P_ID AND PC_ADDRESS.LOC_SEQ=0  

WHERE (PC_ADDRESS.CIVIC IS NULL OR 
(PC_ADDRESS.CIVIC>=@pcfhouseno_0 AND 
PC_ADDRESS.CIVIC<=@pcthouseno_1))  

AND (ISNULL(PC_ADDRESS.STREET,'') = 
ISNULL(@pcstreetname_2[[PC_ADDRESS.STREET]],''))
AND (ISNULL(PC_ADDRESS.SUFFIX,'') = 
ISNULL(@pcstreettype_0[[PC_ADDRESS.SUFFIX]],''))

In the above query, the SQL ISNULL() function is used, so that when 
searching specified columns in the table, should a NULL character be 
encountered, the ISNULL() function will equate it with zero (0). In the above 
example a modification in the form of double square brackets “[[ ]]”, have been 
added to the query. This modification has been made for the DAB. When 
When the DAB encounters double-brackets it will immediately use the data 
type of the TABLE.COLUMN combination that are within the brackets to 
declare the leftmost variable that is outside of the brackets, in our case the 
ISNULL.

B. NULL Characters Alternate Method

As stated in the previous example, the database entry can have three (3) 
states, TRUE, FALSE, or NULL. A check box in a user interface can have two 
(2) states, TRUE (-1), or FALSE (0). We would need to code our query to 
equate a NULL with a zero (0). The following example demonstrates an 
alternate method of handling the NULL character.
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Query Fragment

AND(PC_PARCEL.NON_PARCEL_FLAG=@pcnonparcel_0 OR ( 
0=@pcnonparcel_0 AND PC_PARCEL.NON_PARCEL_FLAG IS NULL))

The above statement is written to handle the NULL by equating 
NON_PARCEL_FLAG with NULL.

The above example statement can also be recreated with the double brackets 
method. The statement would be as follows:

AND 
(PC_PARCEL.NON_PARCEL_FLAG=@pcnonparcel_0[[PC_PARCEL.NON_
PARCEL_FLAG]],'')

C. Linking Interface Selections

We would like to present the user with a search option that will include inactive 
parcels. Unfortunately in the database there is no field in the database that will 
tell you that a parcel is inactive. To be able to link something that does not 
exist in the database to something that does, and get a TRUE or FALSE value 
that we can then manipulate.

The PC Inactive Parcel field does not exist in the database but we want the  
user to use the check box, it will have to be linked to one that is of the same 
type. i.e. integer, float, text, small int, etc.

Create a dummy condition

This is a condition that will always return a value of TRUE, this also declares a 
variable based upon a column.

AND (PC_PARCEL.NON_PARCEL_FLAG=@pcinactiveparce_0 OR 1=1)

To declare the pcInactiveParcel object, we will link it to a field that is of the 
same type as that required by the checkbox, i.e PC_NON_PARCEL_FLAG. 
The DAB will now be able declare pcInactiveParcel as valid.

The conditions are now set for the two states of the checkbox option...
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AND (( 0=@pcinactiveparce_0 AND 
PC_PARCEL.EFFECTIVE_YEAR<= year id AND 
PC_PARCEL.INACTIVE_YEAR > year id ) 

OR (-1 = @pcinactiveparce_0 ))

If the Include Inactive Parcel option is not checked, i.e. FALSE (0), or Include 
Inactive Parcel is checked, TRUE(-1).

Following the above steps, we are able to declare a variable based upon a 
column. Based upon the fact that the variable does not exist, the Data Access 
Block (DAB) is being directed not to look directly at the column, but rather it is 
being told what to expect.
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APPENDIX D:  HTML Tags
The following are lists of common HTML tags that can be used in the WebSkin 
Editor 

HTML Document Structure

A standard HTML document will have the 
following structure. 

<HTML>

<HEAD>

<TITLE>

This Title Appears in 
the Browser Title Bar

</TITLE>

</HEAD>

<BODY>

Information for the body section. 
This information

is usually seen in the browser window.

</BODY>

</HTML>

<HEAD> Section

The <HEAD> section is the recommended location for JavaScript, and 
Cascading Styles Sheets (CSS). Elements that are often contained in the 
<HEAD> section are:

• Title - The title that appears in the title bar of the browser is set between 
the <TITLE></TITLE> tags.

• Link - The link element is used to define an external resource such as the 
external CSS file containing formatting styles. The following is a sample 
using the Link element to link to an external CSS file.
<link rel="stylesheet" type="text/css" 
href="CSS_Filename.css" />
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• Meta - The meta element is used to define document author, purpose, 
keywords, etc.
<meta name="keywords" content="HTML, web design" />

The “Head” section of the document is where you place the title of the page. 
The title that appears in the title bar of the web browser is placed between the 
“<TITLE></TITLE>” tags. 

<BODY> Section

The <BODY> section of your document is used for all content that is to be 
displayed in the browser. Following are some tags that are used in the 
<BODY> sections

Formatting Tags

Creating Hyperlinks, Anchors, and Links

The HTML Anchor link <a> is used to define links within your document.

<a href="URL to file">Text to be linked</a> 

Tag Name Tag Used

Heading1 <H1></H1>

Heading2 <H2></H2>

Heading3 <H3></H3>

Heading4 <H4></H4>

Heading5 <H5></H5>

Heading6 <H6></H6>

Bold <B></B>

Italic <I></I>

Paragraph <p></p>

Font <font face=”Arial” color=”#FFFFFF” size=”5”>
- The font name must appear as it does in 
your fonts folder
- Colors are defined using Octal
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HREF defines the link address, so for example a line of text that would link to 
the MS Govern Web site would look like the following:

<a href=“http://www.msgovern.com/”>Click here to go to our site...</a>. When 
the above hyperlink is defined, Click here to go to our site will appear 
underlined and will be a link to www.msgovern.com

Creating an E-mail Link

The e-mail link is a standard hyperlink using the anchor link with a slightly 
different syntax. For example:

This is a mail link...

<a href="mailto:someone@company.com?subject=Per-
mit%20Request">Contact Us</a>

the above e-mail link, will display Contact Us as a hyperlink that when 
selected, will launch the installed e-mail client with a new message window. 
The message will be addressed to “someone@company.com”, and “Permit 
request” will appear in the Subject field.

Relative Links

When creating hyperlinks, depending on the length of the domain name, and 
the number of subdirectories that the file being referenced is located in, the 
URL’s can become very long. In such situations, users that are familiar with 
the use of Relative Links will use them as a means of shortening the URL. 

For example, a file called web_image01.jpg is being referred to from a page 
with a URL of :

http://www.metrocity.com/webpages/html/services.html 

The URL for the image is:

http://www.metrocity.com/webpages/html/images/
web_images01.jpg 

Note: When you want to enter text in the Subject field, spaces between 
words should be entered as “%20” which is the URL encoding for a 
space character.
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To shorten the URL, a relative URL can be use to replace the longer path:

images/web_images01.jpg

Using Relative Links with the ePortal Application

The use of relative links, although supported, is not recommended. The Web 
Portal Application uses Active Server Pages (ASP), information to generate 
the page may be obtained from varoius locations. These locations can 
change, and as a result the links can be broken. It is therefore recommended 
that you use absolute URL’s, i.e. the full path for hyperlinks and references.

Tables in HTML

HTML tables allow you to arrange text, images, links, etc. into rows and 
columns of cells that are in a table. The principal tags that are used are the 
following:

Tags

Tag Name Tag Used Explanation

Main Table Structure <TABLE></TABLE> Creates table; properties 
are defined within.

Table Row <TR></TR> Defines each row

Table Data <TD></TD> Defines each cell of the 
table.

Table Header <TH></TH> Used to specify table 
headers; can be used for 
Rows, Columns, or both.
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Elements

Table elements are used to define other elements that specify content, and 
formatting 

Tag Name Name & Attribute Explanation

Border BORDER
ex. <TABLE BORDER=2>

Specifies thickness of 
cell border

Cell spacing CELLSPACING
ex. <TABLE 
CELLSPACING=4>

Sets space between 
table cells

Cell padding CELLPADDING
ex. <TABLE 
CELLPADDING=4>

Defines the space 
between content of the 
cell and the cell wall.

Column Span COLSPAN
ex. <TR><TH 
COLSPAN=2>Test Text</
TH>

OR
 <TR><TD 
COLSPAN=3>Test Text</
TD>

Lets the cell span over 
multiple columns

Row Span ROWSPAN

ex. <TR><TH 
ROWSPAN=2>Test Text</
TH>

OR

 <TR><TD 
COLSPAN=3>Test Text</
TD>

Lets the cell span over 
multiple rows
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Cascading Style Sheets (CSS)

The topic of Cascading Style Sheets (CSS) is one that is complex and its full 
exploration is beyond the scope of this document. What is presented here is 
an overview containing examples that can be used as a starting point.

Style sheets are used to define how HTML elements are displayed in a 
browser. Using a Cascading Style Sheet (CSS) allows you to create a single 
file that will contain the formatting information for your pages. When changes 
need to be made to the appearance, they are made in the CSS document; any 
documents that reference the CSS document are automatically updated.

A CSS can be defined in a single external document or on a page by page 
basis when embedded in the <HEAD> section of the document.

Background Color BGCOLOR

ex. <TABLE 
BGCOLOR=”Pink”></
TABLE>

ex. <TR BGCOLOR=”Yel-
low”></TABLE>

ex. <TD BGCOLOR=#AAF-
FAA></TABLE>

Sets the background 
color of a single cell, row, 
or table.

NOTE: Colors can be 
specified by name within 
quotes, e.g. “Red”, or in 
hexadecimal format, e.g. 
#FF0000. When usng 
hexadecimal format, no 
quotation marks are 
required.

Tag Name Name & Attribute Explanation
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EXAMPLE:

The above style sheet is placed in the <HEAD> section of the document. The 
<STYLE> tag is used to define the CSS. Styles have been specified for the 
<H3>, and <P> tags. The default <P> tag can be overriden when you specify a 
CSS CLASS. 

The CSS class can be used as in the above example, when you want all text 
with the <P> tag to appear as courier, but sometimes you would like them to 
appear as sans-serif. This is done by adding an “extension” to the standard 
CSS code, “P.sansserif”, and specify the extension as a class in HTML in the 
<BODY> section of the document, “<P class=”sansserif”> </P”. When you 
want the default paragraph with courier, you use <P> Text Example </P> and 
whenyou want the sans-serif font, use <P class=”sansserif”> Text Example </
P>.”

Note: CSS Code in classes will override default CSS code, e.g. P.sansserif 
will override P

Note: Key to success with CSS is paying close attention to spelling. In 
addition, like HTML, CSS are not case sensitive, but font families, 
URLs to images, and other direct references may be.
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A source of information is the World Wide Web Consortium home page at 
http://www.w3.org/. This is an excellent resource for topics related to HTML, 
CSS, and JavaScript.
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APPENDIX E: Electronic Fund Transfer 
(EFT)

The following table contains a list of the Electronic Fund Transfer (EFT) 
providers / interfaces that are supported by Govern.

1With the exception of the ACH interface provider, all transactions are done in 
Real-Time mode.

Provider / Interface Method of 
Payment

Method of 

Transfer1
Available 

from 
Version...

Pay Connexion Credit Card Real-time Transfer 4.0

Moneris Canada** Credit Card Real-time Transfer 3.3

Nelnet (QuikPAY) ** Credit Card Real-time Transfer 4.1

Nelnet (QuikPAY) ** Electronic Check Real-time Transfer 4.1

Pay Pal ** Credit Card Real-time Transfer 3.3

Paymentus Credit Card Real-time Transfer 4.5

Paymentus Electronic Check Real-time Transfer 4.5

Point & Pay Credit Card Real-time Transfer 4.1

Point & Pay Debit Card Real-time Transfer 4.1

Point & Pay Electronic Check Real-time Transfer 4.1

HPG (Harris Payment Gateway) Credit Card Real-time Transfer 4.7

HPG (Harris Payment Gateway) Electronic Check Real-time Transfer 4.7

iCart Credit Card Real-time Transfer 4.7

UniPay Credit Card Real-time Transfer 5.0

UniPay Electronic Check Real-time Transfer 5.0

Moneris (US) ** Credit Card Real-time Transfer 4.1

YourPay Credit Card Real-time Transfer 4.0

Automated Clearing House (ACH) Online entry of 
banking details

Batch Process 3.3
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**The option of configuring ACH as a secondary interface is available for 
these providers. For ACH, the transaction is expedited through a Govern 
batch process.

 

Configuration of EFT Providers and Interfaces

Provided below is non-exhaustive configuration information for some of the 
Electronic Fund Transfer (EFT) providers and interfaces. The configuration 
parameters that are required in GNA for the eGovern Public Self Service 
Portal are supplied by the EFT interface provider. The configuration 
information that is required for completion on the providers side, should be 
obtained from said provider. This information can be in the form of 
documentation, which at times may be referenced below.

QuikPAY™ from Nelnet

After successful configuration, the process flow of MS Governs’ eGov solution 
and Nelnet’s QuikPAY begins with the user being directed to a screen that will 
collect the information required for the transaction. Prior to connecting with the 
Nelnet QuikPAY system, a table log is generated and stored on the Govern 
system (Table: cc_pending_webtran). An HTTPS connection is established 
with the Nelnet QuikPAY system (1). The Govern URL is valiated by the Nelnet 
QuikPAY system, the transaction is processed along with the details (2). The 
generated transaction, confirmation details, and the session ID, are sent back 
to the MS Govern eGov system(3). On the Govern system, if the transaction is 
successful, the Table log is deleted and and the confirmation information is 

Note: When ACH is opted for as a secondary provider, it must be configured. 
See ACH tab in the MS Govern - eGovern Public Self Service Portal 
Release 5.1 user guide. for details on configuring ACH.
© 2014 MS Govern Page 393



Govern New Administration (GNA)
displayed to the user. If the transaction failed the log file remains with the 
associated error codes. 

Configuring Nelnet’s QuikPAY

For this process to proceed, there are two (2) critical configuration points, one 
is on the side of the Nelnet QuikPAY system web interface, in the Manage 
Allowed Redirect URL’s screen of the QuikPAY configuration web interface. 
The URL that is required here is that of the web page that the user will be 
entering their transaction details. Prior to configuration, ensure that you have 
noted the URL of the eGov page that will be used to connect with the QuikPAY 
system. Typically this will be an HTTPS URL with a session ID. 

Ex.: https://www.any_city.com/GovernEComponents/WebUserInterface/
$RANDOM_STRING/AR/Web_AR_Payment.aspx

The domain and path highlighted in blue is critical to the configuration, as it is 
used for authentication. In addition, the portion of the path in green must keep 
the same format.

 WebUserInterface/$RANDOM_STRING/AR/Web_AR_Payment.aspx

Note: In order to perform configuration for QuikPAY, it will be necessary to 
obtain Administrator role user rights on the system.
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When the URL information is incorrectly configured, the following error screen 
is displayed. To resolve, verify that the information is entered correctly.

Refer to the QuikPAY (R) Q4 2010 Release Notes for full configuration 
details.

Configuring eGov with the GNA for Nelnet’s QuikPAY

The second configuration point is configuring eGov for Nelnet’s QuikPAY 
through the Govern New Administration (GNA).

1. In GNA select Setup > Web Configuration > Manage Websites... to 
display the Web Sites form.

2. Under the Web Site tab, if you are managing multiple sites, ensure that 
you are on the correct site record; click the ePayment tab.

3. For development or testing do not select the Live Mode option.

Note: The above URL information is critical for the authentication process, 
so ensure that it is accurate. 
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4. Complete the parameters as per your requirements in the top section of 
the form(A).

5. Click the Credit Card / Debit Card / eCheck tab (B).

6. Select Nelnet from the drop down menu and enter any required suffixes.
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7. Click Manage to display the Account screen; complete the form. 

Browser errors with Nelnet transactions 

Account Screen Parameters

Processor: This field is preselected and cannot be modified

Account Type: Preselected field that cannot be modified

Order Type: Specify the order type.

Key: Enter the system access key

Note: Nelnet users that encounter transactions errors that may be 
associated with an upgrade of their WebUserInterface files, 
characteristically release 4.5.3 or earlier, refer to Error Associated with 
WebUserInterface File Update on page 442 for details.
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Convenience Fee: Specify the amount of the convenience fee. This amount 
can be for system use or for the transaction.

Specify Live or Test Server

It is possible to specify which server, Live or Test server that you would like to 
use for transactions for NelNet’s Quikpay or PayPal.

HostProd: Specify the password used access the Live server.

HostUAT: Enter the password to access the User Acceptance Testing (UAT) 
server.

8. In the Account screen enter the additional configuration information that 
will be provided by Nelnet, i.e. Order Type, and Key.

9. Click Save to save the settings; click Exit.

10. Complete any additional required parameters under the remaining tabs, 
i.e. Site Seal Script, Payment Option, etc..

11. Click Save  to save your configuration.

Refer to the Web Site Manager - ePayment tab Parameters in the MS Govern 
- eGovern Public Self Service Portal Release 5.1 user guide for details of 
available fields. 

Note: To use this address, the Live Mode option under the ePayment tab 
must be selected.

Note: In order for this address to be used, the Live Mode option under the 
ePayment tab must be disabled, i.e. deselected.

Note: Prior to going live with your site, ensure that the Live Mode option is 
selected.
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APPENDIX F: GNA Configuration Files 
created at Install

XML Configuration Files

XML Configuration files that are created during the installation are in the 
following locations:

By default, Install_Drive:\install_folder_path\
Deployments\Deployment_Folder_Name

FILENAME: GovernNetConfig.XML

Location: C:\Program Files\MS Govern\ OR the root of the install 
directory.

Purpose: This file contains the network configuration, license information, and 
resource file location.

FILENAME: GovernDABConfig.XML

Location: C:\Program Files\MSGovern\DatabaseConfig-
Files.XML OR in the root of the GNA install directory.

Purpose: This file is the Data Access Block (DAB)and is used internally by 
the application.

EXAMPLE:
<?xml version=”1.0” encoding=”utf-8” ?>
- <configuration>
<connectionKey>Suburban05_Seg005_SQL</connectionKey>
<language>eng</language>
<OrganizationName>Town of Any Town</OrganizationName>
<version_dnet>2.400</version_dnet>
<serial_number>Ea5120C-DQDQDQ-DQDQSS</serial_number>
<SecondaryActivationKey>15845375</
SecondaryActivationKey>
<sql>microsoftsql</sql>
</configuration>
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FILENAME: DBName_ServerName_DBType.XML

Example: SCHUYLKILL95_GOV027_SQL.XML

Location: C:\Program Files\MSGovern\DatabaseConfig-
Files.XML\ OR the install_directory\ 
DatabaseConfigFiles.XML\

Purpose: This configuration file is your Connection Key and contains your 
database connection information, organization name, and serial number.
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APPENDIX G:Crystal Reports
In this section of the Govern New Administration (GNA) guide is information 
related to the use of Crystal Reports with the Govern release 5.1 Suite of 
Applications. 

Report Function Setup: Formulas

Below are the recommended, general, read-only and conditional formulas to 
include when creating reports through Crystal Reports.

Recommended Formulas

Include the following formulas when you create Crystal Reports:

General Formulas

Govern populates the following Crystal Reports formulas automatically, if they 
are included in your reports:

Note: Client computers that intend to run Crystal Reports will need to install 
the Crystal Reports 2008 runtime on each client computer. Refer to the 
Crystal Report Runtime section of the DeployEZ™ Installer Guide for 
installation details.

Formula Definition

@rpt_date (totext (currentdate)) Date & Time

@rpt_name Report Name

@rpt_Username Town or Company Name

Formula Definition

@dept Department (code)

@dept_label Department label

@language Language

@rpt_county County
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Read-Only Formulas

The following Crystal Reports formulas are read-only; i.e., they must contain a 
nonblank value in the report. These formulas trigger specific actions or 
populate specific formulas:

@rpt_default_date Default Date

@rpt_login User name

@rpt_range Range Text

@rpt_state State

@rpt_title Report Title

@rpt_uid User identification code (UserID)

@uniform Assessment Equalization Rate

@year Fiscal year in use by current user in 
Govern

Formula Action

@acbill Refreshes the AC_POST_MASTER table 
with the current Aircraft ID or the current 
Name ID (in duplicate bill printing).

@all_ar_needed_ac Populates the value of several formulas 
for the current NA_ID and for the all Tax 
sub-systems. See  Conditional 
Formulas on page 406.

Formula Definition
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@all_int Updates the following fields in the AR_ 
SUMMARY table for all installments with 
positive balance, for all Taxation and 
Assessment sub-systems and for the 
current NA_ID. (All updated installment 
records within a sub-system will contain 
the same information).

LATE_CHARGES (Accrued Penalty or 
Interest)

CHARGE_DATE (Current date as defined 
in Govern)

BALANCE_AS_OF_DATE (Total balance 
due, exclusive of late charges)

@btbill Refreshes the BT_POST_MASTER table 
with the current Boat ID or the current 
Name ID (in duplicate bill printing).

@drilldown Enables Crystal Reports Drill Down 
feature

@govern_tx_interest

*This formula is used when calling a Web 
Crystal Report

Updates the LATE_CHARGES column in 
the AR_SUMMARY table.

Use when calling a Web Crystal Report in 
the Real Property Tax Subsystem.

@govern_ub_interest

*This formula is used when calling a Web 
Crystal Report

Updates the LATE_CHARGES column in 
the AR_SUMMARY table.

Use when calling a Web Crystal Report in 
the Utility Billing Subsystem.

@mv_ar_needed_ac Populates the value of several formulas 
for the current NA_ID and for the Motor 
Vehicle Excise Tax sub-system. See  
Conditional Formulas on page 406.

@mvbill Refreshes the MV_POST_MASTER table 
with current Motor Vehicle ID or the 
current Name ID (in duplicate bill printing).

Formula Action
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@mv_int Updates the following fields in the AR_ 
SUMMARY table with motor vehicle 
excise tax information, for all installments 
having a positive balance for the current 
MV_ID. (All updated installment records 
will contain the same information).

LATE_CHARGES (Accrued Penalty or 
Interest)

CHARGE_DATE (Current date as defined 
in Govern)

BALANCE_AS_OF_DATE (Total Balance 
Due, excluding late charges.)

@pp_ar_needed Populates the value of several formulas 
for the current PP_ID and for the Personal 
Property Tax sub-system. See  
Conditional Formulas on page 406.

@pp_ar_needed_ac Populates the value of several formulas 
for the current NA_ID and for the Personal 
Property Tax sub-system. See  
Conditional Formulas on page 406.

@ppbill Refreshes the PP_POST_MASTER table 
with the current Personal Property ID or 
the current Name ID (in duplicate bill 
printing).

@pp_int Updates the following fields in the AR_ 
SUMMARY table, for the current PP_ID, 
with Personal Property Tax information, 
for all installments having a positive 
balance. (All updated installment records 
will contain the same information).

LATE_CHARGES (Accrued Penalty or 
Interest)

CHARGE_DATE (Current date as defined 
in Govern)

BALANCE_AS_OF_DATE (Total Balance 
Due, excluding late charges)

Formula Action
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@re_ar_needed Populates the value of several formulas 
for the current P_ID and for the Real 
Estate Tax sub-system. See  Conditional 
Formulas on page 406.

@re_ar_needed_ac Populates the value of several formulas 
for the current NA_ID and for the Real 
Estate Tax sub-system. See  Conditional 
Formulas on page 406.

@re_int Updates the following columns in the 
AR_SUMMARY table, for the current 
P_ID, with Real Estate Tax information, for 
all installments having a positive balance. 
(All updated installment records will 
contain the same information).

LATE_CHARGES (Accrued Penalty or 
Interest)

CHARGE_DATE (Current date as defined 
in Govern)

BALANCE_AS_OF_DATE (Total Balance 
Due, excluding late charges)

@td_ar_needed Populates the value of several formulas 
for the current P_ID and for the Tax 
Deferral sub-system. See  Conditional 
Formulas on page 406.

@td_int Updates the following fields in the 
AR_SUMMARY table for all installments 
having a positive balance, with Tax 
Deferral information for the current P_ID. 
(All updated installment records will 
contain the same information).

LATE_CHARGES (Accrued Penalty or 
Interest)

CHARGE_DATE (Current date as defined 
in Govern)

BALANCE_AS_OF_DATE (Total Balance 
Due, excluding late charges)

Formula Action
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Conditional Formulas

The Crystal Reports formulas listed in this table are populated by Govern 
conditionally, on the presence of the following read-only formulas: 

• @all_ar_needed_ac
• @mv_ar_needed_ac
• @pp_ar_needed
• @pp_ar_needed_ac
• @re_ar_needed
• @re_ar_needed_ac
• @td_ar_needed
• @tt_ar_needed

@tt_ar_needed Populates the value of several formulas 
for the current P_ID and for the Real 
Property Tax Title sub-system. See  
Conditional Formulas on page 406.

@tt_int Updates the following fields in the 
AR_SUMMARY table, for the current 
P_ID, with Tax Title/Lien information, for 
all installments having a positive balance. 
(All updated installment records will 
contain the same information).

LATE_CHARGES (Accrued Penalty or 
Interest)

CHARGE_DATE (Current date as defined 
in Govern)

BALANCE_AS_OF_DATE (Total Balance 
Due, excluding late charges)

@txbill Refreshes the TX_POST_MASTER table 
with the current Property ID or the current 
Name ID (in duplicate bill printing).

Formula Action
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Crystal Reports with P_ID, YEAR_ID, or 
FROZEN_ID

When using Crystal Reports, if any of the following three (3) are used as 
Criteria Keys, then the Rule for Keyword Selection Queries should be 
followed:

• P_ID
• Year_ID
• FROZEN_ID

Formula Action

@ar_interest_1

@ar_interest_2

@ar_interest_3

@ar_interest_4

Calculates the interest and penalties 
committed for the current fiscal year and 
the specified installment.

@current_due Calculates the total balance due for the 
current fiscal year, including late charges.

@daily_interest Calculates the daily interest and penalties.

@prior_ar_fee_1

@prior_ar_fee_2

@prior_ar_fee_3

@prior_ar_fee_4

Calculates the demands, charges and 
fees committed for prior fiscal years and 
the specified installment.

@prior_ar_interest_1

@prior_ar_interest_2

@prior_ar_interest_3

@prior_ar_interest_4

Calculates the interest and penalties 
committed for the prior fiscal years and for 
the specified installment.

@prior_due Calculates the total balance due for the 
prior fiscal years, including late charges.
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Rule for Keyword Selection Queries

The rule is the same as that used in the VB6 Platform, Govern scans the SQL 
Query, then takes the first occurrence of the required ID’s for the selection 
formula.

In previous versions, the report selection in the report is set using the 
Table.Column located in the query. Govern would then view the SQL query in 
the Crystal Report and the first string occurrence of the Table.Column 
combination was used.

Duplicate Parameters

A sub-report is best defined as “a report within a report”. Sub-reports can have 
many of the features of a normal report. With sub-reports, data can be 
combined as a single report.

The differences between a primary report and a sub-report are:

• A Primary report can contain sub-reports, but a sub-report can not contain 
other sub-reports.

• A sub-report does not have a page header or footer section.
• A sub-report is always inserted as an object in the primary report.

Prior to Govern release 5.1, the system would NOT allow the parameters used 
in the Primary, or Main Report, to be also used in a sub-report. In release 
5.1.1307.35 and greater, the system has been modified to allow for the use of 
the same parameter in the Primary or Main Report, as well as the Sub-Report.

Database Connection

When providing Database access to Crystal Reports, it is preferable to use the 
OLE DB (ADO) connection, as opposed to using ODBC. Although the ODBC 

Note: When several columns having the same name are in the report tables, 
the ones to be used should be set as hidden print fields. 
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connection is changed to ADO at runtime, should issues arise, they could be 
due to the connection change.

A Govern Field Must be specified in the Main 
Crystal Report

When designing Reports, there is a minimum one field required for connection 
rule. The rule refers to the fact that the Database requires at least one Govern 
field to be included in the Main Report. If no Govern fields are specified, 
regardless of whether Govern fields are specified in any included Sub-
Reports. The Report will not be executed and will appear grayed out.

For a complete listing of all General, Read-Only, and Conditional Formulas, 
see Report Function Setup: Formulas on page 401 of this guide.

BEST PRACTISES FOR CRYSTAL REPORTS 
DATABASE CONNECTIONS

When specifying database access to a Crystal Report, Best Practices 
dictates that an OLE DB (ADO) Connection is the preferred connection 
method. 

BEST PRACTISES WHEN DESIGNING MAIN
CRYSTAL REPORTS

When designing a Crystal Report that will be used with Govern, it is 
recommended that the following parameters in the table below should 
be specified.

Formula Definition

@rpt_date (totext (currentdate)) Date & Time

@rpt_name Report Name

@rpt_Username Town or Company Name
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APPENDIX H:Configuring System Help

Introduction

Installation of the Govern Release 5.1 Help system is managed by the Deploy 
EZ application during the installation or update process. It is during this 
process that required directories are created and help content is updated. For 
the Govern application, unlike the Help system of the other applications in the 
suite, Govern help content is not invoked with the F1 key. Help content is 
displayed with a click on one of the help icons (A) displayed under the Help 
tab (B) in the Govern application interface. The user selects the icon that 
corresponds to the profile, form, or entity of interest. 

Open Form Hierarchy

The Open Forms hierarchy is as follows with order of precedence decreasing 
from left to right. 

The above hierarchy is reflected in the structure of the Help directories and 
subdirectories.

Note: Users can still invoke Help content with the F1 key in all other 
applications within the Govern suite. All help content that is presented 
to the user is contextual, i.e. relevant to the active user screen.
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Changes to the Help Directory

For Govern Release 5.1 and greater, changes were made to the structure of 
the Help file directories. The new structure was created to be able to present 
users with help content in different file formats. Content can include video 
clips, user system supported file types, custom images, and so on. As with 
prior versions of the help, the Adobe Acrobat PDF file format is used to 
distribute the content. 

For Release 5.1, help content is stored in multiple level directories. All 
standard content will be deployed as a ZIP archive file. Upon installation, 
the.ZIP package is then extracted to the Standard directory.

Help Content Directory Structure

The directory structure, as in previous releases, has two (2) principal subdirec-
tories, Standard, and Custom. Both the Standard and Custom directory 
structures are set by the system and should not be modified by the user. The 
structure, and how the system will access the Custom directory can be 
determined by the user through settings in the Govern New Administration 
(GNA). There are two (2) options to choose from in the form. 

To open the form, in the GNA, select the System Parameters (tab) > General 
Settings Editor…

 In the Open Forms General Settings editor, select the following:

1. Under the Registry Filter, select General (A).
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2. Locate the General Section Name (B), available options are Profile or 
Same Level.

The selection of Profile or Same Level, are dependent upon user 
requirements.

Same Level option

Users that are content with the Property Control (PC) profile that is the system 
default should use the Same Level option. The same profile will be used by all 
departments, i.e. the same Open Forms will be accessible to all users. All 
users will be viewing the same help content for the active forms.

Profile option

In situations when different profiles are required for the same, or different 
departments customized profiles will need to be designed. For example, a PC 
profile that is created for the Assessors department may not necessarily be 
the same one used by the Public Works department. As the Profiles and 
Forms are different, the Help content may not be the same. Some confusion 

Note: The Same Level option is the system default.
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regarding functionality may arise unless specific instructions are provided. In 
this situation, the option for Profile should be selected. With the Profile option, 
content is placed in a separate directory that corresponds to each customized 
profile. 

Note: Changing the parameter after the directory structure has been 
established is not destructive to the custom help content, but it will no 
longer be available until the settings are restored.
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Help Content Directory Structure

As illustrated in the grid below, the structure of the Help directory is multi-
leveled. The <HELP ROOT> refers to the root level of the help directory, and 
not the actual deployment installation of the Deploy EZ application.
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Govern HELP 5.x - STANDARD Directory Structure: (Same Level option)

The structure for the Standard directory is as follow. The versionNum 
directory will be a version number, i.e. 5.1, 5.2, 5.x,… 

<HELP ROOT> Level 1 Level 2 Level 3 - Directory / 
Content

Level 4 - Directory / 
Content

versionNum (dir) 

Ex. 5.1, 6.0, etc.

Applications (dir) MSGNET (dir) .pdf Help and required 
supplemental files. i.e. 
avi, docx, jpg, etc.

GNA (dir) .pdf Help and required 
supplemental files. i.e. 
avi, docx, jpg, etc.

QT (dir) .pdf Help and required 
supplemental files. i.e. 
avi, docx, jpg, etc.

. . .

Entities (dir) entityName01 (dir) .pdf Help files

entityName02 (dir) .pdf Help files

. . .

Forms (dir) formName01 (dir) .pdf Help files

formName02 (dir) .pdf Help files

. . .

Profiles (dir) profileName01 (dir)

reportName02 (dir)

. . .

Reports (dir)

reportName01.rpt (dir) .pdf Help and required 
supplemental files. i.e. 
avi, docx, jpg, etc.

reportName02.rpt (dir) .pdf Help and required 
supplemental files. i.e. 
avi, docx, jpg, etc.

. . .
© 2014 MS Govern Page 415



Govern New Administration (GNA)
Govern HELP 5.x - CUSTOM Directory Structure: (Same Level option)

The structure for the Custom directory is nearly identical to that of the 
Standard directory. The exception is that the Version directory is not present at 
Level 1. All sub-directories are shifted up by one level.

<HELP> Level 1 Level 2 Level 3 - Directory / 
Content

Level 4 - Directory / 
Content

Applications (dir) MSGNET (dir) .pdf Help and required 
supplemental files. i.e. 
avi, docx, jpg, etc.

GNA (dir) .pdf Help and required 
supplemental files. i.e. 
avi, docx, jpg, etc.

QT (dir) .pdf Help and required 
supplemental files. i.e. 
avi, docx, jpg, etc.

. . .

Entities (dir) entityName01 (dir) .pdf Help files

entityName02 (dir) .pdf Help files

. . .

Forms (dir) formName01 (dir) .pdf Help files

formName02 (dir) .pdf Help files

. . .

Profiles (dir) profileName01 (dir) .pdf Help files

profileName02 (dir) .pdf Help files

. . .

Reports (dir)

reportName01.rpt (dir) .pdf Help and required 
supplemental files. i.e. 
avi, docx, jpg, etc.

reportName02.rpt (dir) .pdf Help and required 
supplemental files. i.e. 
avi, docx, jpg, etc.

. . .
Page 416 © 2014 MS Govern



Govern HELP 5.x - CUSTOM Directory Structure: (Profile option)

In the above example, different profiles will require the same report. When the 
Profile option is selected in the System Registry, the different profiles will be 
using the same report. Copies of the same report are placed in the different 
Profile directory.

<HELP> Level 1 Level 2 Level 3 Level 4 Level 5

CUSTOM Applications (dir)

MSGNET (dir)

Profiles (dir)

profileName01 (dir) 

Forms (dir)

formName01 (dir) 

Entities (dir)

entityName01 (dir) 

Reports (dir)

reportName01.rpt (dir)

reportName01.rpt

Profiles (dir)

profileName02 (dir) 

Forms (dir)

formName01 (dir) 

Entities (dir)

entityName01 (dir) 

Reports (dir)

reportName01.rpt (dir)

reportName01.rpt
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Custom Directories

Users are not required to create directories for the Custom Help folder; the 
structure established during installation must be kept in order for the content to 
be available.

Creating and Using Custom Help Files

For a user to open the Help file within the Govern application, they will need to 
select the Help tab in the ribbon of the Govern application (A). Under the 
ribbon, the help content which corresponds to the Application, the Profile, 
the displayed Open Form, and the Entity is displayed (B).

• Applications - Content corresponding to the suite Application; the 
General group

• Profile - Help content for the Profile
• Form - The help content for the displayed Open Form
• Entity - Help content related to the Entity
• Report - This is the Report associated with the form or entity.

Note: The structure of default Standard, and Custom folders should not be 
modified.

Note: Unless additional files are required, the help content are in PDF 
format. Any additional formats that are mentioned above are files that 
are supplemental to the PDF with the main help content.

Note: When including any supplemental content, users must ensure that the 
file format is supported by the end-users system; e.g. if a MicroSoft 
Office PowerPoint document is to be one of the supplemental files, a 
PowerPoint viewer or a fully licensed version must be installed on the 
installation computer. 
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The Help button displays information for the main application, and the 
OpenForm Help will display Help content that is related to the active 
OpenForm.

Missing / Unavailable Help Content

When content is not present the broken help link icon is displayed. This 
icon is an indication that there is an issue with accessing the Help file(s). 
Issues can be anything from the files not being present or incorrect directory 
structure due to a change in the Open Forms General Settings form in GNA; 
the Help Folder Structure Type parameter may have been changed.To 
correct this situation, users will need to either:

• Place the required content in the appropriate directory. 

OR

• Verify that the Help Folder Structure Type parameter setting in the Open 
Forms General Settings form in GNA is set to the correct Help folder 
structure.
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Order of Precedence for Help files Directories

When a user invokes or calls the help file, the Govern system first checks in 
the Custom folder. If the requested file is not found, it will default to the 
Standard folder to display the file. The Custom folder is reserved for users 
that want to generate their own custom PDF help files.

BEST PRACTICES - CUSTOM HELP CONTENT NOMENCLATURE
• Lower case names should be used.
• Users should try to limit filenames of help content to no more than 12 

characters because the group will expand to accommodate the name. 
See image below

• Limit the length of directory names directories; try not to exceed 12 
characters

• Use the underscore character “_” in place of spaces. Ex. parcel_asmnt
• Ensure that the extension of the file is supported by the end-user’s 

system that the content will be viewed on.
• As a result of the brevity required for the filename, a detailed description 

of the Help Content can be entered using the Resource File editor in 
GNA. The node that contains this information is located in the WD 
module, CustomHelp function. The Keys for tool tips will be appended 
with an _TT in the names.
Refer to the Govern New Administration (GNA ) Release 5.1 user guide  
for details about using the Resource File editor.
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Security for Custom Folders

Creating Custom Help Files

The Govern application is designed to be flexible, with the understanding that 
users are able to design forms and reports. It is therefore expected that they 
may have a requirement to customize their Help files contents. When users 
customize Govern, supplementary help content can be created in one of two 
(2) ways.

• Annotate existing system Help files
• Generate new content with new PDF files

Annotating System Help Files

Users may annotate, i.e. add Notes, to existing system PDF files that 
correspond to the modules. Although system files should not be modified, 
there are steps that can be taken to ensure that system integrity is maintained. 

Note: There is no security imposed on the Custom Help directories. This is 
the default setting for the installation. Administrators that wish to limit 
user access to these directories will have to do so using Windows 
security. Security settings will also need to be done on a user by user 
basis.

BEST PRACTICES - SECURITY

The recommended security setting for administrators that require user 
restriction to directories, is as follows:

• All top level Help directories should be set to READ ONLY. for the 
Custom folder.

• In order for users to be able to add or update custom content, 
subdirectories of the top level Custom folder should be made 
accessible, i.e. READ / WRITE for users. This will allow them to place 
help in the directories when required.

BEST PRACTICES - ANNOTATING SYSTEM FILES

When annotating system PDF files, users should make a complete back up 
of the installed files. Only the copied files should be annotated and placed in 
the Custom folder. Original system files will remain in the Standard folder. 
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Generating PDF Help Files

When generating a PDF file with custom content, in order for the system to 
recognize the custom PDF file, it must have the same name as the one that is 
used in the Govern application or module.

For example, the Hazards (PC24) OpenForm in the Property Control module 
has been customized. A new PDF file is made containing custom instructions. 
In order for it to be accessible, the new PDF file should have the same name 
as the system default Help file. For Hazards the file is PC24.pdf; when this file 
is created, it should then be placed in the appropriate subdirectory in the 
Custom folder.

Adding or Replacing Help Content

There are two zones to the Help content ribbon in Govern (A). Zone 1 (B) 
which contains the icon for the help content file is the area to click when you 

Note: When a custom PDF is placed in the Custom folder, it is not necessary 
to remove the system default help file in the Standard folder. System 
files should never be modified.
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need to access the content. Zone 2 (C), when selected, will give access to the 
directory that the content is located in.

The directories at the custom content is to be placed in is easily accessible 
with a click on the icon under the Help tab in the Govern ribbon. 

Note: In instance where there is no help content and the broken help link 
icon is displayed (D), a click on the link will also display the directory.
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APPENDIX I:
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Diagnostic Configuration form Trace Log

Resolving Performance Issues

When there are issues with the performance of an application, or queries that 
are being perceived as “taking too long to complete”, resources are available 
to assist in determining the root cause. The Govern Data Access Block or 
DAB is one of the central components to Governs functioning. Options exist to 
have the DAB generate traces that are logged in a file. Reviewing this file can 
be instrumental in the resolution of system issues.

Enabling the Trace Log

In order to start the trace, the Trace Log feature must be enabled in the 
Diagnostic Configuration form in the Govern New Administration (GNA).

To access the form in the GNA ribbon...

1. Select Options (tab) > Configuration.
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2. In the Diagnostic Configuration form, select the Software option.

3. Look for Trace (B) under the Section Name column in the grid. 

 GNA Open Forms General Settings - “Trace” section 
options

For details about the refer to 

Enable Application Tracing For DAB

Select this option to enable the DAB trace option.
(Key: DABTracingIsEnabled)

Enable Application Tracing For External Documents

Select this option to enable the DAB trace option.
(Key: ExternalDocumentTracingIsEnabled)

Enable Application Tracing For GIS

When selected, this option will enable the GIS trace.
(Key: GISTracingIsEnabled)
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Enable Application Tracing For Mobile

Selecting this option will enable the trace option for the Mobile application.
(Key: MobileTracingIsEnabled)

Trace commands where execution time is longer than X 
milliseconds

This condition option will log both failed commands as well as those that 
exceed ‘X’ number of milliseconds to execute. (Key: 
DAB_CommandsMaxInterval)

Access the Trace Log In Govern

After the DAB Trace Log has been enabled in the System Registry, the log file 
for the Govern application can be displayed through the Govern Ribbon. In the 
Govern Ribbon, the log file can be accessed with a click on the Show Trace 
button.

Note: When this option is selected, a log entry will be made regardless of 
whether the command was successful or not. The trigger for this 
option is the fact that the execution of the command exceeded the set 
time. This option requires that the DataAccessBlock, Enable Trace 
commands option is enabled.

Note: Parameter units are in Milliseconds (i.e. 1000 milliseconds = 1 
second); if you want a delay of 3 seconds, enter a value of 3000.  The 
default System value is set 30 milliseconds.
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Format of DAB Trace Log File

The log file is formatted as a Comma Separated Values  (.csv) file. If you have 
Microsoft Excel installed, the file will by default, be opened by MS Excel. The 
log file is located in the Trace folder of the DeployEZ deployment. The file 
name is formatted as follows:

[UserName]_[MachineName]_[ConnectionKey]_[GovernApplication-
Name]_VersionNumber.csv

For example: A log file is generated by the Govern application for a user called 
pparker. The users computer is called octavius8, and a connection key name 
of OCTAVIUS8_MYDB_SQLwas used. The name of the trace file will be as 
follows:

ppparker_OCTAVIUS8_OCTAVIUS8_MYDB_SQL_GovernContainer_5.1.1
234.csv

When the file is opened in a spreadsheet application, the log file parameters 
will be listed under the following headings:

• Trace Date
• Level
• Class Name
• Method Name
• Execution Time
• Message
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SUPPLEMENTAL INFORMATION

Installing and Configuring eGovern - Public Self 
Service Portal

This chapter provides additional information relating to installations of the 
Govern New Administration (GNA). It includes the following sections:

• Notes on Setting up Microsoft™ and Third Party Software: This 
section provides important information on Microsoft Internet Information 
Services (IIS), Microsoft .NET Framework V2.0 and Crystal Reports. 

Notes on Setting up Microsoft™ and Third Party 
Software

This section provides information on Microsoft Internet Information Services 
(IIS), Microsoft .NET Framework v2.0 and Crystal Reports. 

Overview

Note: Prior to commencing with the installation procedures, run the Govern 
Updata utility to ensure that your database is up-to-date. For details, 
refer to the Getting Started guide for Govern for Windows.

Note: For successful configuration of Govern’s eGovern – Public Self 
Service Portal, it is critical that you Internet Information Services (IIS) 
is installed before installing the Microsoft .NET Framework 2.0 or 
Visual Studio .NET 2005, which includes .NET Framework 2.0. During 
installation, the .NET Framework setup program detects the presence 
of IIS and installs additional IIS components, which are not installed 
otherwise.

Note: The eComponents that make up the eGovern – Public Self Service 
Portal are compatible with Crystal Reports 2015. Users of Crystal 
Reports will need to install the Crystal Reports 2015 runtime on the 
server hosting the application, and on each clicnt computer. Refer to 
the Crystal Report Runtime section of the DeployEZ™ Installer Guide 
for details.
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Verification of Microsoft Internet Information Services 
(IIS)

Microsoft Internet Information Services (IIS), with Front Page 2000 Server 
Extension, is a prerequisite:

To verify that IIS is installed:

1. Open Add Remove Programs (A) in your Control Panel.

2. Select Add Remove Windows Components (B), from the left pane.

Note: NOTE: Front Page 2000 Server Extensions are not applicable to 
Windows Vista, Windows 7 and Windows Server 2015.
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3. Ensure that Internet Information Services (IIS) is displayed in the 
Windows Components Wizard list box (A).

If IIS is not installed...

4. Do one of the following:
• Visit Microsoft’s Web site and follow the IIS installation procedure for 

your operating system. Then, repeat this procedure.
OR

5. When IIS is installed, verify the version of the installation, highlight it in the 
list (1), and select Details (2). 
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• If IIS, version 6, is installed, follow the procedures for Microsoft .NET 
Framework, version 2.0 on page 432 and  ASP.NET, version 2.0 on 
page 433.

6. Ensure that Front Page 2000 Server Extensions is selected on the 
Internet Information Services (IIS) screen. If IIS is not selected, select it.

Microsoft .NET Framework, version 2.0 

To ensure that Microsoft .NET Framework, version 2.0 is installed:

1. Open Add Remove Programs (A) in your Control Panel.

2. Verify that Microsoft .NET Framework, version 2.0 is listed. 

Otherwise, visit Microsoft’s Web site and follow the installation procedure 
for your operating system.
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ASP.NET, version 2.0

To ensure that ASP.NET, version 2.0, is specified:

1. Select Control Panel > Administrative Tools (A).

2. Double-click on Internet Information Services (1) to launch IIS.

3. Do one of the following:
• For IIS, version 5, follow steps 4 to 6.
• For IIS, version 6, follow steps 8 to 11.
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IIS Version 5.0

4. In IIS, version 5, expand the Web Sites (2) directory under your computer.

5. Right-click on your Web site and select Properties (3).

6. Select the ASP.NET tab (4) and ensure that the version indicated in the 
ASP. NET version drop-down menu (5) indicates 2.0 or higher; select it.

7. Click OK (6).
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IIS Version 6.0

8. In IIS, version 6, expand the directory for your computer, in the left pane.

9. Open the Web Services directory.

10. Highlight ASP.NET, version 2 and select Allowed.

11. Highlight FrontPage Server Extensions 2000, or higher, and select 
Allowed.

Browser Errors Related to the Web.config File

One potential source of error during the configuration of the Web Portal is 
referencing the GovernNetConfig.xml file. See XML Configuration Files on 
page 399 for details. This file will need to be referenced in the Web.config file 
that is located in the following path:

Root Directory... \ InetPub \ wwwroot \ WebUserInterface

Security and the DeployEZ™ Publisher

Applications that are deployed with the Govern DeployEZ™ Publisher will 
create a GovernNetConfig.xml file. This file containing licensing information 
is located in the deployment folder. Typically the deployment folder is located 
outside of the DMZ and should not be accessible externally. For security 
purposes you would not, and should not, reference this file directly. 
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To resolve this issue, copy the GovernNetConfig.xml file and place it in an 
accessible location, e.g. the same location as the Web.config file.

To reference the GovernNetConfig.xml file:

1. Copy the GovernNetConfig.xml file from the Deployment folder that was 
created by the DeployEZ™ Publisher.

2. Paste the copy of the file in the location of the Web.config file, typically 
Root Directory... \ InetPub \ wwwroot \ WebUserInterface. Write down 
this path.

Using an ASCII text editor like Notepad.exe, you will edit the Web.config file.

1. Open the Web.config file in your text editor.

2. In the file, search for the <AppSettings> section (A).

3. Create a new line and make an entry that will reference the location of the 
GovernNetConfig.xml file.

The line should be entered exactly as it appears below:

<add key="MSGovern.GovernNetConfig" value="Root 
Directory\ InetPub \ wwwroot \ WebUserInterface.\
GovernNetConfig.xml" />

...where Root Directory is your install directory for the Web site

4. Verify the line entered, save and close the file.
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Once this entry has been made, errors related to referencing the GovernNet-
Config.xml file will be resolved.

Resolving the ‘bobj is undefined’ Error

When using the Web portal, errors may be generated that are related to the 
use of Crystal Reports. When reports are requested e.g. a menu selection that 
might provide property information, an error appears in the form of a ‘bobj is 
undefined’ message. 

This error is caused by the inability of the web application to locate JavaScript 
code that is located in the aspnet_client folder.

There are two (2) possible methods of resolution.

If you have a default website, the ASP.net folder will need to be placed within 
the WebUserInterface folder. The ASP.net folder needs to be in this folder so it 
can find the JavaScript code it is looking for. 

‘bobj undefined’ Resolution 1

Placing the aspnet_client folder directly in the WebUserInterface folder is not 
recommended because when the Web application is refreshed, typically this 

Note: The GovernNetConfig.xml file that was copied will only need to be 
updated if the deployment folder is reinstalled, or there is a change in 
the server or location.
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folder will also be deleted. This in turn would also, unfortunately, delete the 
settings in the aspnet_client folder (C). A workaround is to place an alias file to 
the folder in the WebUserInterface folder (B) that is located under the Default 
Web Site (A).

This folder that will be created is a virtual directory, the actual ASP.net folder is 
located outside of the WebUserInterface folder.

To create an aspnet_client virtual directory...

1. On your desktop, click Start > Settings > Control Panel > Administrative 
Tool > Internet Information Services.
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2. In the Internet Information Services Control Panel, double click to expand 
to the level of the Default web Site (1).

3. Look for the WebUserInterface folder and right-click; select New > Virtual 
Directory... from the floating menu (2)

4. In the Virtual Directory Creation Wizard, click Next.

5. In the Virtual Directory Alias screen, enter aspnet_client in the Alias 
parameter; click Next.
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6. In the Web Site Content Directory screen, either type in the path to the 
aspnet_client directory, or click Browse to locate it manually.

Once the following parameter C:\Inetpub\wwwroot\aspnet_client or a path that 
corresponds with the location on your system is entered, click Next.

7. In the Access Permissions screen, click to select the options for Read, and 
Run scripts (such as ASP); click Next.
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8. At the final screen, click Finish.

Now the aspnet_client virtual folder will be referenced as if the real folder was 
present in the directory. Should you perform a site update, usually you would 
keep the Web config and delete all other files. In deleting the other files, you 
could inadvertently delete the aspnet_client folder. With this solution only the 
alias is deleted.

Multiple Web sites

In instances when you have multiple web sites, you would still have the 
Default Web Site folder, but have multiple web site folders. In most instance 
The above Resolution 1 will resolve issues where there are multiple Web site 
folders. The aspnet_client folder is located inside the WebUserInterface folder. 
In other instances, resolution is only achieved by placing the aspnet_client 
folder one level up outside of the WebuserInterface folder.

‘bobj undefined’ Resolution 2

Although the above Resolution 1 will work for 99% of ‘bobj undefined’ errors 
generated in a single Web site scenario, it will only occasionally work in 
instances of multiple Web sites. In instances when no resolution is obtained, 
the following procedure can possibly be of assistance.
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As with the single Web site, a virtual directory must be created. What is critical 
this time is that the directory has to be created not inside the WebUserInter-
face folder, but rather at the same level.

Error Associated with WebUserInterface File 
Update

Users that are updating their WebUserInterface files from versions earlier than 
release 4.5.3 may encounter the following error related to NelNet transactions 
displayed in their browser.

Value was either too large or too small for an Int32.

Prior to release 4.5, NelNet transactions were saved as type Int. After release 
4.5 a design change was implemented that saw Nelnet transactions changed 
to type Float. 

Resolution

Users will need to update their table structure. Running the following script in 
the database will update the table structure from a type int (integer) to a type 
float(floating point). Typically this script can be run in a database 
management application like Microsoft SQL Server Management Studio.
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- Script Start -

-- DROP INDEXES --

DROP INDEX [CC_NELNET_TRANS_TRANSACTION_ID] ON 
[dbo].[CC_NELNET_TRANS] WITH ( ONLINE = OFF )

GO

DROP INDEX [CC_NELNET_TRANS_ORIGINAL_TRANSACTION_ID] ON 
[dbo].[CC_NELNET_TRANS] WITH ( ONLINE = OFF )

GO

DROP INDEX [CC_NELNET_TRANS_TRANSACTION_RESULT_CODE] ON 
[dbo].[CC_NELNET_TRANS] WITH ( ONLINE = OFF )

GO

DROP INDEX [PK_CC_NELNET_TRANS] ON [dbo].[CC_NELNET_TRANS] WITH ( 
ONLINE = OFF )

GO

-- Alter tables --

ALTER TABLE cc_nelnet ALTER COLUMN TRANS_ID  FLOAT 

GO

ALTER TABLE cc_nelnet ALTER COLUMN TRANS_ID_ORIG FLOAT

GO

ALTER TABLE CC_NELNET_TRANS ALTER COLUMN TRANS_ID FLOAT

GO

-- Recreate INDEXES --

CREATE NONCLUSTERED INDEX 
[CC_NELNET_TRANS_ORIGINAL_TRANSACTION_ID] ON 
[dbo].[CC_NELNET_TRANS] 

(

[ORG_ID] ASC

)WITH (PAD_INDEX  = OFF, STATISTICS_NORECOMPUTE  = OFF, 
SORT_IN_TEMPDB = OFF, IGNORE_DUP_KEY = OFF, DROP_EXISTING 
= OFF, ONLINE = OFF, ALLOW_ROW_LOCKS  = ON, 
ALLOW_PAGE_LOCKS  = ON) ON [PRIMARY]

GO

CREATE NONCLUSTERED INDEX [CC_NELNET_TRANS_TRANSACTION_ID] ON 
[dbo].[CC_NELNET_TRANS] 

(

[TRANS_ID] ASC
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)WITH (PAD_INDEX  = OFF, STATISTICS_NORECOMPUTE  = OFF, 
SORT_IN_TEMPDB = OFF, IGNORE_DUP_KEY = OFF, DROP_EXISTING 
= OFF, ONLINE = OFF, ALLOW_ROW_LOCKS  = ON, 
ALLOW_PAGE_LOCKS  = ON) ON [PRIMARY]

GO

CREATE NONCLUSTERED INDEX 
[CC_NELNET_TRANS_TRANSACTION_RESULT_CODE] ON 
[dbo].[CC_NELNET_TRANS] 

(

[RESULT_CODE] ASC

)WITH (PAD_INDEX  = OFF, STATISTICS_NORECOMPUTE  = OFF, 
SORT_IN_TEMPDB = OFF, IGNORE_DUP_KEY = OFF, DROP_EXISTING 
= OFF, ONLINE = OFF, ALLOW_ROW_LOCKS  = ON, 
ALLOW_PAGE_LOCKS  = ON) ON [PRIMARY]

GO

CREATE UNIQUE NONCLUSTERED INDEX [PK_CC_NELNET_TRANS] ON 
[dbo].[CC_NELNET_TRANS] 

(

[BATCH_NO] ASC,

[TRANS_NO] ASC

)WITH (PAD_INDEX  = OFF, STATISTICS_NORECOMPUTE  = OFF, 
SORT_IN_TEMPDB = OFF, IGNORE_DUP_KEY = OFF, DROP_EXISTING 
= OFF, ONLINE = OFF, ALLOW_ROW_LOCKS  = ON, 
ALLOW_PAGE_LOCKS  = ON) ON [PRIMARY]

GO

- Script End - 
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